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Welcome

Concordance® Desktop is a tool that provides electronic discovery, litigation document
management, and litigation support. It was designed to make it easier to identify,
organize, analyze and maintain case-critical information so that you can collaborate and
share across your firm, or around the world. Concordance Desktop provides the means by
which a small to mid-sized law firm can control and maintain the documents that are
pertinent to their cases.

Concordance Desktop can manage up to 2048 databases. Should your database
count exceed this number, we recommend archiving some of your databases that are
not active, or using an enterprise tool to manage your databases.

All the functionality needed to create, maintain, store, and work with databases, as well
as reviewing, marking up,  and redacting, and general production functionality of your
documents is available in Concordance Desktop, and can be turned on with varying
licenses. There are two types of licensing; Application and User Level. 

· Application licenses are used to activate your installation of Concordance Desktop as
either a Server or a Mobile installation.  

· User Level licenses are used to provide access to varying levels of functionality. 

There are several user level licenses that affect three different types of users;
Administrators, Full Reviewers, and Data Reviewers. All documents for a case can be
imported into one or more databases by an Administrator. Once a database is created, it
can be accessed by Data Reviewers for first level searching, record categorization, and
folder, tags and issues creation. The database can also be accessed by Full Reviewers for
searching and marking up documents pertinent to their cases, and for setting up
documents they need to send to opposing council. 

For more details about Concordance Desktop licensing and how it works, please see the
About Concordance Desktop Licensing and Product Activation topic. 

Basic key benefits and features

Concordance Desktop provides the most effective, cost-efficient way to manage the
high volume of documents—scanned paper, email and other e-documents—generated
during litigation. 

Here are some of the basic key benefits and features of Concordance Desktop:

· A repository that holds documents of all types

· A fast and efficient search engine 

· Ability to categorize records with folders, tags, and issues 

· Ability to secure confidential data at various administrative levels 

· Ability to integrate with other litigation technology 
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Here are some of the key benefits and features when installed on a network
server or computer:

· A secure, centralized location for your document databases

· Local Area Network (LAN) and Wide Area Network (WAN) access from workstations
on which Concordance Desktop software is installed

· Server functionality uses highly optimized data compression.

· Server functionality provides RSA encryption for efficient and secure remote access.
This is the same RSA 128-bit encryption that banks use for securing online
transactions.

A Server license is required to enable Concordance Desktop Server on a server, or a
network computer that you want to use as a the Concordance Desktop server. When
that license is activated, two Concordance Desktop Server services are started;
Concordance Desktop Server and Concordance Desktop Admin Server. The
Concordance Desktop Server service sends data to Data Reviewer and Full Reviewer
users on the network. This is where most of the review work is done. Concordance
Desktop Admin Server service works with the Concordance Desktop Admin Console to
control the server, database access assignments, and user management. The
Administration Console provides a user interface to manage Concordance Desktop
server functionality, allowing administrators to publish databases, restrict access and
change user settings, set performance parameters, and generate usage reports.

Document review key benefits and features

Concordance Desktop provides an easy to use interface and markup tools for the
review process.  You can view markup history as well as document and image
information without having to switch back to the main Concordance Desktop window. 

Document review typically involves searching for and marking up documents:

· Relevant for turning over to opposing counsel. 

· Containing privileged or confidential information that you do not want turned over to
opposing counsel. 

· Containing evidential information to support your case. 

The document review key benefits and features of Concordance Desktop are:

· An intuitive user interface for navigating and reviewing documents

· A single Concordance Desktop Image Base (CIB) SQLite database file to store both
native and image information

· Advanced markup tools to review and annotate documents and images

· Track document markups added or removed during a review 

· Produce color or grayscale images to PDF or TIFF

Database capacity



Concordance Desktop 10

Database Capacity

Number of databases 2048

Number of documents 500,000 

Concatenated databases You can join up to 128 databases

Fields 250 custom fields

Characters per field 12 million

Database .ivt file 6 gigabytes

Database .tex file 6 gigabytes

Product integrations

Concordance Desktop integrates with other leading industry technology tools and
providers to assist you in maximizing the functionality you currently have in managing
your case records and history, while allowing you to add on or transition data to other
programs as you move through the litigation process.

Concordance Desktop also integrates with the following tools:

· Hosted Concordance Desktop servers

· CaseMap®

· CloudNine™ LAW

· Sanction® version 2.9 only

· Microsoft Excel®
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Concordance Desktop Release Notes

The CloudNine™ Concordance Desktop Release Notes provide information on the features
and improvements in each release.  

You can see a full listing of current and previous release notes on our Concordance
Desktop Release Notes site.
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Getting Started

Accessing Concordance Desktop

Concordance Desktop does not require you to log onto a server until you actually attempt
to open a database, or if you are an administrator, attempt to open the Admin Console.
Once an attempt is made to either open a database or the Admin Console, Concordance
Desktop begins the process of authenticating the user. It is at this time that a user's log
on information is required. 

To access Concordance Desktop, do one of the following:

· Click on the Concordance Desktop icon on your desktop

· Click on the Windows Start button and select Concordance Desktop from the menu. 

· Double-click on a shortcut (.fyi) file that was sent to you
(If you have Concordance version 9 or lower still installed on your computer, do not
use this method, as it will attempt to open the database in the older version.)

· Double-click on a database that resides on your computer 
(If you have Concordance version 9 or lower still installed on your computer, do not
use this method, as it will attempt to open the database in the older version.) 

To open an database, see "Opening a database."

To open the Admin Console, see "Accessing the administration console."

To change your password:

Contact the administrator of the Concordance Desktop server on which you need your
password reset, and ask them to reset your password.

The next time you open a database on that server, you enter your a new password in
the Password field. That will be your password going forward for that server.

Passwords cannot be reset from the Admin Console login window. So if you are an
administrator, you will need to attempt to open a database, in order to change
your password, after your account has been reset. 

Navigating Concordance Desktop

The Concordance Desktop user interface is similar to Microsoft Outlook.
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The left side of the window is the Navigation pane where you can navigate to
Concordance Desktop tasks to search, tag, sort, and add notes to documents. The right
side of the window is your Workspace pane where you can tab to multiple databases. You
can view databases in the Browse, Table, Edit, or Review views.

The Dynamic toolbar at the bottom of the window changes according to the views
selected.

Navigating Concordance Key

Key Feature Description

(1) Navigation
pane

Provides tools for performing tasks on the current database, such
as searching and tagging.

(A) Task pane Displays database tools in work areas called panels.

(B) Pin Allows you to dock the navigation pane by pinning, or hide the
navigation pane by unpinning.

(C) Navigation
buttons

Opens task panes on the Navigation pane.

(2) Workspace
pane

Displays databases in various views.
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Key Feature Description

(D) Tabs Allows you to move between different open databases.

(E) Table view Displays a list of document records.

(F) Browse view Displays one document record at a time.

(3) Title bar Displays the current database name and information regarding the
current document record.

(4) Menu bar Contains menus, each responsible for a set of tasks.

(5) Standard
toolbar

Contains buttons that let you access standard views and tools.

(6) Quick Search Allows you to quickly enter and execute simple and advanced
searches while browsing document records.

(7) Dynamic
toolbar

Contains buttons for tools corresponding to the current views.

(8) Status bar Displays status information, such as the current document record
count.

(1) The Navigation pane

The Navigation pane allows you to manage your case record review, control database
access, and conduct your daily search, sort, and tagging tasks.

The Navigation pane is divided into work areas called panels. The panels are resizable
based on your personal preference.

The bottom of the Navigation pane contains buttons that determine which feature is
displayed in the Task pane.

Task Pane
Feature

Description

Databases Allows you to open and concatenate multiple databases, take a
snapshot of a query session, quickly scan recently reviewed databases,
and identify the current database you are reviewing and whether it
needs updating.

Search Allows you to perform simple to advanced queries with fast search
results, save and reopen queries, clear search history, and access the
dictionary and field lists.

Tags Contains a menu tree for categorizing tag folders, adding new tags,
and panels for running history and statistical tag queries.

Notes Displays comments added to a document, allows you to sort by note or
issue, and shows the properties for each file.



Getting Started 17

Notice the pin icon in the upper right corner of the Task pane. By clicking this icon, you
can keep the Task pane visible all times (pinned) or tucked away, available when you
click the Task pane tab (unpinned).

(2) The Workspace pane

The Workspace pane is located on the right side of the Concordance Desktop interface,
and displays database items in various views. When you open a database in
Concordance Desktop, a tab is created for the database in the Workspace pane.

The Workspace pane is not the same as the Workspace tab. The Workspace tab is
used to display internal or external web pages. For more information about the
Workspace tab, see Customizing the start-up view.

(3) The Title bar

The Title bar displays information regarding the current database and document.

Concordance Desktop transcript databases automatically set the Title bar to the name,
date and volume of the current document. For non-transcript databases, you can
define the Concordance Desktop field you want to display using the Select the field to
display in the title bar while browsing field in the Preferences dialog box. The selected
field is displayed on the Title bar in the Browse view, Table view, and Edit view.

When reviewing standard records in the Browse, Table and Edit views, displaying the
BEGNO field on the Title bar can help you keep track of record numbering. 

The values in the BEGNO field represent the Bates numbering system, which is a
unique serial number corresponding to each record in the database. BEGNO stands
for beginning number, and ENDNO for ending number.

(4) The Menu bar

The Menu bar contains the Concordance Desktop menus that are responsible for a set
of Concordance Desktop tasks. Some of the menu commands are the same as the
toolbar functions. 

File Menu

File menu commands allow you to create, maintain, and manipulate databases and the
files used by the databases. From the File menu, you can also send data from
Concordance Desktop to other applications, such as CaseMap and Sanction, and edit
and run Concordance Desktop programs. 
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Edit Menu

The Edit menu commands allow you to edit and set data validation options for the
documents in your databases.

The Undo, Cut, Copy, Paste, Ditto, and Replace menu commands are only available
when actively editing in the Edit view. You can use the Copy command to copy text in
both the Edit and Browse view. The Copy Document Data command on the Edit menu is
only available in the Browse view. 
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View Menu

The View menu commands allow you to open images in your viewer, work with
documents in the Edit, Browse, Review, or Table view, change data and field font sizes,
split your screen, and select the status bar and toolbars.

Search Menu
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The Search menu commands provide access to the Simple Search and Advanced
Search panels in the Search task pane, access to the Form Search - Query by Example
dialog box, the Persistent Search and Find Attachments commands.  

The Search menu commands also allow you to save your query session to a file, re-
execute a saved query session, clear all searches, and search for documents that have
been edited or marked for deletion. The Save Search Results and Activate Selected
Query commands on the Search menu are only available in the Review view.

Documents Menu

The Documents menu commands allow you to navigate documents and search results,
import, export, print, and create reports in your Concordance Desktop databases. Most
Documents menu commands operate on the current query. If your last search found
zero documents, some the commands on the Documents menu will be unavailable.



Getting Started 21

Tools Menu

Several options are available from the Tools menu including displaying empty fields,
looking for duplicate records, managing list files, managing tags and issues, and
customizing your preferences.

Do not confuse the Tools button on the Standard toolbar with the Tools menu.
Clicking the Tools button on the Standard toolbar opens the Preferences dialog
box. You can also open the Preferences dialog box by clicking Preferences on the
Tools menu.

Help Menu

The Help menu commands allow you to access the Concordance Desktop Help system,
activate Concordance Desktop, and view information about the Concordance Desktop
version and contacting customer support.
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(5) The Standard toolbar

The Standard toolbar contains buttons for accessing the Concordance Desktop views
and related tools, including Print and Help.

Button Definitions

Standard Toolbar Buttons

Butto
n

Description

Browse Opens the Browse view. The Browse view allows you to view the documents
in the database. You can also add and edit tags, notes, and issues to
documents in the Browse view, and send selected text to other programs.
When you open the Browse view you will be viewing the first document in the
current query or the first document in the database if no query has been
entered.

Table Opens the Table view. The Table view displays documents from the current
search in a tabular format, similar to a spreadsheet, with one document per
row. In the Table view, you can add and edit tags to documents, define which
fields are displayed in the view, the field order, and modify the style and color
of the font displayed in the view.

Review Opens the Review view. The Review view displays all searches performed
since the current database was opened, indexed, reindexed, or the search
history was cleared. The Review view includes the search number, number of
search hits, number of documents containing the search terms, and the
search terms for each search.

All Selects the entire database and returns the sort order of all records to the
order in which they were added to the database. This function is sometimes
referred to as Zero Query. The document last displayed in the Browse view
remains the active record. The documents that come before and after are the
documents that physically precede and follow it in the database. When you
want to return to the last query, simply click the All button again. Performing a
search also resets the All button.
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Standard Toolbar Buttons

Butto
n

Description

Sorting Opens the Sorting layouts dialog box.  The Sorting layout feature provides
additional tools to customize and save how records are sorted in the Browse
view to display the desired result.  

Edit Opens the Edit view.  The Edit view allows you to edit the contents of the
documents in the database.  The Edit view also provides additional tools
needed to create and save custom edit layouts that can be applied to display
only the fields specified in the selected layout in the Edit view.

Print Opens the Print documents dialog box. In the Print documents dialog box you
can print records located from a search. You can underline search terms and
produce key-word-in-context reports. Printed output can be routed to your
printer or to a file. You can select a range of documents within the current
query and specify the fields within the database.

Report Opens the Report Writer dialog box. When you click the arrow next to the
Report view button, you can open the Report Writer or Annotation Report
dialog box. The Report Writer dialog box is used to create columnar reports
for database data. The Annotation Report dialog box is used to create the
Annotation Report for transcript databases. 

Tools Opens the Preferences dialog box. In the Preferences dialog box you can you
to customize how you use Concordance Desktop, including customizing the
Workspace tab, search hit color, title bar, issue coding, and indexing.

Help Opens the Concordance Desktop Answer Center.

Do not confuse the Tools button on the Standard toolbar with the Tools menu.
Clicking the Tools button on the Standard toolbar opens the Preferences dialog
box. You can also open the Preferences dialog box by clicking Preferences on the
Tools menu.

(6) Quick Search

The Quick Search field is located below the Standard toolbar and can be used in any
view. Quick Search allows you to enter basic one-word searches, as well as more
complex combinations, while reviewing your documents, without having to open the
Search task pane.  See Running quick searches.

(7) The Dynamic toolbar

The Dynamic toolbar is located at the bottom left of the Concordance Desktop window.
Each toolbar corresponds to a particular Concordance Desktop view. 
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Button definitions

Dynamic Toolbar Buttons

Butto
n

Name Description

First Opens the first document in the current query in the Browse
view, or opens the first document in the database if you are
using zero query. 

Previous Opens the previous document in the Browse view. 

Next Opens the next document in the Browse view. 

Last Opens the last document in the current query in the Browse
view. 

Go to Opens the Goto dialog box where you can enter the number of
the document you want to view from the current query.
Concordance Desktop opens the document in the Browse
view.  

For Transcripts, use the Goto dialog box, to enter the number
for the document, page, or line you want to view.

Previous Hit Moves the cursor to the previous search hit in the Browse
view. If the document was edited since the last reindex, the
document containing the search hits is displayed but the
search terms are not highlighted.

Next Hit Moves the cursor to the next search hit in the Browse view. If
the document was edited since the last reindex, the document
containing the search hits is displayed but search terms are
not highlighted. If there isn't a next search hit to display, the
next document is displayed.

View Image Displays the image associated with the current document.
Once you click the View Image button, it automatically stays
selected and displays the image associated with each record in
the image viewer. Click the View Image button again to
release the button. This button only works when images are
enabled in Concordance Desktop. 

Copy Opens the Copy dialog box. In the Copy dialog box, you can
copy document data from selected fields to the output
destination you specify. 
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Dynamic Toolbar Buttons

Butto
n

Name Description

Font Opens the Font dialog box. When you modify the font in the
Browse view, you are modifying the font for data displayed in
the Browse view for the entire database. 

When you modify the font in the Table view, you are modifying
the font for data displayed in the Table view for the entire
database. If you are viewing a concatenated database, the
font change only affects the database for the current selected
record. 

Edit Adds the search terms of a selected query to the Search task
pane for editing.

Activate Select a search in the Review view and click the Activate
button to activate a previous search and make it the current
search. Clicking the Activate button opens the documents in
the Browse view.

Fields Opens the Fields dialog box. The Fields dialog box contains a
list of all fields available for editing. Select a field from the list
and click the Insert button to move your cursor to the selected
field in the Edit view.

Ditto Opens the Duplicate dialog box. In the Duplicate dialog box,
you can copy field data from one record to another record or to
another field in the current record. 

Delete Marks and unmarks a record for deletion. Records marked for
deletion are removed from the database when the database is
packed.

Undo Opens the Edit Options dialog box. In the Edit Options dialog
box, you can undo edits, mark and unmark the record for
deletion, or erase all content from the document.

(8) The Status bar

The Status bar at the bottom of the Concordance Desktop window displays the
selected toolbar button's functionality, tracks the document number being edited, and
the total number of documents in the current set. The number in brackets is the
document’s location in the physical database. Document indicators are also displayed
here for documents that are tagged (TAG), marked for deletion (DEL), and/or locked
(LCK) by another user.
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A document locked by another user cannot be saved. A locked document is displayed
for editing so that you can copy the document data to another document or program.
When a record is locked, the record is grayed out.

This Status bar example indicates you are viewing document 1 out of 203 total
documents, the document is the first record in the physical database, and the
document has been tagged.

Opening a database

There are several ways in which you can open a database:

· From the Concordance Desktop File menu 

· By double-clicking a database (.FYI) file sent by the Administrator - Note that if you
have Concordance 10, 9, or 8 still installed on your desktop, this method cannot be
used, as it will attempt to open the database in Concordance instead of Concordance
Desktop.

· By double-clicking on a database - This method is for mobile users who are accessing a
database on their own computer, or by administrators who are opening a database on
a Concordance Desktop server itself. 

If you want to open a database from Concordance 9.x, see Migrating databases
for information and instructions.

· If you have recently opened a database, you can reopen that database by selecting it
from the 'Recent' panel database list in the Databases task pane. 
Clicking a database tab activates the standard and dynamic toolbars in Concordance
Desktop, as well as the task panes in the Navigation pane.

You can open as many databases as you want to review and search in any Concordance
Desktop session. Each database is accessible by clicking the named database tab in the
Workspace pane.

To open a database from Concordance Desktop:

A database can be opened by browsing out to the Database.DCB or selected from a list
of previously opened databases on the server.

To Browse out to the database, do one of the following:

· On the File menu, click Open. Then browse out to the database.DCB and select
Open.  This option is for Mobile license users only, when they access databases
on their own computer. 

· In the Databases task pane, click Open database.  Then browse out to the
database.DCB and select Open.



Getting Started 27

· Enter your User name and Password for the Concordance Desktop server where
the database is located.

If you are attempting to open a Concordance version 10.21 or earlier
database in Concordance Desktop, you are prompted that the imagebase is
not compatible with the Concordance Desktop imagebase, and given the
option to update the imagebase

To Connect to a database that has been added on the server:

1. On the File menu, click Connect.  

2. The Connect to Concordance Server opens in a new window.

3. Enter your Logon (user name) and Password for the Concordance Desktop server
where the database is located. 

· If not already populated, enter the Host name and Port of the server hosting the
database that you want to open.

· Contact your database administrator if you do not know the server's Host name
or Port, or your Logon or password. 

· You may also select a Host name and Port from the drop-down menu of Previous
Connections. 

4. Select Connect.

5. A new window opens to Select Database to Open.
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Versions prior to 1.07

· In version 1.07+ the matter and database items in the Select Database to Open
window can be filtered.  To use the filter, start typing the name of the database
you want to open or the name of the matter wiht which it is associated. 

Version 1.07+

· The databases can be sorted ascending or descending by Matter, Database, or
Status by clicking on the corresponding column header. 
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 Sorting by Matter, Database, or Status in Version 1.07+

6. Select the desired database and click Open.

7. The database name is displayed on a tab next to the Workspace or other open
database tab(s).

To open a database .FYI file:

1. Double-click on the .FYI file that the administrator sent to you. 

2. Enter your log on User ID and Password for the Concordance Desktop server
where the database is located. 

If you receive an error message when attempting to open a .fyi database, it
may be that the database you are attempting to open is not the correct
Concordance Desktop version, or the .fyi file may be corrupted. Contact your
administrator for a new .fyi file. 

To open a database on your own computer or on the server:

Double-click on the database .DCB file, to open the database in Concordance Desktop.

If you are attempting to open a Concordance version 10.21 or earlier database
in Concordance Desktop, you are prompted that the imagebase is not
compatible with the Concordance Desktop imagebase, and given the option to
update the imagebase.



Concordance Desktop 30

If you receive a message stating that the database is not registered, contact the
Administrator and ask them to register the database. If you are opening a file on a
Mobile installation, then open the Admin Console and follow the instructions for
registering a database found under "Registering/unregistering a database".

To close a database

Click the X in the upper-right corner of the Workspace pane.

Viewing records

There are three ways to display records in Concordance Desktop:

· Browse View - displays the entire record content in a scrollable pane (default view)

· Table View - displays a list of documents in a spreadsheet view

· Split Screen - allows you to view both simultaneously (vertical or horizontal)

Browse view

The Browse view is the default setting for the Concordance Desktop window and allows
you to read an entire document summary. 

Use the Dynamic toolbar at the lower left of the Navigation pane to navigate between
records. The document number and record count display in the Status bar. The
document title displays in the window’s title bar and is a helpful reference when
reviewing lengthy documents. See also, Navigating in Concordance Desktop. 

When you run searches in Concordance Desktop, any words located in a search (search
hits), are highlighted in the Browse view. You can quickly navigate search hits in the
Browse view using the Previous Hit and Next Hit buttons on the Dynamic toolbar. 

When viewing records in the Browse view, you can use the Empties command on the
Tools menu to hide fields without data, which can help tighten the screen view when
reading records. A check mark next to the Empties command on the Tools menu
indicates empty fields are hidden in the Browse view. If a field is not displayed in the
Browse view, even when the Empties command is deselected, you may not have
viewing privileges for the field. Contact your Concordance Desktop administrator for
more information.

In the Browse view, you can customize the font and color of the field and record text
displayed in the view, unless the record contains rich-text format. Changing the text
font and color does not affect the record’s original text, which is stored as a rich text
file (.rtf) that keeps the original format secure. You or your Concordance Desktop
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administrator can also customize the Browse view preference settings in the
Preferences dialog box. Browse view setting in the Preferences dialog box are saved in
your Microsoft Windows registry settings. 

For more information about customizing fonts, see Modifying fonts in the Browse and
Table views. 

For more information about Browse view preference settings, see Defining preferences.

Table view

The Table view displays documents from the current search in a tabular format, similar
to a spreadsheet, with one document per row. Use the Dynamic toolbar or Documents
menu to navigate records in the Table view. The view's default document sort order is
the original import order for records entered in the system. Clicking a field column
header will sort data in ascending and descending order. You can adjust the column
widths by dragging a column header's break. 

You can customize which fields are displayed in the view, as well as the field order,
using table layouts. You can create multiple custom table layouts for the Table view.
For more information about layouts, see Using table layouts.

You can also modify the font and color of the record text displayed in the Table view.
Changing the text font and color does not affect the record’s original text, which is
stored as a rich text file (.rtf) that keeps the original format secure. For more
information about modifying fonts, see Modifying fonts in the Browse and Table views. 
 

To review the contents of a specific document in the Table view, double-click the
document to open the document in the Browse view.

The Table view also offers the Tally feature. The Tally feature is a great tool for gaining
an item count for a specific field to help you organize your document collection and for
quality assurance checks.  For more information about the Tally feature, see Searching
by tally. 

Split screen view

The Split Screen view allows you to display two views simultaneously. You can have
the two views display from top to bottom or left to right. You can use the Split Screen
for the Browse, Table, Review, and Edit views.

To use the Split Screen view:

1. On the View menu, click Split screen and then Enable, to activate the Split
Screen view. 



Concordance Desktop 32

A check mark next to the Enable command indicates the Split Screen view is
activated. 

2. On the View menu, click Split screen and then Left - Right or Top - Bottom, to
set the orientation of the Split Screen.  

A check mark is displayed next to the selected orientation.

When you activate the Split Screen view, the currently opened view is displayed
on the top when using the Top - Bottom command, and on the left when using
the Left - Right command.

3. On the Standard toolbar, click the view button for the second view you want to
display.

For example, if you have the Browse view open when you enable the Split Screen
view with the Top - Bottom orientation, and then click the Table view button,
the Browse view is displayed on top and the Table view is displayed on the
bottom.

4. To modify the views, click the view you want to change and click another view
button on the Standard toolbar. 

The view containing your cursor, is the view that changes when you click another view
button.

Customizing view fonts

In the Browse view, you can customize the font and color of the field and record text
displayed in the view, unless the record contains rich-text format. You can also modify
the font and color of the record text displayed in the Table view. Changing the text font
and color does not affect the record’s original text, which is stored as a rich text file (.rtf)
that keeps the original format secure.

When you change the text font and color in the Browse and Table views, the changes are
applied to each database record displayed in the Browse and Table views for the current
database. For concatenated databases, you can customize the text font and color
displayed in the Table view for each database in the concatenated set. This can help
differentiate between the databases at a glance.

To change the field font in the Browse view

1. On the Standard toolbar, click the Browse view button.

2. Right-click anywhere in the record text section of the Browse view.
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3. Point to Font and click Field font to open the Font dialog box.

4. Modify the font settings as desired.

5. When finished, click OK to save your changes.

The font changes apply to all field text displayed in the Browse view.

To change the record font in the Browse view

1. On the Standard toolbar, click the Browse view button.

2. Right-click anywhere in the record text section of the Browse view.
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3. Point to Font and click Data font to open the Font dialog box.

4. Modify the font settings as desired.

5. When finished, click OK to save your changes.

The font changes apply to all record text displayed in the Browse view.

To change the record font in the Table view

1. Click the Table view button on the Standard toolbar to open the Table view.

2. Right-click and click Font to open the Font dialog box.

If you are changing the record font and color for databases in a concatenated set,
right-click any record in the database for which you want to change the font. This
only changes the font for the records in that database.
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3. Modify the font settings as desired.

4. When finished, click OK to save your changes.

The font changes apply to all record text displayed in the Table view for the
database.

If you are changing the font and color for a record in databases within a
concatenated set, right-click any record in the database for which you want to
change the font. This only changes the font for the records in that database.

Defining preferences

The Preferences dialog box contains settings used by both the administrator and
reviewers. You can choose to prevent certain users from accessing the Preferences dialog
box by applying security to this menu item. Most of the preferences are Microsoft
Windows registry settings, but there are several options that allow you to apply selections
to all databases.

Setting some of your viewing parameters helps ease browsing by offering more record
detail onscreen, and changing the red highlight color for keywords.

The Preferences dialog box contains seven tabs:
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· General - settings used when starting and closing Concordance Desktop,
enable/disable Workspace options, and assigning fields for attachments.

· Searching - settings for the default search behavior and search engine.

· Browsing - settings for the title bar field, default query field, and tag and issue
options.

· Import - import settings related to numbering and indexing. 

· CPL - settings for CPLs, such as the CPL font selection.

Any setting changes made in the Preferences dialog box require you to close
Concordance Desktop and restart the application before the changes take effect.

To set General preferences:

1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

Clicking Preferences opens the General tab in the Preferences dialog box. 
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The Startup section defines the startup view when opening Concordance Desktop
and databases.

For more information about customizing the start-up view in Concordance Desktop,
see Customizing the start-up view.

The Initial Browse Path field is used to determine the initial folder that opens when
you browse for a file or open a new database. For example, entering C:
\CloudNine\MyDatabases opens the MyDatabases folder when selecting Open
database from the Databases task pane. During each Concordance Desktop session,
the browse path is a dynamic setting and remembers the last folder opened. The
next time you browse for a file or select Open database, the previous folder location
opens. Each time you close and restart Concordance Desktop, Concordance
Desktop resets the browse path to the original Initial Browse Path field setting.

You need to restart Concordance Desktop for this change to take affect.
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2. To define the initial browse path, click the ellipses (...) button next to the Initial
Browse Path field, to open the Browse For Folder dialog box.

3. Navigate to and click the folder you want to open when you browse for a file or
open a new database, and click OK.

Clicking OK adds the folder path to the Initial Browse Path field. 

4. To ensure all workstations installs open the path in the Initial Browse Path field,
select the Always Map Initial Browse Path option.

The Default view field determines whether the Browse or Table view automatically
opens when you open a database in Concordance Desktop.  

5. To define the default view, in the Default view field, click Browse or Table from
the view list.

The Number of MRU items field determines the number of database files listed in the
most recently used (MRU) file list. The MRU file list is displayed on the File menu and
the Recent panel in the Databases task pane. The Number of MRU items field
defaults to 6. You can display up to nine files in the list. 

If a user's Recent panel or Recent Files list is blank, your company may have a
policy preventing the user's computer from writing to the MRU registry key.

You need to restart Concordance Desktop for this change to take affect.

6. To modify the number of database files listed, in the Number of MRU items field,
type or scroll to the number of files to list in the most recently used (MRU) file list. 

The Exit section defines what happens when you close Concordance Desktop. 

The Exit application field allows you to set up an application to automatically launch
after Concordance Desktop is closed, like a reviewer time card application.
Concordance Desktop launches the application when it terminates normally. Any
additional parameters for the application file are entered in the Parameters field. 

7. To launch an application after Concordance Desktop closes, click the ellipses (...)
button next to the Exit application field, to open the Open dialog box.

8. Browse to and click the application executable file, and click Open.

Clicking Open adds the application's file path to the Exit application field.

9. In the Parameters field, type any additional parameters for the application.

The Workspace section controls the Workspace tab settings in Concordance
Desktop.

By default, the Workspace tab is displayed and contains links to the CloudNine Web
site. You can customize your Workspace tab to display internal or external Web
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pages simply by adding a link to an external HTML web page or to a locally stored
.HTM or .HTML file with information you’d like to publish for user reference.

10. In the Workspace section of the General tab, the Enable workspace check box
is selected by default. To continue displaying the Workspace tab in Concordance
Desktop, leave the Enable workspace check box selected. If you do not want to
display the Workspace tab, clear the check box.

11. To add a link to an external HTML Web page, in the URL field, enter the Web site
URL. Be sure to include http:// or https:// in the URL. For example:
http://www.google.com.

To add a link to an internal internal .HTM file located on your server, in the URL
field, enter the full UNC path. For example: J:\CloudNine\Internal_Links.htm or \
\MyServer\MyFolder\myhtm.htm.

12. In the Attachments section, if the attachment fields were not set up during the
database creation process, to specify the fields to use with the Find Attachments
feature, do one of the following:

· To set a field to a range of attachments, select the Attach Range option, and
then select the field that contains the attachment range data. 

· To set up the beginning and ending attachment fields, select the Fields option,
and then from the Beg Attach and End Attach list select the fields that contain
the attachment data for the beginning attachment number and ending attachment
number.

When using the Find Attachments feature, it is best practice to setup the fields
as paragraph type fields to increase the performance and make sure to
index/reindex the database. For more information about the Find Attachments
feature, see Finding attachments.

13. Click OK to save your changes. 

To set Searching preferences:

1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the Searching tab.

The settings on the Searching tab define settings for your search query results.
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The Default search term section determines which search operator is used when
two search terms are entered without an intervening search operator, and the
number of words within the search. The search operator selected in the Default
search term field is automatically inserted when Concordance Desktop encounters
this scenario. The Default search term field defaults to the adjacent (ADJ) search
operator.

For example, searching for Anza Borrego is interpreted as Anza ADJ Borrego.

3. To change the default search operator, in the Default search term field, select
the default search operator you want to use.

4. To expand the number of words included in the search results, in the Within words
field, type the number of words to include within the search. 

For example, if ADJ is selected in the Default search term field and you enter 3 in
the Within words field, Concordance Desktop searches for Borrego within 3 words of
Anza.
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The Wildcard character field determines the wildcard character for searches. The
wildcard character is used as a prefix or suffix mask when running a search. The
Wildcard character field defaults to an asterisk (*). You can change this character
to any non-alphanumeric character.

5. To modify the wildcard search character, in the Wildcard character field, type the
non-alphanumeric character you want to use.

Quote characters are used when your search query includes numbers or special
characters, such as periods (.), asterisks (*), and spaces. The quotation character
can be redefined as any non-alphanumeric character, such as the apostrophe. The
quotation character is not included in the dictionary unless it occurs as embedded
punctuation. To search for the quote, use this option to change the character
recognized as the quote, then do the search.

The Quotation character field defaults to the quotation mark (") character. It is
best practice to leave the quotation mark character in the Quotation character
field, which is necessary for locating punctuation in relational searches.

For more information about quotes in searches, see Running relational searches.

On occasion you may need to search for a quote. To do so, you must first change
this setting to a non-alphanumeric character, like an apostrophe, so that the
quotation mark is searchable. To search for the word “and”, you need to use
quotes in your query “AND”, otherwise it is read as a search operator by
Concordance Desktop.

6. To change the quotation character, in the Quotation character field, type the
non-alphanumeric character you want to use. 

The Highlight color field determines the color used to display search hits from
searches performed using the Quick, Simple, Form, and Advanced Search features. 
The Persistent color highlights the terms found in the record from the list of terms in
the <databasename>_Persistent.txt file when the Persistent Search feature is
enabled.  It is best practice to choose a color that stands out against the Browse
view background and is different than the data or field font color. The Highlight
color field defaults to red.  The Persistent color defaults to blue.

7. To change the hit color, do any of the following:  

· For search hits using Quick, Simple, Form or Advanced searching, click the Highlight
color list, in the color selection box, click the color you want to use. 

· For Persistent Search hits, click the Persistent color list, in the color selection box, click
the color you want to use.

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

8. Click OK.

To set Browsing preferences:
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1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the Browsing tab.

The settings on the Browsing tab define the browse settings by database and field
data parameters.

The Local settings section determines where the browse settings are applied. The
browse settings can be applied to any database in a group of concatenated
databases. 

3. In the Apply settings to field, select the database you want to apply the settings.

In the Select the field to display in the title bar while browsing field, you can select
a field to display on the Title bar for the current document. The field is displayed on
the Title bar in the Browse, Table, and Edit views.



Getting Started 43

Having a field's content displayed on the Title bar can help when viewing long
documents, such as depositions, where you may be deep within the document and
forget the deponent's name or the document's title. It can also help you see
relevant document information when scrolling through records in the Table view.

For transcript databases, Concordance Desktop automatically displays the name,
date and volume of the current document in the Title bar.

Use the Select the field to display in the title bar while browsing field to select a
field for other non-transcript databases.

For concatenated databases, you can choose a different Title bar field for each
database.

In the Select the field to sort default query by field, you can modify the default field
sort order of a database when the database is opened and before running a search.
This is called the "default query." The database is sorted in ascending order by the
field selected in the Select the field to sort default query by field. The field can be
any field designated as a key field on the New or Modify dialog box. For more
information about key fields, see Creating databases. 

Selecting <none> sorts the database by the document number.

4. To adjust the default sort order of a database, in the Select the field to sort
default query by field, click the field you want to use for the default sort order. 

In the Select the default action of double-clicking a tag field, you can determine
whether double-clicking a tag applies the tag to or removes the tag from a
document or whether double-clicking a tag opens the tagging options menu. The
Select the default action of double-clicking a tag field defaults to Apply tag
(Default). 

Regardless of the Select the default action of double-clicking a tag field's setting,
clicking directly on the tag’s check box will apply or remove the tag as usual, and
you can always access the tagging options menu in Concordance Desktop by right-
clicking a tag. 

5. To modify tagging actions, in the Select the default action of double-clicking a
tag field, click Apply tag (Default) to apply a tag when you double-click a tag or
click Displays menu to open the tagging options menu when you double-click a
tag.

Double-clicking a tag applies the tag to a document or removes it from the
document if it's already selected. You can change this action to display the tagging
options menu, which is usually displayed by right clicking a tag.

The Issue coding section determines how issues are applied in Concordance
Desktop. By default, issues are are applied to highlighted text in a  document using
SHIFT+left-click. You can change the setting to apply issues using only left-click. 
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6. To modify the issue coding setting, in the Issue coding section, click the Use
shift-left-click for issue coding or Use left-click for issue coding (original
method) option.

If you change the issue coding setting, the change will not take effect until you
close and reopen Concordance Desktop.

In the Sticky camera section, you can determine whether the View Image (camera)
button on the Dynamic toolbar automatically stays selected, also known as "sticky,"
for continuous image viewing in the Browse, Table, and/or Edit views. 

When a "Sticky" [view name] button check box is selected, the View Image button
is automatically selected in the view. When the check box is cleared, users manually
have to click the View Image button to view the images associated with the
documents in the viewer. 

By default, the Sticky browse button, Sticky table button, and Sticky edit button
check boxes are selected.

7. To turn off "Sticky" [view name] button function for a view, clear the check box
for the view.

8. Click OK to save your changes.

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

9. Click OK. 

To set Import preferences:

1. Do one of the following: 

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the Import tab.
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The settings on the Import tab allow you to define import settings related to
numbering and indexing. 

3. In the Prefix field, type the prefix you want to precede the production number. 

The prefix can be any combination of letters, numbers, or punctuation that are valid
folder or file names. You can use up to 57 characters.

4. In the Starting Number field, type the number you want to use to start numbering
the production files. 

Zero fill your starting number to determine the desired number width. You can use
up to 9 digits. 

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

5. Click OK.
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To set CPL preferences:

1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the CPL tab.

The CPL tab determines the font and tab size settings used when running
Concordance Desktop Programming Language (CPL) programs. 

The CPL font field defaults to Courier New 9pt and the Tab size field defaults to 3
spaces. 

3. To change the CPL font, click the CPL font button.  The Font dialog displays.

4. Modify the settings and click OK.
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Clicking OK closes the Font dialog box, and adds the font settings to the CPL font
field.

5. To change the tab size, in the Tab size field type the number of spaces you want a
tab to contain.

6. Click OK to save your changes. 

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

7. Click OK.
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Document Review

Basic Searching

Concordance Desktop search tools sort through vast amounts of information quickly using
two search methodologies:

· Full-text Searching 

Full-text searching is fast and produces results quickly because it searches for words
based on index entries created when building the database. The index provides
directions to words in the database dictionary and records are gathered for you to
review based on search criteria. For more information, see Running full-text searches.

· Relational Searches 

Relational searches scan every word of every record in a database and take longer
than full-text searches, because Concordance Desktop must read every record to
locate your entries and does not use an index. Relational searches are great for
locating dates and numbers, whereas full-text searches are optimal for word searches.
For more information, see Running relational searches.

When your Concordance Desktop administrator builds your record databases, the
information is indexed for full-text searching capabilities. Once a record collection is
indexed, a dictionary is created with additional filters that weed out unnecessary words,
common English words, and even some punctuation, to improve search processing time.
When reviewers make edits, redactions, or add new records to the database, the
administrator must perform a reindex in Concordance Desktop to update your record
collection.

All of this processing affects how up-to-date your full-text searches are on a database.
However, this does not affect relational searches, because relational searches run off the
entire database, not just the database index. 

Administrators must perform indexing when reviewers are not working in Concordance
Desktop, but a reindex process can be performed while users are working in a database. 

To better understand full-text searching, it is important to understand the following
functionality used in full-text searching:

Indexing and reindexing

When Concordance Desktop databases are built, the index and dictionary are generated
from your document contents. The index contains directions to every word or character
string in the database. The dictionary contains a list of every word or string of
characters in your record collection, except words, punctuation, and/or field content
your administrator specifically excludes from the dictionary. 

A word is simply defined as any string of letters and/or numbers. A word does not have
to be in a published dictionary to qualify as a word in a Concordance Desktop
dictionary.
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Example: airforce1 or ABC000001

“Airforce1” qualifies as an index entry, including both letters and numbers. Spaces
between characters disqualify it as a whole word; space between airforce and 1 would
be read as two words. The same is true for ABC000001, a numbering scheme that is
searchable and considered a word by Concordance Desktop.

In Concordance Desktop, we refer to an index update as a reindex. Reindexing updates
the database dictionary and its corresponding index. Actively used databases need
frequent reindexing to keep the index and dictionary entries current for searches.  

Administrators are usually responsible for indexing or reindexing databases due to the
sensitivity involved in running these processes. Concordance Desktop administrators
must ensure that all data is reviewed and proper backups are made before indexing or
reindexing a database.

When updates have been made to a database and your database dictionary is no longer
current with the latest updates, Concordance Desktop indicates that the database
needs reindexing. On the file menu a check mark is displayed next to the Reindex
command and Needs Reindexing is displayed in the Databases task pane under Current
Database. If you do not have reindexing privileges, the Reindex command is not visible
on the File menu.
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Stopwords

Concordance Desktop comes with a pre-defined list of stopwords for each database.
Stopwords are words that are automatically excluded from a database's index. The
stopwords list includes the most common words in the English language (for example:
and, but, is, and the). Stopwords are words you would generally not search for.
Eliminating these words from the index ensures that searches run faster and more
efficiently. Stopwords lists can be modified by your database administrator. If you need
a copy of a database's stopwords list, your administrator can print it out for you.

The stopwords list is maintained in the Stopwords dialog box. To access the Stopwords
dialog box, on the File menu, point to Dictionaries and click Stopwords.
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Punctuation

For full-text searching, punctuation is not indexed. Concordance Desktop treats
punctuation symbols as spaces when full-text searches are conducted. All punctuation
is ignored, such as periods or quotations, as well as any symbols like currency and
percentage. All leading and trailing punctuation for words are also ignored.

There are two exceptions to this rule, and both must be true:

· Punctuation is entered in Concordance Desktop by your administrator to be indexed.

· Punctuation is embedded in a string of words.

Select File>Properties dialog to see the punctuation that is full-text searchable in a
database (when it's embedded in a string of characters).
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Examples of Embedded Punctuation:

AOL.COM and NETSCAPE/AOL – Allows you to search on these terms because the
entries relate to a case regarding Internet browsers.

D’Arcangelo – The apostrophe is embedded because of the surname spelling. People
often have possessive apostrophes embedded in their names and are added to the list
because they are searched often.

john.smith@organization.com – The period and ampersand are both examples of
embedded punctuation within an email address.

Contact your Concordance Desktop administrator if you have questions, need a listing
of the punctuation used in your databases, or would like to modify the punctuation list.

Dictionary

In Concordance Desktop, a word is any string of characters; a word can be a series of
numbers or a combination of letters, numbers and even punctuation or symbols.
Familiarize yourself with your database dictionary by reviewing or printing the entries
added to help streamline your search queries.
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The Properties dialog box provides a quick review of the number of words included in
your dictionary, and also notes punctuation that is indexed. Punctuation is entered by
your database administrator. You can only search on punctuation when listed in
Properties dialog box and it’s embedded in the word.

Go to File>Dictionaries>Database Dictionary.  The Dictionary dialog box provides a
complete listing of all words included, the number of documents it appears in, and how
many word hits there are.

You can also access the Dictionary dialog box from the Search task pane by selecting
Display the database dictionary under Options in the Advanced Search panel. This
allows you to select words from the dictionary and add them directly into your search
logic in the Advanced Search panel. You can also verify whether the word you are
searching is included in the dictionary. If it isn’t, then you may want to try another
spelling or try a relational search.

Available search tools

Searching is a fundamental core component of Concordance Desktop, and there are a
variety of tools to assist you in this process. You can use all of them, deciding which you
prefer or produces faster results depending on the task and issue currently at-hand.

There are search tools for locating specific record content, each one specific to the type
of search you are conducting:

· Quick Search (full-text and relational)

· Persistent Search (full-text)

· Find Attachments (full-text)

· Simple Search (full-text)

· Advanced Search (full-text and relational)
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· Form Search (full-text and relational)

When only searching documents, make sure that the View image (camera) button on
the Dynamic toolbar is not activated, otherwise it will open images in Concordance
Desktop Image.

Running quick searches

Quick Search is similar to using the Internet browser to locate information. Use Quick
Search to find information quickly in the Browse or Table views without having to open the
Search panel. You can use it for fast, simple searches or to copy and paste in complex
search strings. Toggle the All button to switch between viewing all case records or those
in your current query.

When using punctuation characters in your search term, at least one letter needs to
be inserted between the punctuation characters. For example, joe&i@email.com.
Using two or more punctuation characters together (joe&@email.com) will not work.

To run a quick search:

1. In the Search field, type the search value or string.

You can enter up to 255 characters to build your query.

2. Click the Go button or press Enter to initiate the query.

All records containing the search value you entered are displayed in Table view, and
the first record is displayed in the Browse view.

Notice that search value is highlighted in red in the Browse view. A search value
highlighted in red is called a hit in Concordance Desktop. 

3. To navigate to each hit in a document, click the Next Hit button.

4. The Search field stores your recent quick searches. You can select, edit, and rerun
any search stored in the Search field list. To access a recent quick search, click the
Search field down arrow, and select the query. To rerun the search, click the Go
button or press Enter.



Document Review 57

Running simple searches

Simple Search is a great way for new Concordance Desktop users to jump right in and
start searching records. Simple Search is designed similar to the Google Advanced Search
query for familiarity. You can immediately locate information using the parameters provided
in the task pane without having to use or learn about search operators.

Simple Search is available in the Search task pane in Concordance Desktop.
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Simple Search is the most basic full-text search for a one-word query, reviewing the
contents of all indexed fields, and finding an exact word match in seconds. You can also
search for more than one word or phrases. Searching in Concordance Desktop is not case
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sensitive, so you can type keywords in the manner that is most comfortable for you.  You
can enter up to 128 characters in a single search option field to build your query.

Expand the width of the Search task pane, so that more text can be entered and
viewing is easier. You can always resize the pane to a smaller setting once a
document is open for review.

To run a simple search:

1. Open the Search task pane.

2. Open the Simple Search panel.

3. To expand your task pane for better viewing, drag the navigation pane bar to the
right.

4. Enter your search criteria.

Simple Search Options

Field Name Definition

with all of the
words

Conducts an and search to find document records containing all
terms listed

with the exact
phrase

Conducts an adjacent search to find document records containing
terms found together

with at least one
of the words

Conducts an or search to find document records containing any
of the words listed

without the
words

Conducts a not search to find document records that do not
contain any of the words listed

When using punctuation characters in your search term, at least one letter needs
to be inserted between the punctuation characters. For example,
joe&i@email.com. Using two or more punctuation characters together will not work
(joe&@email.com).

5. Click the Search button to initiate the query.

All records containing your search criteria are displayed in the Table view. 

The first record of the search results is displayed in the Browse view, and your
search value is also highlighted in red in the Browse view. Use the Next hit and
Previous hit buttons on the Dynamic toolbar in the Browse view to jump from one
highlighted word to the next. 
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When navigating search results in an ideographic language, like Chinese, one
character can represent a word. Clicking the Next hit button jumps to the next
character in the search results. For more information, see Navigating Search
Results for Ideographic Languages.

The Status bar indicates the number of records found.

To remove Search criteria:

In the Simple Search panel, click the Clear form button.

Using persistent search

Save time during review using the new Persistent Search Hit Highlighting.  Persistent
Search stores a list of search terms that can be easily executed within a database to find
records that contain the specified term(s) and highlights them in the Browse View. It is a
search query, that when enabled, remains active even after the results are returned.  The
Persistent Search feature searches for the terms included in the
<databasename>_Persistent.txt file and highlights term(s) in each record where they are
found.  To add terms to the Persistent Search text file, contact your Concordance
Desktop Administrator.  

When new records are added to a database and the Persistent Search feature is enabled,
simply reindex the database and then the new records are automatically included in the
search results if the records meet the criteria.  

The color used to highlight the terms found in the record from the list of terms in the
<databasename>_Persistent.txt file is set on the Searching tab in the Preferences dialog
box.  For more information, see Defining preferences. 

If you use a space in a persistent search term, the hit highlighting displays as red,
instead of the color you have set.  
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Persistent Search terms highlighted in the Browse View

The Persistent Search feature may be run in conjunction with the Quick, Simple, and
Advanced Search queries to refine the search results even further.  However, when
combining search queries a maximum number of 255 characters is allowed.  If a search
is performed and then Persistent Search is activated make sure that the total number
of characters does not exceed 255 to ensure the correct results are returned. 

The Persistent Search text file, <databasename>_Persistent.txt, is stored in the
corresponding database folder and accessed only by the associated database. In the case
of concatenated databases, the Persistent Search text file associated with the primary
database is used for all the databases in the concatenated set.

The Activate button can be used with the Persistent Search option to run previous search
queries.  If the Persistent Search option is enabled in the Search pane and then the
Activate button is selected in the Review view, Concordance Desktop returns all the
records that contain both the terms in the query and the Persistent Search text file.  For
more information, see Running previous search queries.
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When adding words to the persistent text file that include 16 bit characters, such as
Korean, Chinese, etc., save the text file as UTF16 instead of ANSI, so that the 16 bit
characters are supported.  

When combining Persistent Search and other search options, make sure that the
Persistent Search option is enabled before running any additional queries.  However,
Persistent Search is automatically disabled after executing the Find Attachments
command.  

The Review view does not list the Persistent Search terms in the Search Terms(s)
column; however, the Number of Hits column does count the terms in the total
number of hits.

To enable/disable persistent search:

1. To enable Persistent Search, do one of the following:

· From the Search menu, click Persistent Search.

· In the Navigation pane, click the Search tab to open the Search task pane, and then in
the Options section click the Persistent Search check box.

2. To disable Persistent Search, do one of the following:

· From the Search menu, click Persistent Search.

· In the Navigation pane, click the Search tab to open the Search task pane, and then in
the Options section clear the Persistent Search check box.

If you click the 'All' button on the standard toolbar, all the records in the database
are returned and Persistent Search is automatically disabled.  Click the All button a
second time to reactivate the Persistent Search.

To use persistent search with another query:

1. Do one of the following to enable Persistent Search:

· From the Search menu, click Persistent Search.

· In the Navigation pane, click the Search tab to open the Search task pane, and then
in the Options section click the Persistent Search check box.

2. Enter the new search query using Quick, Simple, or Advanced Search features.  For
more information, see Running quick searches, Running simple searches, Using the
Advanced Search panel.

The search results returns all records having one or both the search term and the
term(s) listed in the <databasename>_Persistent.txt file. 
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3. To return to all the Persistent Search results, in the Search field type 0.

4. To return to all the documents in the database, on the Standard toolbar, click the
All button.

Finding attachments

When paper documents are scanned to TIFF formatted files and loaded into Concordance
Desktop, parent documents and their attachments may be broken into separate records. 
If a document and its attachments are scanned as one document, there may be only a
Begin and End Bates number field for each record in the database that reflects whole
documents.  If parent documents and attachments are separate records there may be a
Begin and End Bates number as well as a Begin and End Attachment field or Attachment
Range field in the database for each record.

When native e-mail files are processed, they may be converted to TIFF formatted files, in
which case, they could be treated the same as paper document TIFF formatted files, in
terms of the Begin and End Bates number and Attachment number fields in the database.
If they are not converted to .tiff files and were reviewed in native format, document ID
fields are used to assign a unique identifier to each document and attachment.  A
document ID is a document level identifier, rather than a page level identifier.

When searching a database that has documents and attachments, the search results may
return some of the attachments for a document but not the parent document, or just the
parent and not the attachments, etc.  If it is important to produce the entire document
set (parent and all attachments related to those document that returned as the result of
a search), it may be necessary to run the Find Attachments command to gather the
related parents and attachments. 

The Find Attachment command gathers related parent and attachment documents in a
database based on the fields containing the attachment information for an active query.
The Find Attachments command looks for attachments where the attachment ranges are
stored in a single field or two separate fields. The Find Attachments can be set up when
creating a database using the New Database Creation wizard, or using the preferences. 
For concatenated databases, only the primary database settings will work for all other
databases in concatenated set, even if non-primary databases have different settings.
For more information about setting up the fields for the Find Attachment command for the
database, see Defining preferences.

When using the Find Attachments feature, it is best practice to setup the fields as
paragraph type fields to increase the performance and make sure to index/reindex the
database. For more information about the Find Attachments command, see Finding
attachments.

To locate documents and related attachments:
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1. Run the appropriate search to locate the documents for review.

The search results are returned.

2. To find related attachments, on the Search menu, click Find Attachments.

3. When finished, press Enter.

To run a query and include all documents and attachments:

1. In the Search field, type the query to locate the documents and attachments.

2. In the Navigation pane, click the Search tab.

3. In the Options section, click the Include Attachments check box.

4. On the Search toolbar, click the Go button .

Advanced Searching

There are two ways to query a Concordance Desktop database: full-text and relational.
Each method has a distinct purpose in locating information efficiently. But both methods
can be combined and used in the Quick Search bar and the Advanced Search panel.

Full-text searching is the faster search method in Concordance Desktop, enabling you to
examine the contents of free-text paragraph fields using words and phrases with various
search operators and parameters narrowing the query results. Relational searching is used
to query fixed fields, most commonly defined as numeric, date, or fixed-length text. One of
Concordance’s most powerful features is its ability to combine these search methods,
allowing you to search both field types at once — saving critical review process time by
maximizing your query potential.

Searching Benefits: Full-text versus Relational

Searching Benefits: Full-text Versus Relational

Full-text Relational

Searches the dictionary, uses index to
display words from dictionary search

Searches the database in real time

Very fast Slower (depending on size of database)

Highlights hits in red Does not highlight hits

Can only be used to search indexed fields Can search any field, indexed or not
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Searching Benefits: Full-text Versus Relational

Full-text Relational

Easy to search multiple fields at once Searches one field at a time (Unless fields
groups are established in the .INI file)

Used more often to find words Used more often to find dates, numbers,
ranges, comparisons

Cannot be used on date fields Can find specific dates or a range of dates
within limits or outside limits

Often used on paragraph fields Normally used on paragraph fields only to
find empty/not empty fields

OCR1 EQ "" finds empty fields

OCR1 NE "" finds populated fields

Cannot be used until the database has
been indexed. Will not find new data until
database has been reindexed.

Can be used whether or not the database
has been indexed

Cannot be used to find stopwords, since
they are not in the dictionary

Can be used to find stopwords

Uses the * wildcard character.

Can be used before or after the word.

Uses the * wildcard character only at the
end of a word. Use the ? wildcard character,
to replace a single character in the middle
of a word and in data searches.

Always searches the complete contents of
paragraph fields

Only searches the complete contents of
paragraph fields when using CO and NC
operators

In the Browse view, you can distinguish between the different fields:
· Non-paragraph fields are preceded with an equal sign =
· Paragraph fields are preceded with a colon :

Running full-text searches

A full-text search is designed for text and words, and is the most flexible search feature
provided by Concordance Desktop. A full-text search uses the database’s index to quickly
sift through every word entry (of every record) entered in the database index dictionary –
similar in design to the Google search engine, which is also based on indexing. Your
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Concordance Desktop index is generated after your record collection is entered into the
database. The dictionary is created during the indexing process and includes every word in
indexed fields, except for stopwords, to improve searching speeds.

Terms entered in the search are highlighted in the record (red is the default color setting)
and are referred to as a hits. You can quickly navigate to every hit in a given record by
using the Previous Hit and Next Hit buttons on the Dynamic toolbar.

There are three sets of operators and one wildcard you can use for full-text searches:

Boolean (document level)

Boolean operators are based on the binary logic used in computers today, producing
strict true or false results. In Concordance Desktop, Boolean operators search at the
document level. The most common Boolean operators are: AND, OR, and NOT. The
search is not case sensitive, so you do not have to enter all caps for the Boolean
operators.

Table of Boolean Operators

Boolean Operators

Operator Query Results

AND contains both words milk AND coffee All documents with both the
words: milk and coffee

OR contains either word milk OR coffee All documents with either
milk or coffee, or both

NOT contains first word,
but not second

milk NOT coffee All documents with milk, but
not coffee

XOR milk NOT/OR coffee All documents with milk or
coffee, but not both words
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Boolean search operators are used in the Simple Search panel, but the operators are
hard-coded for you. 

Typing spaces between words is important to separate the word you are searching
from the operator word (AND, OR, NOT). For example, type spaces where you see
the underscore: milk_AND_coffee.

Using XOR saves time in locating documents by combining two separate word
searches into one, pulling all documents that either have milk or coffee in them,
but not milk and coffee in the same record.

Context (field level)

Context operators are great for locating authors and recipients of records, if these
fields are entered in your database. Context operators search at the field level. If you
are searching the AUTHOR and RECIPIENT fields for a particular name, the query results
will be a list of documents to and from that person. The search is not case sensitive, so
you do not have to enter all caps for the context operators.

Context operators include SAME and NOTSAME qualifiers including or excluding fields.
The SAME and NOTSAME operators are not commonly used, but field limiters are used
frequently to narrow a search for a particular field or to omit fields, saving valuable
search processing time.

Table of Context Operators

Context Operators

Operator Query Results

SAME DOCTITLE SAME bank Both terms exist in the
same field

NOTSAME DOCTITLE NOTSAME bank Both terms never exist in
the same field

Field Limiters

      .FIELD.

     ..FIELD.

cowco.DOCTITLE.

correspondence.doctype.

Looks in the named fields

cowco..ocr1.

memorandum..doctype.

Looks in all other fields
except for the named field

Example: cowco.ocr1.
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This query searches for cowco in the ocr1 field.

Example: milk SAME coffee

This query searches for documents where milk and coffee are both found in the same
field. If they occur in the same document, but not in the same field, the document is
ignored.

Typing spaces between words is important to separate the word you are searching
for from the operator word (SAME, NOTSAME). However, when you are using the
periods/field limiters, you want to skip spaces and type the words and periods
together in a tight search string, because the periods are a coding language for
specifying the inclusion or omission of a field (milk..ocr1.). If you add a space
between milk and ..ocr1, the application will not read your search query.

A context operator search with word..fieldname. locates the word with an
exclusion. The word can still exist in database records, it is just not part of your
specific search. For example, a search for milk..ocr1. locates milk in all fields,
except for ocr1. This search is helpful for locating keywords in metadata fields,
excluding a search on the record’s body content.

Proximity (word level)

Proximity operators search at the word level and are useful when looking for content
that appears in records either in direct succession or adjacent order, or in close
succession to each other within a specified range. You can add a qualifying number
from 0 to 255. This number refers to the maximum number of intervening indexed words,
excluding stopwords.

Table of Proximity Operators

Proximity Operators

Operator Query Results

ADJ (default operator) milk ADJ programs Both terms are immediately
next to each other and in
the order specified

Produces the same results
as typing milk programs

ADJ25 milk ADJ25 programs Both terms appear within
25 words of each other

ADJ# operator has a 255
word limit
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Proximity Operators

Operator Query Results

NEAR milk NEAR programs Both terms are within close
range of each other
regardless of order, i.e.
programs for milk

NEAR255 milk NEAR255 programs Both terms appear within
255 words of each other

NEAR# operator has a 255
word limit

The default Proximity operator is ADJ. So a search for file note is actually searching file
ADJ note. This selection can be customized by your Concordance Desktop administrator
for your personal searches, as needed.

Typing spaces between words is important to separate the word you are searching
from the operator word (ADJ, NEAR). For example, type spaces where you see the
underscore: file_ADJ_note.

Proximity operators are hard-coded into the Form Search tool.

Wildcard (field and character masking)

Searching for people’s names can be complicated. Names can be misspelled or include
variations of punctuation. You’ll want to investigate the method used at your
organization for entering names into your Concordance Desktop databases. This helps
you determine how to search to ensure that you do not exclude any possible variations
of someone’s name.

If you are searching for a name in an email database, you will notice that there are
many email address formats depending on the Internet service provider’s account type.
You may miss a critical record in an email address search if you are not careful about
how you query it. Using wildcard characters helps ensure that the recipient name is
located, regardless of the email format.

Examples:

· jsmith@organization.com

· J_Smith@organization.com

· john.smith@organization.com

· jsmith@gmail.com
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Names in documents are also easily misspelled and could be overlooked if apostrophes
and initials are combined in records. Using a wildcard symbol as a substitute for a
character or series of characters, masks the individual character fields in words
creating a broader search with stronger results.

Table of Wildcard Characters - Full Text

Wildcard Characters - Full Text

Character Query Results

Asterisk (*) replaces a
character at the beginning
or end of a search string

*count* Finds account, accountant,
country, countries, and
discount

milk.ocr*. Searches ocr1, ocr2, ocr3,
etc.

When searching for a person, think about all the fields in which this name might be
printed or referenced, and also become familiar with the field titles used in your
databases, as these can vary. For instance, when searching for Weller in one
database, it may be necessary to specify the To and From fields. In another
database, you may need to search in the Author and Recipient fields.

Search strings that do not include white space are limited to 64 consecutive
characters. 

Using the Advanced Search panel

The Advanced Search panel allows you to type longer, complex search strings. You can
still conduct simple, one-word searches as well. The added benefit of using Advanced
Search is your query results also display the number of word hits found and how many
documents it appears in. The hits and document counts are listed in the Hits and Docs
columns in the Results field on the Advanced Search panel.

Reviewing your search results:

· A summary of your search results are displayed in the Results field.

· The Results pane displays the search results for each individual term, and the search
results for the entire search string. After running your query, the search results for the
entire search string is displayed in the last row of the Results field and is highlighted in
gray. 
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· Double-clicking a term in the Results field narrows your search to only those
documents containing the term. The search results are displayed in Table view. The
first document in the search results is displayed in the Browse view.

You can enter up to 255 characters to build your search logic in the Advanced Search
panel. If a complex search string exceeds this limit, you may want to run two separate
searches and later combine them in the Review screen using the search numbers.
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The Advanced Search panel also contains more tools to assist you with your case
review:

· Display the database dictionary

· Display a list of available fields

· Display a list of words that sound like the selected word

Using the Dictionary

Use your database dictionary to search for keywords and also to add dictionary entries
directly into a search string in the Advanced Search panel. You can also use your
dictionary to see if a word already exists in the dictionary. If a word is not in the
dictionary, use relational searching. 

The dictionary contains every word, other than stopwords, in the database since the
last time it was indexed or reindexed. If the database is concatenated, the dictionary
feature displays only words in the primary database.

To open the Dictionary list:

1. In the Search task pane, do one of the following:

· In the Advanced Search panel, click the Display the database dictionary link
.

· Click the Form Search panel to open the Query by Example dialog box, and
click the Dictionary button.

2. In the Dictionary dialog box, scroll through the dictionary list or type the first
letters of a word to scroll directly to that entry. 

3. To add words to the search string, do one of the following:
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· Select the word, and then click Add.

· Double-clicking the word. 

4. When finished, click the Close button.

The maximum length of a dictionary word is 64 characters. Due to this limit, only
the first 64 characters of a long word are included in the dictionary. Since the full
word is not listed, it may not be found in the database. For example, including the
file name and path in a word can create a word longer than 64 characters, and
the full word will not be found in the database.

Adding Dictionary words to search queries

If you have a list of common words for your review, you can quickly locate the words
in the dictionary and run a search query for each of the words in the Advanced
Search panel to identify how many times these words appear in records, and to
locate the applicable documents. 

There are two ways to add a dictionary word in the Dictionary dialog box to a search
query in the Advanced Search panel. You  can select the word and click the Add
button, or double-click the word. If you are adding multiple words at once to a
search query, double-clicking the words also automatically adds the OR search
operator, so pay attention to how you add dictionary words to a query, as it affects
your search results.

Example: Dictionary words are added as adjacent (ADJ) words in the Advanced
Search field if you add the words separately or by clicking the Add button in the
Dictionary dialog box.

Example: Dictionary words are added with the OR operator to the Advanced Search
field if you add multiple words at one time by double-clicking the words in the
Dictionary dialog box.

To add dictionary words to a search query:
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1. In the Advanced Search panel, click the Display the database dictionary
link to open the Dictionary dialog box.

2. Scroll to and select the words you want to add to your search query.

To quickly search for a word in the dictionary, you can type all or part of the
word in the field below the dictionary list to locate a word. For example, if you
type c, the dictionary automatically scrolls to the first word in the dictionary
that starts with c. 

3. Double-click the dictionary word or click the Add button to add the word to
the Advanced Search field.

When you double-click multiple dictionary entries at one time, rather than
clicking the Add button, Concordance Desktop automatically inserts the OR
search operator into the search query. When you add multiple dictionary words
separately or by clicking the Add button, Concordance Desktop treats the
words as adjacent (ADJ) words in the query. Pay attention to how you add
dictionary words to a query, as it affects your search results.

4. Click the Close button to close the Dictionary dialog box.

5. In the Advanced Search panel, click the Search button to run a query for
records containing the selected words.

Searching by fields

Field search narrows a query to a specified field in the active database. You can view
the fields in a database and add field entries directly into a search string in the
Advanced Search panel of the Fields dialog box. Referencing your Fields dialog box is a
great way to verify exactly what your database field names are. For example, searching
for goniff*.TO. when the field is actually named RECIPIENT will not return any search
results.
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To add fields to a search query:

1. In the Advanced Search panel, click the Display a list of available fields link
to open the Fields dialog box.

2. Locate and select the fields you want to add to your search query.

3. Double-click the field or click the Insert button to add the field to the
Advanced Search field.

Concordance Desktop automatically inserts the field limiters into your search
string and separates the additional fields with commas.

4. Click the Cancel button to close the Fields dialog box.

5. In the Advanced Search panel, click the Search button to run a query for
records containing the selected fields.

Searching Fuzzy words

Fuzzy searches are great for finding misspelled words. A fuzzy search looks for
homonyms in the database dictionary; finding words that look like and sound like your
term. For example, milk, mild, and mike are homonyms. You can view the words similar
to your search term and add these fuzzy word entries directly into a search string in
the Advanced Search panel in the Fuzzy Search dialog box.



Document Review 77

Fuzzy searches provide a 65 percent character match for each word, offering a list of
best guesses. If you combine this search with asterisks around the *word*, you will get
more fuzzy results.

To add fuzzy words to a search query:

1. In the Advanced Search panel, type the word you want find homonyms for in
database dictionary.

2. Click the Display a list of words that sound like the selected word link to
open the Fuzzy Search dialog box.

3. Locate and select the words you want to add to your search query.

You can select multiple words in the Fuzzy Search dialog box. To select multiple
individual words in the list, use CTRL+click. To select a block of words in the list,
use SHIFT+click.

4. Click OK.

Clicking OK adds the selected words to the Advanced Search field and closes
the Fuzzy Search dialog box.

When you add multiple fuzzy word entries at one time, Concordance Desktop
automatically inserts the OR search operator into the search query.
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5. In the Advanced Search panel, click the Search button to run a query for
records containing the selected fields.

Running relational searches

Relational searches query the entire database in real time. This search is based on a
specified field for a specified value, scanning every record in the database (usually only
one field). Relational searches are primarily used to search unique value fields, Bates
numbers, dates, fixed-length text fields, and other short fields.

Relational searching does not require an indexed database to search current data. Unlike
full-text searching, you can search on all punctuation and stopwords in the database.
Because Concordance Desktop is searching the actual database data in real time, and not
a dictionary or index, relational searching can take longer than full-text searching. 

Relational searches can be done on full-text fields, but it is best practice to use full-text
searching for full-text fields when you can to save time.

Relational search results are not highlighted in red. Instead, you receive a list of records
containing your query results in the Table view. It is best to try initial queries in a full-text
search before conducting a relational search to ensure you are using the dictionary when
you can.

Field Groups are not supported in relational searching. Use full text searching for Field
Groups.

Syntax

Relational search requests are entered in a structured query format. Every fixed
field query contains at least three elements:

field name OPERATOR data value

The fixed field name to search

A relational operator

The selection criteria

Example: 

ISBM = 0-477-01-482-8
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The sample query searches the ISBN field in every record in the entire database for a
value equal to 0-477-01482-8. Relational searches can run faster if you combine them
with a full-text search:

wonder wheels and date <= 4/25/1994

In this case, the fixed fields are examined only in the documents located by the full-
text portion of the query. The result line for the date query would apply only to the
documents that contain wonder wheels. It is not an indication of all possible matching
dates in the database.

Concordance Desktop provides ten relational operators for relational searches. Like full-
text queries, relational searches are not case sensitive. You may enter your search in
upper, lower, or mixed-case letters. You can search for a subset of characters in a
field, for a partial match of characters, or for an exact match.

Concordance Desktop allows you to use wildcard characters in fixed fields. You can use
a wildcard to mask single characters (?), or to mask the remainder of a word (*). The
masking capability is not available when selecting on numeric fixed-length fields.

Searching for multiple values

Search for several values at once by separating them with commas. Spaces between
the values are optional. If you are searching for a value, which itself has a comma in
it, then the value must be placed in quotes.

Example: AREACODE = 213, 818, 310, 714

Relational Operators

There are ten relational operators available in Concordance Desktop. These operators
compare your search criteria with the contents of the fixed field specified in your query.
Some of the relational operators have a symbolic equivalent, such as eq and =, both of
which mean equal to. These may be used interchangeably and are listed below. When
performing a relational search you want to type the field first, then the data value you
are searching.

Relational Search Format

field name OPERATOR data value

Relational Operators reference table
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Relational Operators

Symbol Abbreviation Description

= EQ Equals

<> NE Not equal to

> GT Greater than

< LT Less than

>= GE Greater than or equal to

<= LE Less than or equal to

$ CO Contains

! NC Does not contain

(no symbol) WL Within limits, includes
stated values

(no symbol) OL Outside limits, excludes
stated values

Typing spaces between words or symbols is important to separate the word you are
searching for from the operator symbols or letters (CO, WL, GT, etc.), otherwise the
search won’t work. For example, type spaces where you see the underscore:
milk_NC_coffee.

The CO and NC operators are only valid when searching text or paragraph fields. If used
on numeric or date fields, Concordance Desktop processes the request as if you had
entered EQ or NE respectively. A search for OCR CO milk locates words like unmilked
and milking because it includes the four characters in milk and anything before or after
it.

The WL and OL operators search for ranges, within limits and outside of limits. These
operators require two criteria to specify the range. The following search would locate
any record with a DUEDATE field greater than or equal to January 1, 1993 and less than
or equal to March 15, 1995.

Example:

DUEDATE WL 1/1/1993, 3/15/1995
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If you are searching for a value that has operators, then the value must be placed
in quotes. For example: OCR1 CO “$5,000”

Example: 

doctitle = untitled

doctitle EQ untitled

Both of the relational operators produce the same search results

If you need to find a specific record and know the Bates number, run a relational
search.

But first check your dictionary to see if they are included by your administrator. If
numbers are included, you can skip relational searches for them and run a full-text
search instead.

Example: 

docdate WL 10/01/1983,12/31/1984

This query finds all documents from October 1, 1983 though December 31, 1984.

Use the date format that is standard for each database.

Example: 

pages WL 5,10

This query finds all documents that are five to 10 pages in length. Four-page
documents or 11-page documents are not included in the search results.

Concordance Desktop searches numbers and dates in sequential order, so it’s best
to train yourself to enter them in that order: smaller number first, then bigger
number (5,10), and earlier date, then later date (10/01/1980,12/31/1983).

Wildcard Characters - Relational

When Concordance Desktop reads a relational search, it views each individual
character. The root of the search criteria can be masked (*) or individual characters
can be masked (?) using the wildcard characters. For relational date searches, you
must replace each digit in a date query with a wildcard character while using slashes
based on the existing date format for your database.

Example: 
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8 and date eq 01/??/1986

All documents identified in query eight with any date in January 1986 are retrieved.

Example: 

organization co wom?n*

The query selects documents that contain the words WOMAN, WOMEN, WOMANHOOD,
etc., in the organization field.

Relational Wildcard Characters reference table

Wildcard Characters - Relational

Character Query Results

Asterisks (*) replace a
single text character at the
end only

BEGNO = 0001* Locates all Bates numbers
that begin with 0001

Question mark (?) replaces
a single character

DOCDATE = ??/??/1983 Locate all records in 1983

Quotation marks (“) are
required for searching
operators

OCR1 CO “$5,000” Locates all records
containing $5,000 in
addition to $5,000,000
because of the CO operator

Quotes in Relational Searching

All spaces in a relational search string are automatically trimmed from the search. If you
need to perform a relational search for an entry with spaces or any special characters,
enclose the criteria in quotes. The text must be quoted if the criteria itself has spaces
or commas in it. Below is a fixed field search with spaces and special characters.

Example: 

STATUS = "PAID STATUS?"

Remember that Concordance Desktop inserts the default operator wherever it finds a
space. So, without the quotes, Concordance Desktop would interpret the above query
as STATUS = PAID ADJ STATUS?, and it would locate zero records.
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Running complex clause searches

A complex clause search is a search string containing a combination of both full-text and
relational search clauses. Stringing both full-text and relational searches together and
combining complex clauses together saves query processing time, thus providing faster
search results. 

Use Notepad or another text pad editor program to brainstorm your searches as the
larger text box makes it easier to read onscreen. Type one clause per line and cut
and paste them together, rearranging them until you find the right order. Then simply
copy and paste the string into a Concordance Desktop search tool to run the query.

Type full-text clauses first, then relational, to conduct efficient queries resulting in a
distinct outcome. Full-text searches are faster than relational, so by executing this search
first, the secondary relational search is only running the full-text results as opposed to the
entire database – saving you valuable processing time.

Example: goniff*.ocr1. AND docdate = ??/??/1983

The full-text search for Goniff in the OCR1 field is performed before the relational search is
conducted for all records from 1983 containing Goniff.

In the Results box, you will find records with Goniff hits that appear in the DOCDATE field.

To remember whether fields come first or last in a search clause depends on the search
method used:

· Full-text searches: the field is typed last

goniff*.recipient. or (financial report).doctype.

· Relational searches: the field is typed first

docdate WL 05/04/1982,05/20/1982

Use care when querying names. Some names may be coded with the person’s initials,
especially in email: goniff*.recipient. vs. goniff;ja.recipient. Use a wildcard character,
like an asterisk, to mask the name in full-text searches. This will provide wider results.

Use relational searching to search for empty or populated fields.

• Use fieldname EQ “” to located records where the field is empty.

• Use fieldname NE “” to locate records when the field is populated with any value.

Form Searching

The form search performs the same full-text and relational searches as manually typed
searches, but a form search has the operators hard-coded for you. Clicking the Form
Search panel in the Search pane or selecting Form Search from the Search menu opens
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the Query by Example dialog box. Form searches are built and run from the Query by
Example dialog box.

The form search can be used as a query builder if you are unfamiliar with the various
searching operators. Notice each of the column headers at the top. Your first search
connector will always start with New; then you need to tell Concordance Desktop
Where to Look, How to Look and what word you want Concordance Desktop to Look
For. To build complex queries, use the search connector fields to join various query
strings that you determine for each line.

You can enter up to 85 characters per field with a maximum of 255 characters
total for all fields to build your search logic.

Concordance Desktop determines whether to run a relational or full-text search for you.
If you understand searching concepts and want to use the form search to run all your
complex queries, remember to place your all your full-text searches before the relational
searches in the Query by Example dialog box.

The Query by Example dialog box is limited to ensure it remains simple to use. For
more complex searches, you can use the Advanced Search panel to enter longer
queries, add parentheses more precisely, review the results of each word when
using wildcards, and use a larger range of query operators.



Document Review 85

To build and run a form search:

1. To open the Query by Example dialog box, do one of the following:

· In the Search task pane, click the Form Search panel.

· From the Search menu, click Form Search.

The Connector field in the first row always defaults to New. 

2. If you are creating a new search query, leave the default value, New, in the first
row.

If you are filling out more than one row for your search query, select the
appropriate connector from the Connector field in the additional rows. 

You can also change the first search connector, *New*, to another operator. The
new query will be added to the previous query. For example, if you search for milk
in the Quick Search bar it will now be search #1 (or the next sequential number).
You can then open the Query by Example dialog box, change the first connector
to adj and search for Corp. The new search query will be 1 adj Corp and will find
where milk is adjacent to Corp.

3. From the Where to look field, select the field you want to search.

4. From the How to look field, select the operator you want to use.

In the How to look field CO Contains is equivalent to EQ Equals, and NC Does not
contain is equivalent to NE Does not equal.

5. In the Look for field, type the specific value you want to search for.

6. When finished, click the Search button.

After clicking the Search button, your search query is displayed in the text field
and the number of hits and documents found for your search are displayed at the
bottom of the Query by Example dialog box.

To view your query results:

Do one of the following:

· Click the Search then Browse button to display the search results in the
Browse view.

· Click the Search then Table button to display the search results in the Table
view.

· Click the Done button to display the search results in the current view.

You can edit your search in the text box and run it again to receive different results.
You can insert words from the dictionary into your search string using the Dictionary
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button. When you add a word from the dictionary, the word is inserted wherever
your cursor is in the text field.

Combining Search Strings

Using Boolean search operators, join search clauses together.

Example: 

milk OR calcium NEAR25 coffee

This query locates all documents with either milk or calcium within 25 words of coffee.
The search results omit instances where milk or calcium are in a document, but not
within 25 words of each of coffee because the NEAR operator carries a higher
precedence than the OR operator.

Use of spaces when typing search strings becomes very important and is
dependent on the type of search operators you are using.

· Use spaces when using word operators (AND, OR, NOT, SAME, NOTSAME, ADJ,
and NEAR). For example, type spaces where you see the underscore:
milk_AND_coffee

· Omit spaces when using field limiters ( . or .. ). For example, do not type
spaces before or after the field limiter: cowco.doctitle.

· If you combine operators and limiters, you still need spaces before and after
the operator: Goniff*.AUTHOR._AND_Weller*.RECIPIENT.

Using Parentheses for search precedence

Like mathematics, Concordance Desktop uses a hierarchy to evaluate search
expressions. Use parentheses liberally in complex search strings to clarify query logic
and enforce operator precedence. Searches within parentheses are evaluated before
they are combined with other search operators. Parentheses have the highest
precedence and can be nested up to 50 levels deep.

The following table includes Boolean, context, and proximity operators and the order of
precedence they carry in a Concordance Desktop search. Refer to this table when you
are combining one or more clauses together to know which operator clause to place
first, and which is secondary. Use the parentheses to combine two or more clauses
when additional clauses are included in the search logic, but are secondary in emphasis.

Operator Order of precedence reference table
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Operator Order of Precedence

Operator Description

ADJ Locates words that are immediately adjacent, and you can specify
a range of intervening indexed words from 0 to 255

NEAR Locates words that are near each other, and you can specify a
range of intervening indexed words from 0 to 255

SAME Finds words within the same field

NOTSAME Finds words that do not occur in the same field

AND Combines words and search results that occur in the same
document

NOT Combines words and search results if they do not occur in the
same document

OR Combines words and search results, whether they occur in the
same documents or not; Concordance Desktop doesn’t care

XOR Finds documents that contain one of two search terms, but not
both

Example: milk OR (calcium NEAR25 coffee)

In this example, the NEAR operator carries a higher precedence than OR, and
Concordance Desktop searches clauses within parentheses first. The results of the
calcium NEAR25 coffee search would then be processed as milk OR results.

Examples:

financial ADJ statement OR report

This query locates financial statement or report.

financial ADJ (statement OR report)

This query is focused on finding statements or reports containing the words financial
statement or financial report.

Example: (Correspondence.doctype. AND Goniff*.Recipient.) NOT date = ??/??/1982

This query forces Concordance Desktop to run a full-text search first for all
correspondence records to Mr. Goniff, with a secondary emphasis that eliminates
anything from the year 1982.
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Searching by tally

Tally is a great tool for gaining an item count for a specific field to help you organize your
document collection and for quality assurance checks. Perhaps you need to quickly
determine how many contracts are currently in your caseload or verify if any new ones
have been added to the database since you started your review. Organize your
documents by type so you can search a subset for critical information. Or, find out how
many times a key witness is mentioned by tallying the Author field. A Tally count itemizes
this information for you so you can perform internal quality assurance checks in your case
review, organize documents by field type, or narrow your searches off a reduced set of
records. The Tally feature is only accessible from the Table view and runs a query only on
the selected field column.
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In the Tally task pane, you can:
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· Reset the tally list for a new search

· Print a tally list for quality assurance reference

· Save the tally list to a text file for tracking purposes

For more information about using Tally for printing needs, see Tallying records for reports.

To run a field tally in the Table view:

1. In the Table view, right-click in a field column.

2. Select Tally [field name] to tally the field. 

3. The tally results are displayed in the Tally task pane.

4. Double-click an item in the tally list to display the records in the Table view and the
first corresponding record in the Browse view.

Each time you double-click a tally list item, you are narrowing your search results based
on your initial query.

· To sort the tally results, click the tally column headers to sort by item or count.

· To return to the original document listing, click the Reset link.

· To print your tally results, click the Print link.

· To save your tally results to a text (.txt) file, click the Save link.

· To close the Tally task pane, click the Close link. To hide the Tally task pane, click
another task pane icon.
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Searching by tags and issues

You can also search by tags and issues in the Tags task pane. Searching by tags or
issues allows you to locate documents tagged in a specific category and marked with
internal issues. You can also search your record collection by tags, using the Review
screen or conducting a query on applied tags.

For more information about searching by tags or issues, see Creating queries from tags
and Querying tags and folders.

Creating a synonyms list

When you perform a search for a word, Concordance Desktop automatically searches for
any synonyms associated with that word in the database dictionary. Synonyms are
created and managed in the Synonyms dialog box. 

Synonyms can be based on words already entered in your database dictionary, creating a
permanent link between them, or other search terms in Concordance Desktop. You can
also create synonyms from the fuzzy words list, to include homonyms or words that “look
like” and “sound like” those already in your dictionary and synonyms listings. Fuzzy words
provide a 65% character match on search terms, but fuzzy searches can miss words
longer than the search term.

Synonyms are stored in the .syn file and fuzzy words are stored in the .fzy file. Both files
are located in the same directory folder as the primary database.

Here are some examples of synonyms you can create:

· Common American English and UK English spellings, such as color and colour

· OCR errors and misspellings

· For acronyms

· For complex query expansions (Automatic synonym expansion is suppressed when you
place a search term in quotes.)

· Associating generic drug names with brand name medications 

· Associating e-mail messages to a person’s name 

· Capturing misspellings of a person’s name 

For more information about fuzzy searches, see Using the Advanced Search panel.

To create a synonyms list:

1. On the File menu, point to Dictionaries, and click Synonyms.  Clicking Synonyms
opens the Synonyms dialog box.
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2. In the Dictionary list, click the word you want to link to synonyms.

To search for a word in the Dictionary list, type or select part or all the word you
are looking for in the Dictionary field below the Dictionary list.

If you only want the Dictionary list to display words already associated with
synonyms, select the Limit the words to Synonyms check box. If you want the
Dictionary list to display each word in the dictionary, clear the Limit the words to
Synonyms check box. 

You can manually adds words to the synonym list or add words to the synonym list
from the Fuzzy matches list. You can associate multiple synonyms with a dictionary
word. 

3. To manually add a word, in the Synonyms field at the bottom of the Synonym
list, type in the corresponding synonym and click the Add button.

Clicking the Add button adds the word to the Synonyms list. Repeat this step for
each of the synonyms you want to associate with the selected dictionary word.

4. To add a word from the Fuzzy matches list, in the Fuzzy matches list, click the
word and click the double arrows, <<, button.

5. When finished, click OK.

To check the synonyms associated with a dictionary, you can run a search for the
word in the Advanced Search panel in the Search task pane. You should see the
synonyms listed as hits in the Results list in the Advanced Search panel since they
are linked to the word in the dictionary.
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Saving Searches

Reviewing and saving your work history is essential for tracking purposes, especially during
complex and lengthy reviews. After conducting a series of searches, you’ll want to review
your search history to combine previous searches into a new search to narrow your
results and rerun prior queries to capture updates in the record recollection. You will also
want to save previous queries to a file for tracking purposes or to rerun them at a later
time.

Saving search queries

There are several reasons to save your search queries. A benefit to saving queries is that
once stored, they will collect new data on future executions. The next time you open the
query file, Concordance Desktop automatically reruns all previous query criteria and
includes them in the current session’s search listing. This provides you with a foundation
of queries to build upon in your advanced search efforts and saves you data entry time.

You may want to save your searches if:

· You are interrupted during a complicated set of searches that you want to resume
later.

· You need to perform some searches on a regular basis for production reports or
privilege-status logs.

· Other reviewers need to retrieve your search results from another computer at a later
time.

· You want to run the searches on another database.
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Queries are saved as .qry files. These are editable text files containing only the search
string. Rerunning a saved query file reprocesses all searches for the file. This process can
take extra time since Concordance Desktop is re-executing all of the searches. You can
execute a .qry file on other databases. If you re-execute it in another database,
remember that you will need to resolve any field discrepancies between them by editing
the search strings or by making a copy of the search and editing it. For example, the To
and From fields in one database may be titled Author and Recipient in another one.

Each reviewer needs to save their query file with a unique file name on a shared
network. Your network will not allow multiple files of the same name to be created in
the same folder. We recommend each user adds their initials to the end of the file
name to differentiate it from others and make it easily identifiable to each person.
This rule does not apply to personal or local folders. This example has initials at the
end of the file name: F:\DATA\CONCORDANCE\TUTORIAL\SEARCHES\LAM.QRY
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If you don’t need to re-execute a .qry file, then you can save queries as .txt files by
right-clicking on a query in the Review view and selecting Save. Unlike a saved .qry file,
which only stores your search clause, a saved text file also stores the number of hits and
documents for that query. Saved .txt files are useful in referencing search history.

To save search queries:

1. To open the  Review view, do one of the following:

· Click the Review button on the standard toolbar.

· From the View menu, click Review view.

· Press F3 on your keyboard.

2. To open the Keep Queries dialog box, do one of the following:

· In the Search task pane, click the Save all queries to a saved query file.

· From the Search menu, click Save All Queries.

3. Browse to where you want to save the file.

4. Type the name of the .QRY file in the File name field.

5. Click Save.

To clear the queries from the Review view:

Once you have saved your queries, to clear the queries from the Review view, do
one of the following:

· In the Search task pane, click Clear search history.

· On the Search menu, click Clear Search History.

To rerun saved queries:

1. Do one of the following:

· In the Search task pane, click Execute a saved query.

· On the Search menu, click Execute Saved Queries. 

2. Locate and open the .qry query file. 

Concordance Desktop reads the file and reruns all the searches in the query file. If
any records were updated before you restored the query, your search results are
automatically updated. The search results display in the Review view as soon as
they are executed.
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Reviewing search queries

The Review view provides a complete, numerical listing of all searches conducted since
you opened Concordance Desktop or it was last reindexed. Use the Review view for
tracking purposes or simply to save your queries at the end of your Concordance Desktop
session. The Review screen references all search scenarios already conducted on a record
collection. The listing is also a foundation for building advanced searches to narrow results
for key criteria.

Because each search query is numbered sequentially, you can select one or more to
combine two previous queries into a new one. The Review screen conducts searches
based on Boolean operators, so you can also exclude previous queries from a new search
using the OR or XOR operators when combining multiple search numbers in a complex
query. Concordance Desktop references a query by number faster than if you re-type the
query words.

Example: 2 AND 3

Using the queries listed in the Review view image above, the 2 AND 3 query searches for
all documents from 1980 with Goniff in the RECIPIENT, AUTHOR, OR CC fields.

Reviewing recent queries is easy. You can click the drop-down arrow in the Search field to
view your recent queries, and rerun and edit previous searches from the Search field. You
can also copy an advanced search string into the Search field to save it and rerun at a
later time. Queries in the Search field list are stored for one Concordance Desktop session.

The Review view does not list the Persistent Search terms in the Search Terms(s)
column; however, the Number of Hits column does count the terms in the total
number of hits.

Zero Query

To search the entire database or resort it after running several queries, run a Zero
Query by typing a zero, 0, in the Search field. The zero is predefined in Concordance
Desktop to locate all records in a database and resort them in their original load order
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and is always the first search run when opening a database. You can combine the zero
with operators to narrow query results.

Example: 0 NOT milk

This search first locates all records in the database, then narrows the results to
exclude all documents that contain the word milk.

Example: 0 NOT 9

This search locates all database records, then narrows the results to exclude the query
results found for search number 9 in the Review view.

Using the Search field is the fastest way to search the entire database or conduct a
Zero Query, and is a useful tool when rerunning or excluding results in previous
searches tracked in the Review view.

Running previous search queries

When you click the Review button in the Standard toolbar, two additional Dynamic toolbar
buttons become active: Edit and Activate. The Edit button adds queries from the Review
view to the Advanced Search panel. The Activate button initiates a previous search query
and the search results are displayed in the Table view.

The Activate button can be used with the Persistent Search option.  If the Persistent
Search option is enabled in the Search pane and then the Activate button is selected,
Concordance Desktop returns all the records that contain both the terms in the query and
the Persistent Search text file.

The Review view does not list the Persistent Search terms in the Search Terms(s)
column; however, the Number of Hits column does count the terms in the total
number of hits.

To review a previous search query:

On the Standard toolbar, click the Review button. 

All searches conducted since you opened the Concordance Desktop session are saved
and displayed in the Review view.

 

To rerun a previous search query:

In the Review view, do one of the following: 
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· Double-click the search query.

· Select the search query, and then on the Dynamic toolbar, click Activate.

· Right-click the search query, and then click Activate.

The first record of the search results displays in the Browse view. You can also view
the query results in the Table view.

To copy a previous search query:

In the Review view, do one of the following: 

· Right-click the search query, click Copy Query, and then right-click in a search
field and click Paste.

· Select the search query, and then on the Dynamic toolbar, click Edit.

· Right-click the search query, and then click Edit.

The query displays in the Advanced Search panel, where you can add or edit the
search logic for a new query.

To combine and run search queries using query numbers:

1. In the Search Number column in the Review view, locate the query numbers for
two previous searches.

2. In the Advanced Search box, type in the numbers for those two search queries.

For example: 3 AND 9. 

It isn’t necessary to type in the preceding zeros displayed in the Search Number
column.

3. Click the Search button.

Combining both search queries narrows your search results. Remember that the
number of keyword hits and documents found display in the Results field of the
Advanced Search panel.

Basic Tagging

A new case has started and boxes of printed documents, CDs, DVDs, and other discovery
documents have arrived and need to be reviewed and categorized. In a traditional setting,
someone would have to manually sort and flag each document, hoping that the privileged
flags don’t fall off in the process.
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With Concordance Desktop, you no longer need to worry about lost flags and managing
boxes of papers and electronic media files. If your case documents have already been
entered into Concordance Desktop, you can step into the review process with the bulk of
the headache-inducing tasks already completed, and start reviewing and categorizing
documents.

Tagging records is a critical step in the discovery process. It is your organization’s way of
essentially putting color-coded flags on your documents to categorize them by privilege,
review status, or other criteria during document review.

When reviewing a concatenated dataset, all tags in all databases display in the Tags
panel. If you apply a tag from one database to a record in another database,
Concordance Desktop automatically writes that tag into the record’s corresponding
database. See Concatenating Databases for more information about joined datasets.

Preliminary planning for tagging

To help you manage the case review process, your Concordance Desktop administrator
typically builds a set of tags for case review that include standard naming conventions,
such as privileged, responsive, non-responsive, etc. Tags can also be added in the
Tags task pane and can be removed at any time. There are no limits on tagging. You
can tag as many documents as you want, with as many tags as you want.
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Once tags are applied to document records, the tags become searchable, allowing a
user or administrator to easily retrieve all documents with a particular tag.

Typical tag uses

The following tag list provides examples of the types of tags organizations use to
categorize documents during the document review process. You should consider in
advance what tags will be required for both high-level review and specific research
angles for your case. Collaborate with your Concordance Desktop administrator so
these tags can be set up in advance.

· Responsive vs Non-responsive - identify responsive documents that must be produced
as part of the discovery process

· Privileged - identify documents containing information that should not be produced

· Witnesses - identify documents for witness kits or binders used in depositions or
trials

· Reviewer Assignments - delegate documents to be reviewed by individual
reviewers

· Exhibits - identify documents that will used as exhibits

· Issues - identify documents related to key legal issues in the case

· Keywords - identify documents containing important terms in the case

· Other

Tagging strategies

In order to gain the most benefit from tag use, please consider the following:

· Determine how your database will be used by reviewers, so tags can be created in
advance.

· Use consistent tag and folder names for better organization.

· As a general rule, search first, tag second. This method allows you to focus on
documents containing key terms or other search criteria, which limits the number of
documents that need to be reviewed.

· For field-level tags, once all documents are tagged with a particular tag, consider
adding a field value to the database to permanently categorize these documents.

Tagging records

New tags are easily added to a list of persistent ones that are custom designed for a
particular case. Any new tag created is immediately accessible to all users in Concordance
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Desktop. This provides a standard format, easy access, and a faster, more efficient
review for all users.

Often tags are placed in folders or grouped by type or purpose so all reviewers have an
immediate understanding of the case tag organization.

Tag names always display and sort alphabetically. If you intentionally want a tag to
appear in a specific location, use the tag name to accomplish that.

Tagging individual records

Before you begin tagging records, it is best practice to run a search to limit the number
of documents you have to review.

Tags can be applied and removed by any user, at any time. Contact your
Concordance Desktop administrator or supervisor if you have concerns regarding
the permanence of applied tags.

To apply a tag to a document:

1. Open the Tags task pane.

2. Run the appropriate search to limit the documents you have to review.

3. Review your search results and identify the documents you want to tag.

4. In the Table view, select the document. 

You can also tag documents from the Browse view. Tags can be applied to the
document currently displayed in the Browse view.

5. In the Tags task pane, do any of the following:

· Click the tag's check box.

· Right-click the tag and click Tag document.

· Double-click the tag's name. 

When you double-click a tag Concordance Desktop can either apply the tag or
open the tagging options menu. The double-clicking option is set on the Browsing
panel in the Preferences dialog box. Double-clicking a tag to apply the tag is the
default setting.

A red check mark appears in the tag's check box and the tag is now applied to
the document.

To remove a tag from a document:
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1. Select the document in the Table view. 

You can also remove tags from documents in the Browse view. Tags can be
removed from the document currently displayed in the Browse view.

2. To remove the tag from the document, in the Tags task pane do one of the
following:

· Clear the tag's check box.

· Double-click the tag's name. 

When you double-click a tag Concordance Desktop can either apply the tag or
open the tagging options menu. The double-clicking option is set on the Browsing
panel in the Preferences dialog box. Double-clicking a tag to apply the tag is the
default setting.

The tag's check box is now cleared and the tag is removed from the document.  

Tagging multiple records

In some review projects, you may want to conduct searches first and tag all
documents for review later. This method is often referred to as bulk tagging. 

For example, if you want to review all documents containing references to Mr. Goniff,
you can search for these documents and tag all the documents in the search results for
a later review.

Tags can be applied and removed by any user, at any time. Contact your
Concordance Desktop administrator or supervisor if you have concerns regarding
the permanence of applied tags.

When bulk tagging, do not drag and drop (move) tags from one folder to another,
as it can produce duplicate tags, as opposed to just moving the tags.

To apply a tag to multiple documents simultaneously:

1. Open the Tags task pane.

2. Run the appropriate search to limit the documents you have to review.

3. Open the Table view to view the search results.

4. In the Table view, select all the documents you want to apply tags.

5. In the Tags task pane, do one of the following:
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· Click the tag's check box, right-click the tag, and then select Tag all
documents in query.

· In the Table view, drag the documents selected to the tag in the Tags panel. 

· Double-click the tag's name. 

When you double-click a tag Concordance Desktop can either apply the tag or
open the tagging options menu. The double-clicking option is set on the Browsing
panel in the Preferences dialog box. Double-clicking a tag to apply the tag is the
default setting.

A red check mark appears in the tag's check box, and the tag is now added to
each of the selected documents. 

To apply a tag to all documents and attachments in a query simultaneously:

1. Open the Tags task pane.

2. Run the appropriate search to limit the documents you have to review.

3. Open the Table view to view the search results.

4. In the Tags panel, right-click the tag, and then select Tag Query &
Attachments.

If no attachments are found for a document, the selected tag is applied to all the
documents in the current query.

5. When prompted, confirm the number of documents to tag.

A red check mark appears in the tag's check box, and the tag is now added to
each of the selected documents and associated attachments. 

To remove a tag from multiple documents simultaneously:

1. Open the Tags task pane.

2. Run the appropriate search to limit the documents you want to remove a tag.

3. Open the Table view to view the search results.

4. In the Table view, select all the documents you want to remove tags.

5. In the Tags task pane, click the tag's check box, right-click the tag, and then
select Untag all documents in query.
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The tag's check box is now empty and the tag is removed from each of the
selected documents.  

Creating a query from tags

If you need to identify which documents have a particular tag applied to them, you can
easily do so by creating a query from a tag.

To create a query from tags:

1. Open the Tags task pane.

2. In the Tags task pane, select the tags you want to query. 

You can select multiple tags by pressing the SHIFT or CTRL key while selecting
multiple tags.

3. Right-click the selected tags and select Create query from tag(s).

All documents that are tagged with the selected tags display in Table view.
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Advanced Tagging

Organizing tags

Folders are used to organize similar types of tags, allowing you to easily focus on the tags
that matter to you at that moment. Once a review has begun, you can review tag history
and statistics to see what tags are applied to a document, who applied the tags and
when. You can also perform queries on multiple tags or folders, allowing you to use a
document’s tag status as part of a complex search.

Creating folders

When you create a folder you must add at least one tag to the folder, or the folder will
not be saved. You cannot create empty folders.

To create a folder:
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1. Open the Tags task pane.

2. In the Tags task pane right-click, point to New, and then click Folder.

3. Type the name of the new folder and then press Enter.

4. Right-click the new folder, point to New, and then click Tag to create a tag
within the folder.

5. Type the name of the new tag and then press Enter.

When you are creating a folder, you must add at least one tag to the folder.

To create a folder and set of tags for your individual review of documents, you can
easily do so. For more information, see Creating Personal Folders and Tags.

If you need to remove a folder or tag, contact your Concordance Desktop
administrator.

Creating Personal folders and tags

To keep the tag panel uncluttered for all users, you can create a personal folder and
custom tags specific to your own review needs. When you create personal folders, they
are not visible in the Tags panel for other users. 

1. Open the Tags task pane.

2. In the Tags task pane right-click, point to New, and then click Folder.

3. Type the name of the new folder, and then press Enter.

Personal folders are pink and can only be viewed by the user who created the folder
and the administrator. All public folders are yellow.

4. Right-click your personal folder, point to New, and then click Tag to create a tag
within the folder.

5. Type the name of the new tag, and then press Enter.

When you are creating a folder, you must add at least one tag to the folder, or the
folder will not be saved when you end your Concordance Desktop session. You
cannot create empty folders.

If you need to remove a folder or tag, contact your Concordance Desktop
administrator.

Reorganizing tags and tag folders
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1. Open the Tags task pane.

2. In the Tags task pane, do any of the following:

· To move a single tag from one folder to another folder, select the tag and drag to
the new folder.

· To move multiple tags, press CTRL and click the tags to move, and then drag the
tags to the new folder.

· To move a folder and all the tags in the folder, click the folder and drag to the
new location.

· To move multiple folders, press CTRL and click the folder to move, and then drag
the folders to the new location.

For a tag folder to exist in Concordance Desktop, it must have at least one tag in
it.  If you move all the tags out of a folder, the folder will be deleted.

Creating queries from tags

As your team reviews documents and categorizes them using various tags, you may want
to search on multiple tags to find documents that have more than one tag applied. For
example, you may want to run a search to find all documents that your team has tagged
as both Responsive and Privileged so you can redact content prior to production. You can
search on multiple tags individually or by folder.

Query results are displayed within the Tags task pane and the Review screen, where they
are stored and can be rerun later. A query created from a tag becomes the current query
and it can be used just like any group of retrieved records. Concordance Desktop stores
the tagging information in the .TRK file, so it remembers the tagged documents and tag
descriptions between query sessions.

Querying tags by a tag

There are two ways you can query multiple tags. You can query multiple tags together
in one query or you can query the tags individually and then combine the individual
queries into one complex search query.

For more information about complex search queries, see Running complex clause
searches.

To query multiple tags combining individual queries:

1. Open the Tags task pane.
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2. In the Tags task pane , select the tag you want to query. 

3. Right-click the selected tag and select Create query from tag(s).

All documents that are tagged with the selected tags display in Table view.

4. In the Tags task pane, select another tag to query.

5. Right-click the selected tag and select Create query from tag(s).

All documents that are tagged with the selected tags display in Table view.

6. Click the Review button on the Standard toolbar to review your queries in the
Review view.

7. In the Review view, identify the search numbers for both of the tag queries you
created.

8. In the Search field, type the numbers with the AND operator between them and
press Enter.

For example, if the searches were numbered 12 and 13, then type 12 AND 13 to
combine the two searches.

The Table view displays only those documents that have both tags applied.

This new search combines the initial queries into a new complex query, locating
documents that contain both tags.

Querying tags by folder

If you need to identify which documents have particular tags from a specific tag folder,
you can easily do so by creating a query from a folder.

To create a query from folders:

1. Open the Tags task pane.

2. In the Tags task pane, select the folders you want to query. 

You can select multiple folders by pressing the SHIFT or CTRL key while selecting
multiple folders.

3. Right-click the selected folders and select Create query from tag(s).

This selection says tag(s) instead of folders, but the query process applies to
both tags and folders.

The Table view displays all the documents tagged with any of the tags in the
selected folders.
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Searching by tags and issues

You can also search by tags and issues in the Tags task pane. Searching by tags or
issues allows you to locate documents tagged in a specific category and marked with
internal issues. You can also search your record collection by tags, using the Review
screen or conducting a query on applied tags.

For more information about searching by tags or issues, see Creating queries from tags
and Querying tags and folders.

Viewing tag history

The Tag history panel displays two types of information:

· Added Tags - tags that exist on the current document record, including who applied
the tag and when it was applied.

· Deleted Tags - tags that previously existed on the current document record, but are
now removed, including who deleted the tag and when.

As you navigate records, your tag history changes to reflect the history of each selected
document.
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To review tag history:

1. Select a document record that has been tagged.

2. Open the Tags task pane and select the Tag history panel.

3. Scroll to view all tags that are applied and removed from the current document.

4. Click the plus or minus sign next to the tag status to view or hide a category
listing. 

Viewing tag statistics

The Tag statistics panel allows you to monitor the tags applied, in categories by tag or
reviewer, for a certain time frame. This feature is useful when monitoring an individual’s
review progress.
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To review tag statistics:

1. Open the Tags task pane and select the Tag statistics panel.

2. In the From and To fields, select the date range you want to review.

3. Click the Refresh button to display the tag statistics.

4. Scroll to view all tags and users listed.

The Tags list displays the name of the reviewers who applied the tag, and how
many records the tag was applied to by the user. 

The Users list displays the tags applied by each reviewer, and how many times the
user applied each tag. 

5. Click the plus or minus sign next to the users and tags to view or hide the
statistics. 
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Sorting Records

The results of any search are sorted in the order in which the documents are added to the
database. You may want to sort your documents chronologically, by author, by document
type, or by any other field you have in your database to help speed up your review.  

The Sorting layout feature provides additional tools to customize and save how records
are sorted in the Browse view to display the desired result.  For more information, see
Using sorting layouts.   The Table layout feature provides the tools to create customized
public and a private layouts for viewing data in the Table view.  For more information, see 
Using table layouts.  

When you are sorting, you need to remember that it only affects your current search
results.

Additional methods for sorting records:

Returning all records

After sorting and reviewing your records, you can to refresh the sort order to its
original state using the All button. Click the on the Standard toolbar All button to
quickly return all records to the sort order in which they were added to the database.
You can also toggle the All button to switch between your current query and viewing all
records in the database.

Quick sort

After running any search, you may want to sort your documents to view them
chronologically, by author, by document type, or by any other field you have in your
database.

In order to sort your documents by a field, click a column heading in the Table view.
Documents are sorted in ascending order by the selected field. To sort in descending
order, click the column heading a second time.  The arrow in the column header
indicates the current sort order.  For more information, see Using table layouts.
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Sorting by selected fields

In the Table view you can sort documents by a single field. With Sorting layouts, you
can go a step further and perform multi-level sorting of records using up to four fields
at once.  For more information, see Using sorting layouts

Using sorting layouts

The Sorting feature in Concordance Desktop determines the order records are displayed in
the Browse view. The fields selected in the Sorting Layout dialog box define the order the
records are returned for viewing.  For example, if you select to sort the records by the
fields:  BEGNO, DOCDATE, and AUTHOR, then the records are first sorted by the records
BEGNO number, then the document date and then by the document's author.  You can
also choose whether the field is to sort in Ascending or Descending order.  

Sorting layouts are created and maintained in the Sorting Layout dialog box and saved as
a .Sortlayout file on your local machine in the same directory as the database. There are
no limits to the number of sort layouts that can be created and saved; however, sort
layouts are specific to the database for which they were created.  

Sorting layouts are specific to a database and user.  Therefore, if you are working in a
database and using a sorting layout that you created, and another user accesses the
same database, the sorting layout you are using is not affected by the other user or their
sorting layout.  

Sorting layouts are compatible with concatenated databases.  The fields available in the
Sorting Layout dialog box are those fields associated with the primary database.  

When creating sorting layouts for concatenated databases, keep the following in
mind:
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· All databases in a concatenated set are sorted according to the sorting layouts for the
primary database when accessed from the concatenated set.

· Database fields in a concatenated set other than the primary will not appear in the
Sorting Layout dialog box unless they are opened separately.

· If the field structures for the primary database do not completely match the field
structure of concatenated databases, the sorting layout may not sort the
concatenated databases as expected.

· In order for field structures of concatenated databases to match, they must have
identical field names and field types and be listed in the same order.

· Each sorting layout is limited to four fields.

It is recommended that the .Sortinglayout file not be marked as Read-Only as this will
prevent the ability to create or switch layout views.

Sorting layout dialog box

Icon Description

Single Database and Compatible Concatenated Databases

Primary database

Available sort layout

Field sort order - Descending

Field sort order - Ascending
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Incompatible Concatenated Databases

Available sort layout containing fields that are not
compatible with the concatenated set of databases

Field sort order - Descending (inconsistent layouts may
appear for each concatenated database)

Field sort order - Ascending (inconsistent layouts may
appear for each concatenated database)

To create a sort layout:

1. On the Standard toolbar, click the Sorting button.

2. In the Layouts tree, click the New button.

3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list, do one of the following:

· Drag a field to the new layout.

· Double-click a field. 

· Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields
to the new layout.

5. To change the order of the fields sort the database in the layout, in the Layouts tree,
drag a field to the desired position.

6. To set sort order for the field data, right-click the field, and then click either Ascending or
Descending.

7. When finished, click OK.

To modify a sort layout:

1. On the Standard toolbar, click the arrow next to the Sorting menu, and then click Sort
layout to open the Sorting Layout dialog box.

2. To change the field order, drag a field in the Layout tree to the desired location.

3. To remove a field, in the Layout tree, do any of the following:

· Right-click a field, and then click Delete.

· Double-click a field.

4. When finished, click OK to apply your changes.
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To view a sort layout:

Do one of the following:

· From the View menu, click Sorting, and then click the layout name.

· On the Standard toolbar, click the arrow next to the Sorting menu, and then click
the layout name. 

To delete a sort layout:

1. On the Standard toolbar, click the Sorting button arrow, and click Sort layout to open

the Sorting Layout dialog box.

2. Right-click the layout you want to delete in the Layouts tree and then click Delete.

To rename a sort layout:

1. On the Standard toolbar, click the Sorting button arrow, and click Sort layout to open

the Sorting Layout dialog box.

2. Click the layout name to change, and then type a new sort layout name.

The default user sort layout is automatically created when the database is opened.
 This sort layout cannot be renamed.

Using table layouts

The Table view uses table layouts to determine the fields and order of the fields displayed
within the view. Table layouts can be used to customize viewing preferences or to support
sort methods specific to a review.

Table view layouts are created and maintained on the Table Layout dialog box. For each
database, each user has one private layout, that is accessible only to the user. Any
additional layouts created for a database are public and accessible to everyone using the
same database. A database's public layouts can be created, edited, or deleted by anyone
in the database.
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Be selective when creating table layouts for a database. Too many table layouts in a
database can slow down the database's processing speed.

If you have a table layout design that works well in other databases, you can copy and
paste the .layout file into other database directories, and then rename the file with the
new database name. 

If you are using Table View to display long documents, such as depositions or
resumes, you can get much faster performance if you do not display full text
Paragraph fields. If necessary, add fixed length fields to your database, which have
identifying information, such as a name, date and serial or volume number. Then use
those fields for Table View. By selecting only fixed length text, date or numeric fields,
large full text portions are not loaded. This improves performance for long document
types.

It is recommended that the .layout file not be marked as Read-Only as this will
prevent users from creating or switching layout views.

To create a table layout:

You can only make new layouts for the database currently selected. Any layouts
created in addition to your private table layout are accessible to all reviewers, and can
be altered or deleted by them as well.

1. On the Standard toolbar, click the Table button arrow, and then click Table
layout to open the Table Layout dialog box.



Concordance Desktop 118

In the Table Layout dialog box, the green box with your Windows User ID is your
private table layout that is customizable and viewable only by you.

Users are permitted one private table layout per database.

2. In the Layouts tree, click the New button to create a new layout .

3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list do any of the following:

· Drag a field to the new layout.

· Double-click a field to add the field to the new layout. 

· Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields
to the new layout.

The order the fields are listed in the Layouts tree is the order in which the fields
appear in the Browse and Edit views.

5. To change the order of the fields in the layout, click a field in the layout and drag it to the
desired position in the Layouts tree.

6. When finished, click OK.

7. To view a saved layout, on the Standard toolbar, click the arrow next to the Table
button, and then click the layout name. 

The Table view layout is not persisted if a sorting layout is applied to the view. 
Creating a sorting layout will automatically apply a Zero query, returning all
documents and sorting the records based on the specified sorting layout.

To modify a table layout:

1. On the Standard toolbar, click the Table button arrow and click Table layout to
open the Table Layout dialog box.

2. To change the order of a field in a table layout, click a field in the layout and drag it
to the desired place in the Layouts tree.

3. To remove a field in a table layout, right-click a field in the layout and click Delete.

You can also double-click a field in the layout to remove the field.

4. Click OK to close the Table Layout dialog box and apply your changes to the Table
view. 

To view other table layouts:
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In the Table view you can switch between the different table layouts created for the
selected database.

On the Standard toolbar, click the arrow to the right of the Table button then click
the layout name for the layout you want to view in the Table view. 

The check mark next to a layout indicates the layout currently displayed in the
Table view. 

To delete a table layout:

Only public table layouts can be deleted in Concordance Desktop. When you delete a
table layout, it is deleted for all users using the same database.

You cannot delete your private table layout or the table layout currently displayed in
the Table view. The Delete command in the Table Layout dialog box is unavailable for
private table layouts and the table layout currently displayed in the Table view.

To delete the public table layout currently displayed in the Table view, you first need to
display a different layout in the Table view.

1. On the Standard toolbar, click the Table button arrow, and click Table layout to
open the Table Layout dialog box.

2. Right-click the layout you want to delete in the Layouts tree and then click
Delete.

Editing Records

Concordance Desktop is fully equipped to handle a rolling production environment with
features that allow editing records as needed. Attorneys find the editing tool useful for
adding comments directly to a document record during the case review. Administrators
can add an Attorney Notes field to the database for this purpose.

The editing tool is also useful when there is limited information in the database to search.
Sometimes a paralegal or staff member may be assigned to add missing information, such
as the dates, authors, and recipients, to every document in a database to help locate
documents authored by a particular individual to another individual within a specific time
frame during searches.

When the Edit view is opened the Edit pane appears on the left and the Edit toolbar at
the bottom of the workspace.  By default the Edit view is blank, providing the ability to
customize the view to display only those fields you want to edit for each record in the
database.  The Edit pane lists all the available fields that can be added to the view.  Only
those fields you have full rights can be edited.

The customization of the Edit view is not available for the Append and Ditto features.
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Edit tools

When you click the Edit button on the Standard toolbar, the four Edit view tools on
Dynamic toolbar are displayed:

· Fields - accesses a field listing to insert data from another field

· Ditto - allows you to copy field data from another record Note that Ditto can on be
used on migrated 10.x DAT, E-mail and Attachment, or Transcript databases. Ditto
cannot be used for Concordance 10.21 E-document databases, and all databases
created in Concordance Desktop. 

· Delete - allows you to mark or unmark a document for deletion 

· Undo - displays the Edit Options dialog to allow you to undo or abandon edits

Edit Options dialog box

Clicking the Undo button on the Dynamic toolbar opens the Edit Options dialog box.
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The Edit Options box offers the following options:

· Reset document - removes applied edits and restores the record to its original
state

· Blank document - erases all field content in a record

· Delete document - marks the record status for deletion

· Undelete document - removes the Delete status for a record

· Abandon and quit - exits the current record and exit Edit mode, any applied edits
are not saved

Rich Text toolbar

When you click the Edit button on the Standard toolbar, the Rich Text toolbar displays
under the Standard toolbar. On the Rich Text toolbar you can adjust the font size,
color, and spacing in edit form fields.

Edit Mode options

When opening up a record in edit mode in the Edit view, Concordance Desktop has
formatting options that can be applied to data within a specific field. These formatting
options include: Upper case, Lower case, Capitalize, and Reset field formatting. 
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To change the format of existing data within a field:

1. In the Edit view, select the word or blocks of text that you want to format. 
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2. Right-click the text and click the applicable formatting option.

Your changes are saved when you navigate to another record or view in
Concordance Desktop.

Creating edit layouts

To make editing easier, Concordance Desktop provides the ability to select specific fields
and change the order they are displayed in the Edit view.  Changing field display settings
only affects your view of the fields, it does not affect field display for other users. These
field settings apply to all records within the database.

Concordance Desktop uses edit layouts to determine the fields and order of the fields
displayed within the view. Edit layouts are created and maintained on the Edit Layout
dialog box and stored in the <databasename>.Editlayout file. An edit layout can be
created or edited by anyone in the database.  However, only the Concordance Desktop
Administrator or person who created the layout have permissions to delete it.

When creating an Edit Layout for a concatenated set, only the fields of the primary
database are displayed in the Available Fields list for non-identical concatenated
databases.

The .Editlayout file should never be marked as Read-Only, as this will prevent users
from creating or switching layout views.
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To create an edit layout:

You can only make new layouts for the database currently selected. All edit layouts are
accessible to all reviewers and can be altered by them as well.

1. Do one of the following:

· On the View menu, click Edit View, and then Edit Layout.

· On the Standard toolbar, click the Edit button arrow, and then click Edit layout.

· On the Standard toolbar, click the Edit button, right-click within a field, point to Layout
and then click Edit Layout.

2. In the Edit Layout dialog box, click the New button to create a new layout .

3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list do any of the following:

· Drag a field to the new layout.

· Double-click a field to add the field to the new layout. 

· Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields
to the new layout.

The order the fields are listed in the Layouts tree is the order the fields appear in
the Edit view.

5. To change the order of the fields in the layout, in the Layouts tree, click a field and drag
it to the desired position.

6. When finished, click OK.

The new layout view is displayed in the Edit view.

To modify an edit layout:

1. Do one of the following:

· On the View menu, click Edit View, and then Edit Layout.

· On the Standard toolbar, click the Edit button arrow, and then click Edit layout.

· On the Standard toolbar, click the Edit button, right-click in a field, point to Layout and
then click Edit Layout.

2. In the Edit Layout dialog box, from the Layouts tree, select the layout you want to edit.

3. Do any of the following:

· To change the field order, click a field and drag it to the desired location in the
Layouts tree.

· To remove a field, right-click a field in the Layouts list, and then click Delete.
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You can also double-click a field in the layout to remove the field.

4. When finished, click OK. 

If all the fields are removed from a layout, then the layout itself is removed.  The
active layout cannot be deleted.

To view saved edit layouts:

In the Edit view you can switch between the different edit layouts created for the
selected database.

Do any of the following:

· On the View menu, click Edit View, and then click the layout name to view.

· On the Standard toolbar, click the Edit button arrow, and then click the layout name to
apply.. 

· On the Standard toolbar, click the Edit button, right-click in a field, point to Layout and
then click the layout name to view.

The check mark next to a layout indicates the edit layout currently displayed in the
Edit view. 

Editing records

Editing existing records is done most often when records are added to Concordance
Desktop but are missing information that needs to be captured in the system to identify it,
such as the document title, author, and date it was created. 
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If you are an attorney entering summary notes or a paralegal adding missing data to
records, you are only able to access fields that you have permission to edit. Fields that
can’t be edited display in gray. Other data entry restrictions may be placed on fields by
your Concordance Desktop administrator.

Each time you edit a record, any changes are saved when you navigate to another record
or change your view in Concordance Desktop.  New information is not full-text searchable
until the database is reindexed to refresh the dictionary.

If you try to edit a record that someone else has open for editing, the record will be
locked and displays as read-only with gray fields and a LCK notification displays in the
Status bar.

For more information about field lists containing word selections that reduce data entry
time, see Using Word Lists.

Editing = coding. Use caution when working in the Edit view. You can spoliate
documents if you are not careful, damaging the integrity of your original database
records and impacting the search results of others.

To edit an existing record:

1. In the Browse or Table view, select the record .
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2. On the Standard toolbar, click the Edit button to activate edit mode for the record.

By default, all the fields are displayed in the Edit view.  Some fields may be gray
because you don’t have permission to edit these fields.

3. To apply an edit layout, do one of the following:

· On the View menu, click Edit View, and then click the layout name to apply.

· On the Standard toolbar, click the Edit button arrow, and then click the layout
name to apply.

· In the Edit view, right-click within a field, point to Layout and then click the
layout name to apply.

For more information about Edit Layouts, see Creating edit layouts.

4. To resize a field in the Edit view, select the bottom border box of the field and drag
it down the page to expand the field size. The fields are distinguishable by having a
raised border and can be resized during data entry to make editing easier.

5. Make your edits.

Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

6. To reindex the database, on the File menu, click Reindex.

Using Word lists

In most document databases, some data entry work is unique, like attorney review
comments, but much of it is repetitive. For example, if you are cataloging
correspondence between the principal players in a case, the same names are repeated
again and again.

Having these names or other repetitive words available in word lists allows you to insert
them in respective database fields reducing the amount of typing necessary. This
feature also minimizes data entry errors. For example, you can pick Wocjieweiski from a
list instead of having to remember how to spell it each time you need to enter the name
into a field.
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Word lists can be used for any repetitive data entry fields, such as document type
(letters, memos, reports, etc.), privilege (attorney client privilege, trade secret, etc.),
or any field where the same set of terms is used over again.

Word lists are set up by your Concordance Desktop administrator. If you want a word
list added to a particular field, contact your Concordance Desktop administrator.

There are numerous ways to open a word list in Concordance Desktop. You can only
open a word list when you are in the Edit view.

To open a word list:

For fields associated with a word list, the first time you click in the field, the
associated word list automatically opens. To open the word list if the word list does
not automatically open, begin typing the value or right-click in the field to open the
associated word list. 

For fields not associated with a word list, do one of the following: 

· Press CTRL + L, select the word list, and click Open.

· Right-click in the field and click Word Lists or the associated field list. If you
select Word Lists, navigate to and open the word list file.

· On the Edit menu, click Lists, then Word Lists, and then navigate to and open
the word list file. 

To populate a field using a word list:

1. In the Browse or Table view, select the record.

2. On the Standard toolbar, click the Edit button to open the Edit view and
activate edit mode for the record.

By default, all the fields are displayed in the Edit view. Some fields may be gray
because you don’t have permission to edit these fields.

3. To apply an edit layout, do one of the following:

· On the View menu, click Edit View, and then click the layout name to apply.

· On the Standard toolbar, click the Edit button arrow, and then click the layout
name to apply.

· In the Edit view, right-click within a field, point to Layout and then click the
layout name to apply.

For more information about Edit Layouts, see Creating edit layouts.

4. For fields associated with a word list, the first time you click in the field, the
associated word list automatically opens in the Word List dialog box. To open
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the word list if the word list does not automatically open, begin typing the value
or right-click in the field to open the associated word list. 

For fields associated with a word list, you can also populate the field with a value
from a different word list. To use a value from a different word list, click the field.
 From the Edit menu, point to Lists, and click Word Lists.  Navigate to and open
the word list file.

For fields not associated with a word list, click field you want to populate and
open a word list. To open a word list do one of the following:

· Press CTRL + L, click the word list, and then click Open.

· Right-click in the field and select Word Lists or the associated field list. If you
click Word Lists, navigate to and open the word list file.

· On the Edit menu, click Lists, then Word Lists, and then navigate to and open
the word list file.

5. Select a value from the word list and click the Add button.

For long word lists, you can quickly locate the value you are looking for by typing
the first couple letters or characters of the value in the field below the word list.
For example, typing S takes you to the values beginning with the letter S.

The Add button adds the selected value to the field and closes the Word List
dialog box. 

Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

6. To reindex the database, on the File menu, click Reindex.

To add a new entry to a word list:

1. Open a word list.

2. Type the value you want to add to the list in the field below the word list.

3. Click the Insert button.



Concordance Desktop 130

To delete a value from a word list:

1. Open a word list.

2. Select the value you want to delete from the word list.

3. Click the Delete button.

Formatting field text

In the Edit view you can format individual field text. You can change the text's case and
add or remove rich text formatting. When you modify text formatting in a field in the Edit
view, the formatting only applies to the field text in the current record.

If rich text formatting has been applied to field data, you may need to change the rich
text formatting in a field to plain text to save space or remove certain text formatting
that affects the precision of hit highlighting when searching in Concordance Desktop.

If you need to remove rich text formatting from a field in multiple records in the database,
administrators can use the Bulk Field Format Reset feature. For more information about the
Bulk Field Format Reset feature, see Removing rich text from multiple records. 

To change text case in the Edit view:

1. In the Edit view, open the record containing the text you want to modify.

2. Select the text.

3. Right-click the selected text and click one of the following:

· Upper - changes each letter in the selected text to upper case.

· Lower - changes each letter in the selected text to lower case.

· Capitalize - changes the first letter of the selected text to upper case. If you
selected multiple words, the first letter of each word will be capitalized.

The Upper, Lower, Capitalize functions are also available using the Format option
under the Edit menu.

Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 
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To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

4. To reindex the database, on the File menu, click Reindex.

To add rich text formatting to text in the Edit view:

Rich text can be imported into Concordance Desktop or added to text from the Format
toolbar in the Edit view.

Use the Format toolbar to change the font type, size, bold, italic, underline, and color.
You can also change the alignment of a paragraph, indent the paragraph, or, make it a
bullet list.

1. In the Edit view, open the record containing the text you want to modify.

2. Select the text.

3. On the Format toolbar, apply the rich text formatting you want for the text.

Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop. 

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

4. To reindex the database, on the File menu, click Reindex.

To reset a field's rich text formatting to plain text:

1. In the Edit view, open the record containing the text you want to modify.

2. Right-click in the field containing the text you want to modify and click Reset Field
Formatting. 
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Clicking Reset Field Formatting removes the rich text formatting from all text in the
field and changes the text to plain text. Clicking Reset Field Formatting does not
change the field's case sensitivity.

The Reset Field Formatting function is also available using the Format option under
the Edit menu.

Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

3. To reindex the database, on the File menu, click Reindex.

Copy field data from record to record

IMPORTANT NOTE: Ditto cannot be used on databases created in Concordance Desktop,
or on Concordance 10.21 E-document databases that have been migrated to Concordance
Desktop. The information below is provided only for the use of Ditto on other Concordance
10.x databases that have been migrated to Concordance Desktop. 

Ditto is a tool that can be used for repetitive data entry. When using Ditto, it opens a Duplicate
dialog box that allows you to copy fields of data from one record to another, minimizing data
entry errors. The Ditto feature is only available in the Edit view. 

Ditto offers the following options through the Duplicate dialog box:

· Copy previous - copies data from a previous document into a new or edited document

· Copy from another - copies data from another document into a new or edited document

If you are copying field data from a document to a field containing data in the current
document, when you select Copy previous or Copy from another, the data for the selected
fields in the current document is overwritten by the data from the other document.

For concatenated databases, only documents in the primary (first) database can be used
for copying data.
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To copy field data from one record to other records:

1. In the Browse or Table view, select the record containing the fields you want to
populate from another record.

2. On the Standard toolbar, click the Edit button to open the Edit view.

3. To open the Duplicate dialog box, do one of the following:

4. From the Field list, select the fields containing the data you want to copy to the record. 

· On the Edit menu, click Ditto (Edit View). 

· On the Dynamic toolbar click the Ditto button.

5. From the Field list, select the fields containing the data you want to copy to the
record.

You can select multiple fields by pressing the SHIFT or CTRL key while selecting multiple
fields.

DO NOT select the DOCID field, as this field is used by Concordance Desktop as
the unique record identifier. Selecting to duplicate (copy) this field will corrupt
your database. 

6. Do one of the following:

· To copy the data from the previous record, click Copy previous.

· To copy the data from another record, click Copy from another and type this
document's current record number.

7. Click OK.

Clicking OK copies the data from the selected fields in the other document to the fields in
the current document.
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8. Repeat steps 1 through 7 for each record you want to populate with field data from
another record. 

9. On the Standard toolbar, click the Edit button to turn off edit mode and save your
record.

Concordance Desktop automatically saves the new record as soon as you close the Edit
view or navigate to another record.

Changes are immediately viewable. However, in order to run full-text searches on the
edits in the record, the database needs to be reindexed. Once this action is performed
all reviewers can search the updates. 

To ensure that your new records are searchable in a timely manner, coordinate with
your Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays on the File menu next to
Reindex.

It is best practice to close out of the Edit view by clicking the Edit button after
you are done adding or editing records – and before you exit Concordance Desktop
– to ensure that all new records have been saved. If you do not close the Edit
view before exiting, you may lose your work.

9. To reindex the database, on the File menu, click Reindex.

Searching for edited records

To query the database for any documents that have been edited use the Search for
edited documents command. When you select Search for edited documents, all documents
that have been edited since the last database reindex or index are displayed in Browse or
Table view.
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Searching for documents with redactions

To query the database for any documents that have been redacted, use the Search for
documents with redactions command. When you select Search for documents with
redactions, all documents that have been redacted are displayed in Browse or Table view.
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Deleting records

You can mark records for deletion one at a time using the Editing tools on the Dynamic
toolbar that are available when the Edit view is open. When a record is marked for
deletion, DEL is displayed in the status bar. Concordance Desktop administrators can
review and retrieve these documents before removing them permanently from the
database.

You can also mark multiple records for deletion at one time. By querying for these records,
you can mark all of them for deletion at once.

Records are not permanently removed from the database until your Concordance Desktop
administrator removes them, so retrieval of documents marked for deletion is available.

To mark individual records for deletion:

1. In the Browse or Table view, select the record you want to mark for deletion.

2. On the Standard toolbar, click the Edit button to open the Edit view.

3. Do one of the following:

· On the Dynamic toolbar, click the Delete button.

· On the Dynamic toolbar, click the Undo button  , click the Delete document
option in the Edit Options box, and then click OK.
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Clicking the Delete button or clicking Undelete Document in the Edit Options box
marks an individual record for deletion. DEL is now displayed in the status bar for
the record.

Before a record is permanently deleted by your Concordance Desktop administrator, you
can unmark a record for deletion. 

To unmark individual records for deletion:

1. In the Browse or Table view, select the record you want to unmark for deletion.

2. Click the Edit button on the Standard toolbar to open the Edit view.

3. Do one of the following:

· On the Dynamic toolbar, click the Delete button.

· On the Dynamic toolbar, click the Undo button , select the Undelete
document option in the Edit Options box, and then click OK.

When a record is marked for deletion, clicking the Delete button or clicking Undelete
Document in the Edit Options box removes the mark for deletion from the record and
DEL is removed from the status bar for the record.  

To mark multiple records for deletion:

1. Run a search for a batch of records that you want to mark for deletion.

2. Verify that the desired records appear in Table view.

3. On the Edit menu, click Delete and Undelete.

4. In the Range field, confirm the range of records to mark for deletion, and then click
OK.
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Selected records are marked for deletion and a DEL is shown in the status bar for
each of the records.

If you accidentally mark records for deletion that should not be deleted, follow the
procedures above for deleting multiple records but select Undelete instead of
Delete in the Delete and Undelete box. You can also remove the mark for deletions
from the individual records using the Delete or Edit buttons on the Dynamic toolbar.
Be sure to verify that the DEL status no longer appears for these records.

Working with Transcripts

With Concordance Desktop you get the benefit of managing your transcripts within the
same application as your documents. As a transcription management tool, Concordance
Desktop provides you with additional review and annotation features necessary for
working with transcripts. You can also join a transcript database with other discovery
databases to search across all documents and transcripts at once.

Like other Concordance Desktop databases, transcripts are searched using full-text
operators. You can narrow your search to a specific deponent, transcript date, or volume
number. Specific fields are used in transcript databases to capture that information.

For more information about joining a transcripts and records database together, see
Concatenating Databases.

Viewing Transcripts

Concordance Desktop displays transcripts in a traditional format familiar to most attorneys
and paralegals. Transcripts are reviewed in the Browse view with the database listing of
individual transcripts in the Table view.

A transcript database has name, date, and volume fields with the full-text of the
deposition stored in the text field. These fields are not visible in the Browse view, but you
will see them in the Table and Edit views. In a transcript database, you can mark
transcripts by line, add notes and issues, and add file attachments or hyperlinks.
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Right-click menu options for transcript databases:

· Change the font size and color while reviewing the transcript on the screen,
especially useful if more than one database is open.

· Print the transcript.

· Print selected content of the transcript.

· Add or edit a note or attachment.

· Export the transcript to other litigation software, like CaseMap and Sanction.

You can easily navigate to a transcript you want to review by using the Go to button
on the Dynamic toolbar, and entering the document page and line numbers in the Go to
box. The transcript document is identified in the Concordance Desktop title bar by
name, date, and volume.

There are four ways to annotate a transcript:

· Apply a Quick Mark

· Create a Note
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· Apply an Issue tag

· Add an Attachment

Adding Quick Marks to transcripts

A Quick Mark is highlighting applied on the left side of a transcript denoting the page and
line number. Simply click on a line number during a cursory review. This is a great way to
remind yourself there may be content worthy of a note or issue tag, or simply marks the
place where you may want to return in the future.

Quick Marks made in West® LiveNote® are retained if the transcript is imported from
that application into Concordance Desktop.

Adding notes to transcripts

Creating notes within a transcript is an ideal way to create a reminder of relevance for
case arguments. When you need to find these comments later, you can search the entire
transcript database, locate notes attached to a particular transcript, or find both at the
same time.

There is no limit to the number of notes or quick marks you can apply per transcript. The
first lines of your notes are displayed in the Notes task pane and are also displayed as
floating text when you move your cursor over a highlighted note. Notes disappear the
instant you delete them, but are not physically removed from the database until your
Concordance Desktop administrator removes them.
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To add transcript notes:

1. In the Browse view, select the transcript text or region where you want to apply a
note.

2. Right-click the selected text and select New note to open the Notes dialog box.

3. On the Note tab, type the applicable comments.

To apply issues to a transcript, see Applying issue tags to transcripts.

To add attachments to a transcript, see Adding attachments to transcripts.

4. Click OK to save the note and close the Notes dialog box.

Once a note is applied, the area you selected is highlighted and underlined. To view
the note text, float your cursor over the highlighted text.

5. If you need to edit a note, right-click a note and then click Edit note.

6. Modify the note text as needed and click OK.

Changes are immediately viewable. However, in order to run full-text searches on
new or modified notes in the record, the database needs to be reindexed. Once this
action is performed all reviewers can search the notes.
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7. To reindex the database, on the File menu, click Reindex.

To delete a note:

1. In the Browse view, click  the note or right-click the note and select Edit note to
open the Notes dialog box. 

2. Click the Delete button, and then when prompted click Yes to verify that you want
to delete the note.

The note is removed from the database and the next note in the database displays
in the Notes box. 

3. Click OK to close the Notes box.

Notes disappear the instant you delete them, but are not physically removed from
the database until your Concordance Desktop administrator removes them.

Searching Transcript Notes

Once transcript notes are applied, there may be times when you need to search for them
in a lengthy transcript.

You can search transcripts notes using:

· Advanced Search panel - enter words found in the notes

· Notes task pane - review notes and jump to a specific note within the transcript

The database must be reindexed before any new notes you entered are searchable. 
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To search transcript notes using the Advanced Search panel:

1. In the Search task pane, open the Advanced Search panel.

2. From the Options list, select Search notes only.
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3. Type the type the search value or string in the Advanced Search panel.

4. Click the Search button or press Enter to initiate the query.

Your search results display at the bottom of the Search pane and include those
transcripts with notes containing the search value or string.

If multiple transcripts display in your search results, use the Notes panel to review
each transcript to find other notes containing the search value or string.

To search transcript notes using the Notes task pane:

1. Open the Notes task pane,  in the Note panel, select View by notes.

When you select View by notes, the transcript's notes are displayed in the Notes
panel.

2. To view a specific note in the transcript, double-click on the note in the note list to
jump directly to that note in the transcript.

In the Notes panel, lines with <empty> are simply transcript notes that do not
contain any note text in the note.

Quick marks are also displayed in the Notes panel. The text of a transcript line
marked by a quick mark is what is displayed for each quick mark in the Notes panel.

Applying issue tags to transcripts

Tags work well for categorizing documents, because tags mark or categorize an entire
document. Transcripts are handled differently from documents in Concordance Desktop.
Instead of marking the entire transcript, you are marking a section of text within a
transcript. An issue is a type of tag applied to a section of transcript text. When you're
adding issues to transcripts, you also have the option of entering comments along with
the issue tag for further distinction.

Applying tags to transcripts is not the same method as applying tags to documents
records. Tagging is done during review to categorize an entire document. Tagging
transcripts with issues is done to digest a transcript based upon a review category.

You can apply issue tags to transcripts from both the Tags task pane and the Notes
dialog box.

Document Tags Versus Issue Tags

The difference between a document tag and an issue tag:
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· A document tag is applied at the document level. When a document tag is applied to a
document, the tag name displays in black text with a blue check box in the Tags task
pane

· An issue tag is applied at the text level, within the document. When an issue tag is
applied to a document, the tag name displays in red text with a dark red check box in
the Tags task pane

To add issue tags from the Notes dialog box:

1. In the Browse view, select the transcript text or region where you want to apply
an issue tag.

2. Right-click the highlighted text and select New note to open the Notes dialog box.

3. In the Issues field on the Note tab, select the check box next to the tags you
want to apply.

A red check mark next to a tag in the Issues field indicates the issue tag has been
applied to the selected text. 



Concordance Desktop 146

To apply notes to a transcript, see Adding notes to transcripts.

To add attachments to a transcript, see Adding attachments to transcripts.

4. Click Apply and then OK to save the issue tag and close the Notes dialog box.

Once an issue tag is applied, the area you selected is highlighted and the tags you
applied are selected.  The tag name is displayed in red in the Tags panel. 

5. If you need to edit the issue tags, right-click the highlighted text and select Edit
note.

To remove an issue from a document in the Notes dialog box, in the Issues field on
the Notes tab, clear the issue tag check box. 

You can also remove an issue from a document in the Tags task pane by right-
clicking the issue in the Tags task pane and clicking the Uncheck issue command.
Removing the tag in the Notes dialog box or clicking the Uncheck issue command in
the Tags task pane does not delete the issue code from the database. Issue codes
can be deleted from the Add/Delete panel in the Tag and Issue Management dialog
box.

6. Modify the tags as needed and click OK to save your changes.

To view the issues applied to highlighted text, you can double-click the highlighted
text or open the Notes task pane, select View by Issues or View by Notes, and
double-click the applicable issue or note to open the Notes dialog box. 

To add issue tags from the Tags task pane:

1. In the Browse view, select the transcript text or region where you want to apply
an issue tag.

2. Open the Tags task pane.

3. In the Notes panel, press SHIFT and select the check box next to the tags you
want to apply. 

The default setting for adding issue tags using the Tags task pane is SHIFT+Left
Click. If your Concordance Desktop administrator changed the issue tagging setting
to only use a single left click, just select the check box next to the tags to want to
apply. 

A red check mark next to a tag indicates the issue tag has been applied to the
selected text. 

To remove an issue from a document in the Tags task pane, right-click the issue in
the Tags task pane and click the Uncheck issue command. 

You can also remove an issue from a document in the Notes dialog box, by clearing
the issue tag check box in the Issues field on the Notes tab. Removing the tag in
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the Notes dialog box or clicking the Uncheck issue command in the Tags task pane
does not delete the issue code from the database.  Issue codes can be deleted
from the Add/Delete panel in the Tag and Issue Management dialog box.

Some people find that they highlight and select text as they read documents and
transcripts. Doing so may cause accidental issue tagging if you are using a single
left click to add issue tags. For those users in this scenario, it is best to train
yourself to add issue tags using only the right-click menu option. When applying
document tags to an entire document record, make certain that no text in the
record is highlighted.

Adding attachments to transcripts

Transcripts often reference exhibits and evidence. The ability to view that evidence as
you are reading a transcript is useful in your review. Exhibits attached directly to a
transcript excerpt are an easy way to refer back to those exhibits.

Concordance Desktop allows you to browse to your hard drive, network, or the Internet to
attach a file, creating a direct hyperlink to a file or Web site so that it can easily be
referenced later.

To add attachments to transcripts:
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1. In the Browse view, select the transcript text or region where you want to add an
attachment.

2. Right-click the highlighted text and select New note.

3. Click the Attachment tab.

4. Select the file type's destination or location from the Attachment type list:

· <none> - field defaults to <none> until an attachment is added

· External - to attach an external file or link to a Web site

· Viewer - to attach a document image from a Concordance Desktop database

· Clipboard - to copy the highlighted text to the Microsoft Windows clipboard

· Internal - used by the system only

5. Click the Browse button next to the Attachment field and locate the applicable
files or Web site.

6. Click the Open button on the Open dialog box to add the path to the files or Web
site address to the Attachment field.

7. To automatically launch the file or Web site with one click, select the Open
attachment when note is clicked check box.

If the Open attachment when note is clicked check box is not selected, users have
to right-click the note and select Run attachment to open the attachment.

To apply notes to a transcript, see Adding notes to transcripts.

To apply issues to a transcript, see Applying issue tags to transcripts.

8. Click OK to save the attachment.

9. If you need to edit the attachment, right-click the highlighted text and select Edit
note. Modify the attachment information as needed and click OK to save your
changes.

If you select <none> from the Attachment type field but do not delete the file path
or Web site address from the Attachment field, Concordance Desktop does not
permanently remove the path or address. Concordance Desktop only blocks the
attachment from launching when someone is reviewing the highlighted text.

10. To save a copy of the attachment, right-click the highlighted text and select Save
attachment as to save it to your hard drive or network.



Document Review 149

Reviewing transcript notes

A quick review of a transcript notes and issues can be done in the Notes task pane. The
notes, issue tags, and attachments associated with the current transcript are listed in the
Notes and Issues panels. Click a listed item to quickly jump through all the annotations in
a transcript.

   

To review notes and issues in a transcript:

1. Open the transcript in the Browse view.

2. Open the Notes task pane.

3. In the Notes panel, do one of the following:

· To view by notes, select View by notes.

· To view by issues, select View by issues.
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Selecting View by notes displays a list of the notes applied to the transcript in the
Notes panel.

Selecting View by issues displays a list of the issues applied to the transcript in the
Issues panel.

4. Click a note in the Notes panel to instantly jump to the highlighted region of the
transcript.

5. Click an issue in the Issues panel to instantly jump to the tagged region of the
transcript.

You can also double-click a note or issue to jump to the transcript note and open
the Notes dialog box and edit the note, issue, and/or attachment.

Notes and issues in the Notes task pane display in the order they appear in the
transcript, not in the order applied.

The properties for the selected note or issue are displayed in the Properties panel
below the Notes and Issues panels. The Properties panel displays the location of the
note or issue in the transcript, any added note text, and the path to any attached
file or Web site address.

Printing

Media files are usually only printed in productions by your Concordance Desktop
administrator once annotations are completed and all redacted content marked. This
ensures that opposing counsel does not receive any original copies and other staff do not
view privileged content. However, there may be instances when you need to print images
or create certain reports for case review prior to production.

Concordance Desktop provides several printing options for document records and
transcripts, and can be used to create and print a variety of customized reports based on
search results, field content, tagged document sets, and transcript annotations. Printing
options are available in the Browse and Table views. The view you print from determines
the format of the print output. The print output format looks similar to the view you print
from.

You can print single pages using the viewer or a set of media or image files from
Concordance Desktop using the Print CNV command on the Tools menu.

In Concordance Desktop you can print:

· Records directly from the Browse view

· Record batches based on queries

· Transcript annotation reports (Annotation Report Writer)

· Tagged record lists
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· Summary reports from the Table view (Report Writer or Send to Excel)

· Selected field data

· Multiple annotated media files from CNV as a batch

Using the viewer you can print:

· Redacted media (documents/images)

· Single documents (a single document may contain multiple pages)

When a batch of images are printed, the original images never change. Annotations,
highlights, and other markings are stored in the Concordance Desktop database, and can
be modified without modifying the original image. Selected annotations and headers and
footers can be applied to only the paper copies of images for printing or fused directly
onto new images when produced. When images are printed, they have a slightly smaller
output than the original image. Images are automatically reduced by 2 or 4 percent, based
on the type of image file.

While you have basic options for printing page numbers and dates, Concordance Desktop
also offers selections for printing highlighted annotations, underlined hits, field labels, and
more. These print options are useful for printing sets of records for full-text review or to
print annotations from transcripts.

You can also print a spreadsheet report of queries displayed in Table view with field text in
the sort order selected. This option is useful when a summary listing is appropriate.

With lengthy documents like depositions, transcripts, and research reports, print a
Keywords in Context (KWIC) report to capture pertinent information in context, like the
deponent's name or article title.

If you need to print from the Table view, try exporting the content to Excel and
printing it from there. For more information about exporting table data and exporting
numerical data, see Exporting Concordance Desktop data.

Your Concordance Desktop administrator or Litigation Support Manager is typically in
charge of printing productions because of the sensitivity involved in running a
production. We highly recommend that any staff tasked with printing productions
receives proper Concordance Desktop administration training before attempting to do
so with live databases.

For more information about producing new image files using the Production Wizard, see
Creating a production.
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Printing individual records and transcripts

You can print an individual record, transcript, or selected text from the Browse view.
When you print from the Browse view, Concordance Desktop only prints the record or
transcript file currently displayed in the Browse view.

Before you print a record or transcript, you can preview how the document will print by
clicking Print Preview on the File menu.

If you have another view, such as the Table view, open with the Browse view, the
Print and Print Preview menu selections may be disabled on the File menu. Click on the
record or transcript file in the Browse view to activate the Print Preview and Print
menu selections.

For additional print options, you can click the Print button on the Standard toolbar. For
more information about printing from the Standard toolbar, see Printing standard reports.

To print an individual record or transcript:

1. In the Browse view, open the record or transcript you want to print.

2. On the File menu, click Print or right-click in the Browse view and click Print
record.

3. Click OK to print the record or transcript file.

To print selected text in the Browse view:

1. In the Browse view, select the text you want to print.

2. Right-click the selected text and click Print selection.

3. Click OK to print the selected text.

Batch Printing with Concordance Desktop Viewer

Batch printing allows you to print what is seen in the viewer formultiple documents.  In
Concordance Desktop, batch printing is known as CDV Printing. The CDV Printing feature
allows you to print markups (annotations), add synopsis and separator sheets, and add
headers/footers and watermarks.

If you want to print documents or images from concatenated databases, each database
must be similar in structure, contain media keys, a current .CIB file, and you must have a
minimum of ReadOnly access.
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When printing documents, be aware of the following:

· If you are printing documents that have been reviewed and redacted in the viewer, be
aware that any redaction  placed on the document will print transparent revealing the
text underneath.  If you want to print redactions as opaque, you must run the
documents through the Production process in Concordance Desktop, then print the
produced document.

· Printing documents that contain markups to Adobe PDF using the File > Print option,
does not permanently burn the markups in the document.  If you want markups burned
in, you must run the documents through the Production process in Concordance
Desktop, then print the produced document.

The CDV Printing bulk printing feature is only available in Concordance Desktop when
you are using the viewer for reviewing and annotating documents.

When including Synopsis and Separator Sheets in a bulk print job, you may
experience delayed print times.  This is due to how Concordance Desktop processes
the synopsis and separator sheets at print time.
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Before scheduling a batch print run, you first need to identify and locate the documents
you want to print using one of the Search tools available in Concordance Desktop. See,
Available search tools.
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Identifying documents for printing

1. In Concordance Desktop, open the database containing the documents you want to
print.

2. Run a search query to locate the documents you want to print.

Using CDV Printing

1. In Concordance Desktop, from the Tools menu, click CDV Printing.

2. Specify the printing parameters:

Setting print run parameters:

1. Select the Printer you want to use for printing the documents/images.

2. Select the appropriate Document Range:

· To include all the documents in the query, click All.

· To include a selected set of documents from the query, click Range, and
then specify the range of documents you want to print. The default range
is the complete range of documents in the current Concordance Desktop
query.

3. Select the appropriate Page Range:

· To include all the pages of a document in the query, click All.

· To include a selected set of pages of a document in the query, click
Range, and then specify the range of pages for a document.

4. To include data from Concordance Desktop fields that you have Read access
(minimum):

· Select Yes for Concordance Desktop Synopsis.

· In the DBCB Field Names field, click the field, and then click the Browse
button  .

· In the DBCB Fields dialog box, select your desired database fields:

o To select all the fields, click Select All.

o Select specific fields by clicking the check box for each desired database field

you want to include on the Synopsis sheet.

o To change the order of database fields on the Synopsis sheet, select the field

and click the Move UP or Move DOWN buttons.

o Click Save in the DBCB Fields dialog box.

· In the Synopsis Font field, click the field, and then click the Browse
button  .

· In the Font dialog box, do the following:

o In the Font list, click the font.
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o In the Font Style list, click the font style.

o In the Size list, click or type the font size.

The Synopsis Separator sheets may, together, contain up to 32 unique
database fields.  Both sheets may contain the same database fields, which
counts as a single unique field.  For example, if you add three fields, BegNo,
Admin1, and Filepath field to the Synopsis sheet, and two fields, BegNo, and
Date Sent to the Separator sheet.  You have added four unique fields.  The
BegNo field counts as one unique field.

The synopsis page prints the first 60 characters of data within the specified
Concordance Desktop database fields.  If security is enabled, only those fields with
a minimum of "Read" access are displayed.

5. To add separator sheets at the beginning of each document:

· Select Yes for Separator Sheets.

· In the Separator Sheets Text field, click the field, and then click the
Browse Button .

· In the Separator Sheet Editor dialog, select your separator sheet options:

o Type the text you want to appear on the separator sheets.

o To insert a Concordance Desktop macro, right-click on the edit box and

then select any the Concordance Desktop Macros (Date, DateTime,
DocNo, Time) from the list that displays.

o To insert a Concordance Desktop database field to display, right-click on

the edit box and then select the field from the list that displays.  The
fields are displayed in the order they appear in the corresponding
database.  If security is enabled, only those fields with a minimum of
"Read" access are displayed.

· In the Separator Sheets Font field, click the field, and then click the
Browse Button .

· In the Font dialog box, do the following:

o In the Font list, click the font.

o In the Font Style list, click the font style.

o In the Size list, click or type the font size.

When you add print macros or select database fields, they appear in the text
between angled brackets <>.  When the print job is executed, the information
associated with the macro or database field appears within the text where the
macros or database fields were placed. There is no limit to the number of
macros or database fields you can add.

Setting print format parameters:
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1. From the Printing Format Parameters section, in the Orientation list, do
one of the following:

· Click Portrait.

· Click Landscape. 

· Click Rotate to Fit — allows more of the image to fit within the margins of
the printed page.

Some document types, such as .xls, the landscape option will split the page
by columns and orientated as portrait.

2. In the Color Setting list, do one of the following:

· To print the documents using the document's original colors, click Color
(default).

· To print the documents to shades of gray, click Grayscale.

To ensure the print job prints the documents as expected, make sure that the
printer's color properties are set appropriately.

3. In the Copies to Print field, type the number of copies you want to print. 
The maximum number of copies is 100 and the copies are automatically
collated.  

4. When printing a PDF document, in the Optimize for PDF/Postscript Printing
field, click Yes. 

The Optimize for PDF/PostScript Printing option resolves the issue where some
older printers and the PDF Distiller and Writer may not properly invert printouts
resulting in reversed prints (black background and white foreground).  When
selected, this produces a bitmap of the current document/image that is sent
to the printer giving accurate printouts for the problematic printer or print
driver.  However, selecting this option results in slower print time and a larger
print spool file.

Specifying markups to include in printing:

From the Markup Types section, do any of the following:

· To include all markups, in the Select All list, click Yes.

· To exclude all markups, in the Select All list, click No.

· To include some of the markups, for each mark up you want to include click
Yes from the corresponding markup list.

When printing viewer documents, any documents that contain redaction
markups are printed with transparent redactions.  If you want the redactions
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to print opaque, you need to use the Production tool in Concordance Desktop
to produce the document(s) and then print the produced document.

Due to how the markups are rendered during printing, if you want to include
any applied crossout, strikeout, highlight, or underline markup in a print job,
please note that all four markups are treated as one and all four if applied will
be included in the printed file.  For example, if a crossout and highlight markup
are applied to a document, if the crossout markup is selected in the CDV
Printing parameters, both the crossout and the highlight markup are printed.

Adding headers/footers and watermarks:

Headers and footers are a string of text assigned to a specific location within a
document.  For productions and printing, the text is not restricted to just the top
and bottom margins of a document, you can also place them in the right and left
margins of a document.

A watermark is a semi-transparent string of text that appears behind the existing
document content.  A watermark appears across each printed document from
bottom left to top right and has a transparency setting of 20%.

1. In the Printing Run Parameters dialog box, select the Include Hdr/Fts
Spec check box.

2. Click the Edit Headers/Footers and Watermarks button.

3. Click the (+) sign next to the Header/Footer or the watermark you want to
edit.

4. For each header, footer, or watermark, do one of the following:

· Type the text you want to be displayed.

· Type % to display the available macros list, and then select the macro(s)
you want to add.

Available macros

Keep the following in mind when adding macros to headers/footers, and
watermarks:

· Each line of a header or footer can use multiple macros.  For example, you
can add %Date %Time to the Top Left header.  This prints the date and
time in the location you specified on each page of the print.

· All macro values are case insensitive, except for the %FIELD_ macro.

· All settings in the Header and Footers dialog box are saved for all
documents and images in the Wind
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Macro Description

%FIELD_ Inserts database field data up to 60 characters for a each
specified field.  For example, %FIELD_OCR1 %FIELD_OCR2,
would print the first 60 characters of the OCR1 field and the
first 60 characters of OCR2 field.  If security is enabled, only
those fields with a minimum of "Read" access are displayed.

%Date Inserts the current date

%
SysDatePlusDays(
0)

Inserts a date the specified number of days after the
system date.  Replace the 0 a number to indicated the
number of days.

%Time Inserts the current time the print is executed based on a
12-hour clock

%MilTime Inserts the current time the print is executed based on a
24-hour clock

%Title Inserts the current title of the document

%Page Inserts the page number of the document

%TotalPages Inserts the total number of pages of the document

%BatesPgNo() Inserts a page number (x) to include for each printed
document.  The number entered is the beginning page
number for each document.  Multi-page documents are
numbered incrementally.  For example, %BatesPgNo(0001)
would print 0001 on each single-page document.  However,
if a document had more than one page, the first page would
appear as 0001, the second as 0002, and so on.

%Login, %User Inserts the user name of the person who executed the print

%Hostname Inserts the hostname of the machine where the print was
executed from

%IPAddress Inserts the IP address of the machine where the print was
executed from

%% Inserts a single % character

© Inserts a copyright symbol

® Inserts a registered trademark

%AUTO_ Inserts database field data AND increments field content
ending with a numeric value by 1 for each page. Field must
be specified. Do not use with fields where special characters
such as % are present. Does not account for gaps or
suffixed numbers within a document.

6. To edit the font for the all the text, click the Font button, and then in the
Font dialog box, specify the font name, style, and size.
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7. Click List to review the applied header/footer and watermark text and macros
set for the production.

8. Click Edit to make any changes.

9. When finished, OK.

Printing and Production header/footer and watermark settings are separate
entities.  Parameters you set in the Printing dialog box are only available for
printing.

3. When finished, click Start.

Saving print parameters:

1. Set the printing parameters.

2. Do one of the following:

· To save the parameters as a named parameter set, in the Parameter Set
Selected field, enter a name, and then click Save Parameter Set.

· To save the parameters as the default set, click Save as Default Parameter
Set.  The default parameter set is loaded each time the CDV Printing command is
executed.

All the parameters are saved, with the exception of document range as this always
defaults to 1-n, where n is the total number of documents in the current Concordance
Desktop query.

Using saved print parameters:

1. In the Parameter Set Selected list, click the parameter set you want to load.

2. Click Load User Parameter Set.

Monitoring print jobs:

When a print job is executed, the Print Console is displayed. The Print Console displays
the progress of the files as they are processed and sent to the selected default printer.
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Batch Printing with Concordance Viewer

Batch printing allows you to print what is seen in the viewer formultiple documents.  In
Concordance Desktop, batch printing is known as CDV Printing. The CDV Printing feature
allows you to print markups (annotations), add synopsis and separator sheets, and add
headers/footers and watermarks.

If you want to print documents or images from concatenated databases, each database
must be similar in structure, contain media keys, a current .CIB file, and you must have a
minimum of ReadOnly access.

When printing documents, be aware of the following:

· If you are printing documents that have been reviewed and redacted in the viewer, be
aware that any redaction  placed on the document will print transparent revealing the
text underneath.  If you want to print redactions as opaque, you should select the
Opaque option in the Print Redactions as drop down.

· Printing documents that contain markups to Adobe PDF using the File > Print option,
does not permanently burn the markups in the document.  If you want markups burned
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in, you must run the documents through the Production process in Concordance
Desktop, then print the produced document.

The CDV Printing bulk printing feature is only available in Concordance Desktop when
you are using the viewer for reviewing and annotating documents.

When including Synopsis and Separator Sheets in a bulk print job, you may
experience delayed print times.  This is due to how Concordance Desktop processes
the synopsis and separator sheets at print time.
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Before scheduling a batch print run, you first need to identify and locate the documents
you want to print using one of the Search tools available in Concordance Desktop. See,
Available search tools.

To locate documents for printing

1. In Concordance Desktop, open the database containing the documents you want to
print.

2. Run a search query to locate the documents you want to print.

To print viewer documents or images

1. In Concordance Desktop, from the Tools menu, click CDV Printing.

2. Specify the printing parameters:

To set the printing run parameters:

1. Select the Printer you want to use for printing the documents/images.

2. Select the appropriate Document Range:

· To include the current document, click Current Document.

· To include all the documents in the query, click All.

· To include a selected set of documents from the query, click Range, and
then specify the range of documents you want to print. The default range
is the complete range of documents in the current Concordance Desktop
query.

3. Select the appropriate Page Range:

· To include all the pages of each document in the query, click All.

· To include a selected set of pages of each document in the query, click
Range, and then specify the range of pages for each document.

4. To include data from Concordance Desktop fields to which you have Read or
Read/Write access:

· Select Include document synopsis.

· Click the Configure synopsis sheet button.

· In the Document Synopsis Configuration dialog box:

o Select the desired database fields from the Available Fields list and add

them to the Selected Fields list on the right.

o To change the order of database fields, select a field in the Selected

Fields list and drag/drop it in the desired order.
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o Click the FONT button, and select your font options in the Select Font

dialog:

§ Select your font in the Font Family list.

§ Select your font size in the Font Size list.

§ Select Bold or Italic under Font Style if desired.

§ Click OK to close the Select Font dialog with your selections.

The Synopsis Separator sheets may, together, contain up to 32 unique
database fields.  Both sheets may contain the same database fields, which
counts as a single unique field.  For example, if you add three fields, BegNo,
Admin1, and Filepath field to the Synopsis sheet, and two fields, BegNo, and
Date Sent to the Separator sheet.  You have added four unique fields.  The
BegNo field counts as one unique field.

The synopsis page prints the first 60 characters of data within the specified
Concordance Desktop database fields.  If security is enabled, only those fields with
a minimum of "Read" access are displayed.

5. To add separator sheets at the beginning of each document:

· Select Include document separator sheet.

· Click the Configure separator sheet button.

· In the Document Separator Page Configuration dialog box:

o In the text box, type the text you want to appear on the separator

sheets.

o To insert a Concordance Desktop macro (Date, Time, DateTime) or

Concordance Desktop database field, click the Fields dropdown and
select the macro or field from the list that displays.

o Click the FONT button, and select your font options in the Select Font

dialog:

§ Select your font in the Font Family list.

§ Select your font size in the Font Size list.

§ Select Bold or Italic under Font Style if desired.

§ Click OK to close the Select Font dialog with your selections.

When you add print macros or select database fields, they appear in the text
between angled brackets <>.  When the print job is executed, the information
associated with the macro or database field appears within the text where the
macros or database fields were placed. There is no limit to the number of
macros or database fields you can add.

To set the printing format parameters:

1. From the Output Settings section, in the Orientation dropdown, select
Portrait or Landscape
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Some document types, such as .xls, the landscape option will split the page
by columns and orientated as portrait.

1.

2. In the Color Settings dropdown, select:

· Color (default) to print the documents using the document's original colors.

· Greyscale to print the documents in shades of gray.

To ensure the print job prints the documents as expected, make sure that the
printer's color properties are set appropriately.

3. Select the Resize for best fit check box to have the documents adjusted to
best fit based on your output settings.

4. Type the number of copies you want to print in the Copies to print text box.
 The maximum number of copies is 100 and the copies are automatically
collated.

To specify markup types to include in the print job:

From the Markups section, do any of the following:

· To include all markups, select the Select All check box.

· Select each individual markup that you want included.

In the Print redactions as drop down box:

· Select Opaque to have redaction markups printed opaque, or blocking out
the underlying section of document fully.

· Select Transparent to have redaction markups printed where the
underlying section of document will still show through.

Due to how the markups are rendered during printing, if you want to include
any applied crossout, strikethrough, highlight, or underline markup in a print
job, please note that all four markups are treated as one and all four if applied
will be included in the printed file.  For example, if a crossout and highlight
markup are applied to a document, if the crossout markup is selected in the
CDV Printing parameters, both the crossout and the highlight markup are
printed.

To add headers/footers and watermarks:

1. Select the Include headers and footers check box.  The Concordance
Printing dialog window displays additional parameters to configure.
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2. For each header, footer, margin, or watermark, choose an item from the
corresponding drop down that you want to print in that location or leave the
selection None if you want that area to be left blank.  You can select from
several different macro and Concordance Desktop database fields.

3. To edit the font for the headers and footers, click the Font button and select
your font options in the Select Font dialog:

§ Select your font in the Font Family list.

§ Select your font size in the Font Size list.

§ Select Bold or Italic under Font Style if desired.

§ Click OK to close the Select Font dialog with your selections.

Printing and Production header/footer and watermark settings are separate
entities.  Parameters you set in the Printing dialog box are only available for
printing.

3. When finished, click Start printing.
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Using parameter sets:

To save print parameters:

1. Select the printing parameters you want.

2. In the Settings drop down field, enter a name for the parameter set and then:

· Click Save as default to save the named parameter set as the default set.  The
default set is loaded each time the CDV Printing command is executed.

· Click Save to save this set of parameters with the name specified (not as
default). 

To use saved print parameters select the parameter set name in the Settings drop
down list.  The print parameters will be updated to reflect the selected parameter set.

To remove a saved print parameter set, select the parameter set name in the Settings
drop down list and click Remove.

Printing transcript annotations

Because your transcripts are unique documents with added notes, highlights and
attachments, Concordance Desktop offers an Annotation Report Writer tool for
customizing reports from your transcript database.

Depending on your needs, each annotated report created in the wizard may include
several types of annotations and the text included in the annotations. 

To print annotations using the Annotation Report Writer wizard:

1. In Concordance Desktop, open your transcripts database.

2. On the Standard toolbar, click the arrow next to the Report button and select
Annotation report writer.
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3. In the Annotation Report dialog box, select Annotation Report Wizard and click
OK.

4. In the Report dialog box, select the type of annotated report you want to print and
click Next. 

· Issue report - prints an issues report

· Attachment report - prints a report of annotations containing attachments

· Note report - prints a report of annotations containing notes

· Quick mark report - prints a report of all transcript line number highlights  

5. If you are printing an issue report, select the Print all issues option or select the
Print selected issues option and select the issues you want to include on the
report, and then click Next on the Issues dialog box.

To select individual issues in the list, use CTRL+click. To select a block of issues in
the list, use SHIFT+click.
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If you are printing an attachment, note, or quick mark report, just click Next on the
Issues dialog box.

6. In the Annotations field, select the one of the note printing options and select
whether you want to print the quick marks, attachments, and/or issue list.

7. In the Select the user(s) to print annotations field, select the users for which
you want to print annotations and click Next.  

To select individual users in the list, use CTRL+click. To select a block of users in
the list, use SHIFT+click.
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8. Select the transcript context you want to include when printing the notes and
issues in the Context dialog box and click Next. 

9. To add a custom header and/or footer to the report, fill out the fields in the
Formatting dialog box and click Next.
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You can include an annotation header, page numbers, the print date, and the print
time on the report. You can also select whether to print a page border and multiple
pages per sheet of paper in the Compressed print field.

10. Define your final print options in the Print dialog box, like customizing the font and
page layout, and whether to print a hard copy or save to a file.

To preview or edit your report, click the Click this button to preview your report
button.

We recommend that you always preview the report before printing a hard copy or
saving multiple files of it on your hard drive or server. This also allows you to edit
the font, headers, footers, or other print options before you process the report.
Click the Close button in Print Preview if you need to return to the Annotation
Report dialog box to make any additional changes to the report.

11. Click the Print button to print the report.
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Printing standard reports

If you want to print multiple records or transcripts, you can generate a standard report.
Your current search query determines which records or transcripts are available to print on
a standard report. For example, if your current search query contains 47 records, you can
include some or all of the 47 records in the query on the standard report. 

Standard reports have a number of customizable features such as headers, footers, date
and time stamps, page numbering. When you print a standard report in Concordance
Desktop, by default the printed font format for records is determined by your personal
Concordance Desktop display settings. For example, if your display font setting is: Sea
Green, 14 point, Monotype Corsiva, your document will be printed with the larger italic
green font (for color printers) or gray font (for black and white printers). If you do not
want to use the default format, you can define your preferred print settings on the Print
documents dialog box before printing. You can also save your preferred print settings for
future printing, or use previously saved print settings for printing.

To ensure records print the way you want, we recommend previewing your print job
before sending it to the printer. To preview your print job, click the Print preview button
on the Print tab in the Print documents dialog box.

When you print in Concordance Desktop, you are printing from database records.
When you print in Concordance Desktop Image, you are printing from .tif files in the
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imagebase. For more information about printing in Concordance Desktop Image, see
Printing in Concordance Desktop Image. 

To print standard reports in Concordance Desktop:

1. On the Standard toolbar, click the Print button.

2. Click the Fields tab.

The Fields tab is used to define the fields and their order to include on the report
for the selected database. The fields are listed alphabetically in the Available fields
field.

3. In the Database list, select the database containing the records you want to print.

The Database field defaults to the current Concordance Desktop database.

4. In the Available fields list, choose the fields you want to include on your report.

For example, to print the record's body text, click the OCR1 field. 

You can choose multiple fields by pressing the SHIFT or CTRL key while clicking
multiple fields.

5. Click the Select button to add the fields to the Selected fields list.
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The standard report includes data from each of the fields in the Selected fields list,
and displays the field data in the order the fields are displayed in the Selected fields
list.

To add all of the fields to the Selected fields list, click the Select all button. To
change the order of the fields in the Selected fields list, click a field and click the
Move down or Move up button.

To remove a field from the Selected fields list, click the field you want to remove
and click the Remove button. To remove all the fields from the Selected fields list,
click the Remove all button.

5. To print the keywords (search hits) for the current query, click the KWIC tab and
select the Print key words in context (KWIC) check box.

6. The database and fields you selected on the Fields tab are displayed below the
Print key words in context (KWIC) check box.

7. In the fields list, select the check box next to the fields you want to print keys
words in context.

8. To include record text above and below the key words, select the Print line(s)
above and below check box and type the number of lines to include above and
below in the line number fields.

9. To print the question and answer pair associated with the key words in transcripts,
select the Print Q&A pairs check box. 
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This check box only applies to transcripts. Leave the Print Q&A pairs check box
blank if you are not printing from a transcript.

10. To add header and footer text, determine widows and orphans on page breaks, and
define other printing controls, click the Formatting tab.

11. In the Header field, type the report header.

The header displays at the top of each printed page and is left justified on the
page.

12. In the Footer field, type the report footer.

The footer displays at the bottom of each printed page and is left justified on the
page.

13. In the Widows and Orphans field, type the number of widows and orphans to allow
on each page.

Widows are the lines of text left at the bottom of a page when a record is split in
two. Orphans are the lines of text at the top of the next page.

The number entered in the Widows field controls the minimum number of lines
Concordance Desktop allows to remain at the bottom of a page. If the number of
lines to print at the bottom of the page is less than the number in Widows field,
then the document is moved to the top of the next page.

The number entered in the Orphans field controls the minimum number of lines
Concordance Desktop prints at the top of a page when splitting a document
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between pages. If the lines left to print are less than the number in the Orphans
field, then lines will be borrowed from the previous page until the orphan minimum is
met. This may cause the preceding page to go below the widows threshold, causing
the entire document to print at the top of the new page.

14. In the Options section, select the print options you want to apply to your report.

Formatting options field names and definitions

Field Name Field Definition

Print date Prints the current date on each page below the footer.

Print time Prints the current time on each page below the footer.

Print field labels Prints the field name before each field.

Print page
numbers

Prints the page number at the bottom of each page on the right
side of the page.

Print document
numbers

Numbers each document in the report and prints the document
number before each document in the report. For example,
Document 1 of 100.

New page for each
record

Prints each document on a separate page.

Highlight
annotations

Highlights the notes and annotations in the report.

Compressed
printing

Prints the selected number of pages on one single page.

You can print up to nine pages per sheet of paper. Printing
multiple pages on one single page is sometimes referred to as
N-up printing. The N represents the number of pages you are
printing on one single page.

Print page borders Prints a border around each page when you are printing
multiple pages on one single page. 

This field is only available if you are printing 2 or more pages on
one single page.

Underline hits Underlines search hits in full-text paragraph fields.

Bold hits Bolds search hits in full-text paragraph fields.

Italicize hits Italicizes search hits in full-text paragraph fields.

Hit Color Adds the selected color to search hits in full-text paragraph
fields. 

To change the hit color, click the Hit Color button and select the
hit color.

Search hits are only highlighted in the full-text paragraph fields, not in fixed-length
text, date or numeric fields.
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If a record is edited after the search, the record's search hit will not be highlighted
in the report. To include the edited record's search hit, index or reindex the
database and re-run the search.

When printing documents with ideographic text, like Chinese, a character
underlined for hit highlighting can easily be confused with other characters. Select
bold, italicize, or color to highlight search hits in these languages.

15. To define the document print range, change the font, margin, orientation and
printer settings, and preview and save your print settings, click the Print tab.

The Total field is a read-only field, and displays the total number of documents in
the current query. The First and Last fields determine the document print range for
the report. The First field defaults to the first document in the current query, and
the Last field defaults to the last document in current query. 

16. In the First field, type the number of the first document you want to include on the
report.

17. In the Last field, type the number of the last document you want to include on the
report.

Concordance Desktop prints all documents between and including the first and last
documents defined in the First and Last fields.

18. Click one or more of the following buttons:
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Print button names and definitions

Button Name Definition

Save to Print file Click to open the Print Format dialog box and save your
settings to a print format file (.fmt).

For more information see To save your print settings.

Open an existing
print file

Click to open the Print Format dialog box and select an
existing print format file (.fmt) to use for printing the report.

For more information, see To print a standard report from an
existing print file.

Change the font Click to open the font menu. Click the font type you want to
modify to open the Font dialog box and modify the font. 

You can modify the font for the fields, data, transcripts, and
header and footer in the report.

Change the margin,
orientation, and
other print settings

Click to open the Page Setup dialog box and define the paper
size and source, and the page orientation and margin
settings. 

By default, reports print to your computer's default printer.
You can click the Printer button in the Page Setup dialog box
to select a different printer for the report. 

Print preview Click to preview the report. To print directly from the preview
screen, click the Print button. To return to the Print
documents dialog box, click the Close button.

19. Click the Print button to generate and print the report. 

To save your print settings:

1. On the Standard toolbar, click the Print button.

2. In the Print documents dialog box, define your print settings on the tabs.

3. On the Print tab, click the Save print file button to open the Print Format dialog
box.

4. Browse to where you want to save the file, type the file name in the File name
field, and click the Save button.

All of the print settings are saved including selected fields, fonts, page orientation,
paper size, headers and footers. The file is saved in plain text format and can be
edited with any text editor or word processor that uses plain text. The print format
file’s file extension is .fmt. 
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To print a standard report from an existing print file:

1. On the Standard toolbar, click the Print button.

2. On the Print tab, click the Open an existing print file button to open the Print
Format dialog box.

3. Browse to and select the print format file you want to use.

4. Click the Open button to load the print settings into the Print documents dialog
box.

5. Click the Print preview button to preview the report, and make any necessary
changes to the print settings.

6. Click the Print button to generate and print the report.

Tallying records for reports

The tally feature in the Tally task pane itemizes field information for searching, and is also
a great tool for helping you organize your document collection in preparation for printing
reports. For example, if you want to print a subset of records based on the document
type, such as a group of financial reports. The fastest way to locate these records is by
running a tally count and then printing them based on your needs.

To tally records for reports:

1. In the Table view, right-click a record in the field column you want to tally, and
click Tally [field name].
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Clicking Tally [field name] displays the tally results in the Tally task pane.

2. In the Tally task pane, double-click an item in the Tally list.

Double-clicking an item in the tally list displays only those records in the Table view.
For example, if you ran a tally on the DOCTYPE field, and double-clicked Financial
Report in the Tally task pane, only financial reports are displayed in the Table view.
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3. Print the applicable records.

To print an individual record listed in the Table view, open the record in the Browse
view and see Printing standard reports and for more information.

To print multiple records listed in the Table view, see Printing standard reports for
more information.

To export the data in the Table view to Microsoft Excel, see Exporting Concordance
Desktop data for more information.

Exporting database table view data

In Concordance Desktop, you can export record data from the Table view to Microsoft
Excel and CaseMap. The export feature is a great tool for making custom reports, as well
as contact and mailing lists. In order to export to Microsoft Excel or CaseMap, the
software you are exporting to must be installed on your computer.

If you want to export data to Microsoft Word, you can simply copy and paste data
from Concordance Desktop to Microsoft Word. 

Exporting to Microsoft Excel

When you export data from the Table view to Microsoft Excel, Concordance Desktop
exports data from the records you select in the Table view. The fields and field order
currently displayed in the Table view determine which field data is exported for the
selected records and the order of the fields exported to Microsoft Excel. Before
exporting, you can run a search to display the records you want to export in the Table
view, and modify the table layout to define the fields and field order you want to
include in the export. 

Microsoft Excel has capacity limitations. If you are primarily exporting your data to
Microsoft Excel 2003 , you need to be aware that this version of Excel is limited to
printing a maximum of 65,000 rows, and also has limitations for the number of
characters per cell.

To export table data to Microsoft Excel:

1. Run a search to locate the records you want to include in the export to Microsoft
Excel.

For more information about searching, see Available search tools. 
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2. In the Table view, adjust your table layout to include the fields and field order
you want to export to Microsoft Excel.

For more information about adjusting a table layout, see Using table layouts.

3. In the Table view, select the records you want to export.

You can export multiple adjacent records and non-adjacent records.

· Adjacent records: SHIFT + Click to select a block of consecutive records.

· Non-adjacent records: CTRL + Click to select random records from the list.

· All records: CTRL + A to select all records in the list.

If you have Microsoft Excel 2013 installed, open a blank Excel spreadsheet prior
to completing step 4 below. 

4. Right-click in the Table View, point to Send To, and then click Excel.

Microsoft Excel automatically launches and displays your exported Concordance
Desktop data in the field order you selected. If the data does not display, try the
export again. 

Exporting to CaseMap

When you export table data to CaseMap from the Table view, all of the records listed in
the Table view are exported to CaseMap. Before exporting data to CaseMap, run a
search to capture only the records you want to include in the export.

To export table data to CaseMap:

1. In Concordance Desktop, run a search to locate the records you want to include
in the export to CaseMap.
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For more information about searching, see Available search tools. 

2. In the Table view, right-click the records, point to Send To, point to CaseMap,
and then click Send all documents in query.

Selecting Send all documents in query opens the following message: CaseMap
does not support Unicode and we will only send single-byte (Ascii) text to them.
Press OK if you want to continue.

3. Click OK to continue.

Clicking OK opens the Completed gathering the document data message dialog
box.

4. Click the Continue button.

Clicking the Continue button opens the Bulk Send to CaseMap wizard in CaseMap.

For more information about exporting Concordance Desktop data to CaseMap and
using CaseMap's Bulk Send to CaseMap wizard, see the CaseMap documentation.

Exporting numerical data to Microsoft Excel

When you export numerical data from Concordance Desktop to Microsoft Excel, if the
field value begins with leading zeros, the leading zeros are trimmed from the field value.
For example, if you are exporting the BEGNO field value 00020177, the value is exported
to Excel as 20177. To keep record numbering consistent with Concordance Desktop
data, you need to add the leading zeros back onto the applicable field data in Microsoft
Excel.  See, Microsoft Excel documentation.

Numerical field values starting with alphabetical prefixes are not affected when
exporting to Microsoft Excel.

Only the field data that is displayed in the Table view is exported. Field data is exported
in the order that is displayed in the Table view, based on the selected table layout. You
can use custom table layouts to determine the field data and order of field data
exported to another application.

Productions

Once a document collection review is completed, documents typically need to be
produced to opposing parties. Database administrators prepare the electronic production
using Concordance Desktop and the viewer or Concordance Desktop Image based on
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queries or tagged sets of documents that are identified for production during the review
phase.

Numbering documents

As part of the production process, a new set of images are generated for documents
that need to be produced. A Bates number series is then applied to all pages of all
documents included in the production, with the option of burning or fusing the numbers
to the image during the process. This number series usually differs from that of your
internal collection. You can then track what has actually been produced and your Bates
number series for the production is sequential with no gaps in the numbering.

Markups

Redactions or other markups can be burned to the images during production so that
they cannot be altered. Confidentiality headers or footers can also be burned to the
images during production. Production numbers are usually cross-referenced to those in
the original review collection.

If the Concordance Desktop administrator included fields for production numbers in your
database, these numbers are then written to the production number fields during the
production process. Later when you look at your internal document collection, you are
able to see the production number for any documents that were produced.

For multiple or rolling productions, tags or sequentially numbered production fields are
tracked for which production series a document was produced under. For example,
fields named BEGPRODNO1/ENDPRODNO1, BEGPRODNO2, ENDPRODNO2, etc.

Production output

The output generated by an electronic production in Concordance Desktop is a set of
images or PDF files and an image load file. Both the production image set and the load
file are typically burned onto CDs or DVDs (or for very large collections, an external
hard drive). Output volumes, such as CDs or DVDs, are labeled to track the production
series.

Native file production

For native file productions, the set of documents to be produced is typically converted
to TIFF or PDF formatted files during production. Organizations need to adhere to
proper forensic procedures for handling native files.
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For Concordance Desktop databases, the Native File Production produces a copy of the
original native file.  The produced document does not include any annotations or
markups. 

Generating Load files and images

The output from a production from Concordance Desktop is a set of image or PDF files
and an OPT file. The output generated depends on production requirements agreed
upon with opposing counsel. A best practice is to know in advance what the recipient
needs for output format. The database administrator can collaborate with someone
from opposing counsel’s technology department to determine their exact needs.

Administrators can also export specific fields of data and OCR from Concordance
Desktop to include with the production. OCR text files are generated using a
Concordance Desktop CPL (script).

Learning more about productions

Anyone tasked with preparing productions should receive Concordance Desktop
Administration training before attempting to produce documents from a live database. The
litigation industry guidelines regarding how discovery documents are handled, processed,
and shared between parties is a sensitive matter.

If you or anyone on your IT or Litigation Support Team are interested in learning more
about productions, please email our Client Training Administrator at
training@cloudnine.com to register for the Concordance Desktop courses.

Additional course information is available on CloudNine Training.

Protecting Data

Protecting discovery document collections is a sensitive and demanding job. Your
Concordance Desktop administrator or Litigation Support Manager must perform a variety
of maintenance processes and manage various files to preserve the integrity of your
document collection. Stringent litigation guidelines must be adhered to and maintenance
schedules followed to protect the information and ensure your databases are up-to-date
and running efficiently for the review team.

Many of the processes involved in protecting your Concordance Desktop databases
include:

· Taking Snapshots
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· Backing Up Databases

· Zapping Databases

· Packing Databases

· Deleting Tags

· Performing Global Replacements

Consult with your Concordance Desktop administrator or Litigation Support Manager to
gain a deeper understanding of your organization’s maintenance process schedule. If you
are responsible for maintaining the database at an administrative level, it is recommended
that you attend our Concordance Desktop Administration Fundamentals and Concordance
Desktop Certified System Administrator classes.

If you or anyone on your IT or Litigation Support Team are interested in learning more
about Concordance Desktop classes, please email our Client Training Program Administrator
at Training@cloudnine.com. 

Avoid using administrative features in Concordance Desktop that you are unfamiliar
with, because using these features without fully understanding the feature may
cause data loss or corruption. These features may also require a backup of the
database before proceeding.

Whenever possible, consult with your database administrator before attempting to
use any administrative features so they can either backup the database before you
proceed or take care of administrative tasks for you.

Saving and restoring snapshots

Snapshots are a point-in-time picture of your work history. Using snapshots is one way
reviewers can help track and preserve both search history and search results.

Saved snapshots can easily be restored to see what the contents of a database were on
a particular day, and what search results were found at that moment in time. During a
lengthy review, tracking your work for the day is also important, not only to manage tasks
and schedules, but to provide a placeholder for searches so you can jump right back into
your project without duplicating previous efforts.

Unlike a query file, a snapshot saves the search results for documents retrieved, not
which words were searched. This means that a snapshot will not locate new or updated
documents in a database; a snapshot only displays those documents captured at the time
the picture was taken. 

Because snapshots provide a picture-in-time reference, all your search queries and
customized sort settings are preserved and can be displayed again or restored at a later
time. If your database is actively being edited, changes will not be reflected in a snapshot
saved last week. For instance, a document deleted from the database since the snapshot
was taken will display as blank when you open the snapshot in Concordance Desktop. To
capture updates after edits have been made, rerun your snapshot queries.
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Snapshots are saved as .snp files and can only be restored on the original databases.
When you restore a snapshot file, Concordance Desktop automatically opens the
databases associated with the file, with all queries and sorts preserved.

If you regularly save snapshots at the end of every work session, we recommend that
you periodically review and delete outdated or unnecessary files due to their large file
size on your hard drive or network.

There are two ways to save snapshots in Concordance Desktop. You can manually save
snapshots or you can use the Auto restore command to have Concordance Desktop
automatically save snapshots for you. 

To manually save a snapshot:

Ensure that the snapshot path along with the file name does not exceed 256
characters. Windows limits file paths to a maximum of 256 characters. 

1. To open the Save Snapshot dialog box, do one of the following:

· In the Databases task pane, click Save snapshot.

· On the File menu, click Snapshot, and then Save snapshot.

2. Browse to where you want to save the snapshot file, type the file name in the File
name field, and then click the Save button.

All search queries and customized sort settings for the current Concordance
Desktop session are saved in a .snp file.

Auto-restoring snapshots

With the Auto-restore feature, Concordance Desktop can automatically create and
save a snapshot each time you close the Concordance Desktop application. The next
time you open a Concordance Desktop session, the application automatically displays
the exact record and view settings you had when you closed the application, including
displaying your last search in the Review view. 

The Auto-restore feature functions differently than manually saving separate snapshots
of work your sessions. When the Auto-restore feature is enabled, Concordance Desktop
creates the autosave.snp file and automatically saves the snapshot created by the
Auto-restore feature to this file at the end of each session, overwriting the previous
work session’s autosave.snp file. The autosave.snp is automatically saved to the ...
\Documents and Settings\UserID\My Documents\Concordance Desktop [version#]
(Windows  XP) or ...Users\UserID\My Documents\Concordance Desktop [version#]
(Windows 7) directory on your machine.

By default, the Auto-restore feature is enabled. The Auto-restore feature is enabled
and disabled by clicking the Auto restore option in the Snapshot menu. When a check
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mark is displayed next to the Auto restore menu selection, the Auto-restore feature is
enabled. When the check mark is not displayed, the Auto-restore feature is disabled.

To restore a snapshot:

1. To open the Restore Snapshot dialog box, do one of the following.

· In the Databases task pane, click Restore snapshot.

· On the File menu, click Snapshot, and then Restore snapshot.

2. Browse to and select the snapshot file (.snp) you want to open, and then click
Open.

When you restore a snapshot file, Concordance Desktop remembers what databases
and documents were accessed during the search session captured by the snapshot and
launches them. The search results are displayed in the Review view, and the restored
snapshot file is listed in the Recent panel in the Databases task pane.

About backing up databases

Database administrators take stringent precautions against data loss. Data loss can occur
for many reasons, including hardware failures, file corruption, human error, and natural
disasters such as fire, floods, electrical surges that can cause damage to equipment
containing data. It is important that precautions are in place to deter any data loss by
backing up data on a regular basis and having disaster recovery plans in place.

Most organizations have backup programs that run automatically at scheduled times to
backup data on their network servers. We recommend becoming familiar with your
company’s backup policies and disaster recovery plans in case you need to recover data
that has been lost or damaged.

Every organization handles backups differently, so it is important to know how often
backups occur on your network or off-site hosted network. Sometimes backups are stored
off-site or may be difficult to recover on short notice, so it is helpful to know what to
expect.
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Concordance Desktop databases on a network should be backed up on a regular basis to
protect work product. Concordance Desktop databases that are stored on local hard
drives or hosted on off-network computers should have an alternative means of backing
up the data, such as an external hard drive or other backup device that can be easily
attached to the computer. Many of these devices come with software programs that are
designed to run backups automatically at a scheduled time, or files can be backed up by
copying them manually to a storage device attached to the computer.

Consult with your Concordance Desktop administrator or Litigation Support Manager if you
need more information regarding your organization's backups and disaster recovery plans.

About other maintenance tasks

In addition to backing up and preserving databases, your Concordance Desktop
administrator performs several processes that keep your document collection streamlined
and running efficiently.

Reviewers should understand how these processes affect their document collections, but
should not attempt to use any of these tools without consulting their Concordance
Desktop administrator or having received proper database administration training for
Concordance Desktop.

The following administrative functions do not have an undo feature to retrieve data
once the process is performed:

· Zap - deletes every record in the database

· Pack - if not done properly, can delete all of the records in the database

· Delete Tags - deletes all tags in the database

· Global Replace - if not done properly, can change data throughout the entire
database unintentionally

We highly recommend that security is applied to every Concordance Desktop database to
preserve document collections and protect staff from inadvertently deleting or altering
critical information.

Zap

This is an administration-only function. The Zap feature is used to remove all
documents from a database, freeing space in Concordance Desktop. Once all
documents are purged, only the stopwords file and field definitions are retained in the
database. When zapping a database, there is no undo feature for document retrieval so
administrators must back up databases before running this process.

Pack
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This is an administration-only function. The Pack feature is used for both the document
database and dictionary file. Packing a database removes all documents that are
marked for deletion. Packing a dictionary optimizes its file structure to increase search
speed and reindex processing time. Once performed, there is no undo button for data
retrieval, unless your Concordance Desktop administrator has made a backup file of all
deleted records.

Delete Tags

The Delete Tags feature is used either to remove a tags from all documents, or remove
all tags from a database. There is no undo feature once this process is performed.

Global Replace

Global editing is basically running a Find and Replace process for words or phrases in a
database. The Global Replace function can perform replacements on specific fields, full
or empty fields, with or without case sensitivity, and with or without confirmation
before replacement. Caution must be used when replacing data, otherwise information
in your document collection may be unintentionally and permanently altered. There is no
undo feature once this process is performed.

Concordance Desktop Viewer

Content review of documents is primarily done with the Concordance Desktop Viewer.
Concordance Desktop Viewer allows you to magnify the original document image for clarity
and inspection, and provides a variety of markup tools specifically designed for privileged
content and trial preparation. Once you have reviewed and annotated the content,
especially redacting key information, the document markings are automatically saved and
the changes secured. 

Concordance Desktop stores references to all native documents and image information in a
single Concordance Desktop Image Base database (.cib) file. The .cib file is located in the
same folder as the associated Concordance Desktop database (.dcb).

Due to changes within Brava, our third party vendor, if you are currently working on a
review with Concordance Desktop Viewer (any version), it is recommended that you
complete the review and produce the files before migrating the database to
Concordance Desktop.  For more information, contact Concordance Desktop
Technical Support.
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Supported file types

The Concordance Desktop viewer works with the following file types:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic Experts Group

*.gif Graphic Image File

*.bmp Bitmap

*.asc ASCII text

*.pcx PC Paintbrush Bitmap

*.csv Comma-Separated Values

*.cal, *.cals Facsimile

*.pdf Adobe Portable Document Format

*.doc, *.dot, *.docx Microsoft Word

*.ppt, *.pps, *.pptx, *.pptm Microsoft PowerPoint®

*.xls, *.xlsx Microsoft Excel

*.msg Microsoft Outlook 2010 or later Message File

*.eml Microsoft Outlook Express®

*.txt ASCII text

*.rtf Rich Text Format

*.html, *.htm Web/HTML

*.wps Microsoft Works®

Concordance Desktop Viewer basics

Navigating the document viewer

The viewer in Concordance Desktop opens a separate window that displays the document
associated to the record you currently have open in the Concordance Desktop database. 
Using the tools in the viewer, you can review documents, navigate between records,
apply markups (annotations), and adjust the display of the documents.  

The Thumbnails pane in the viewer displays small images of the pages of the current
document.  The Document Information pane displays additional information about the
current document, such as corresponding media information, image information (images
only), and markup history.



Document Review 193

(A) Viewer work area  (B) Markup toolbar  (C) Navigation toolbar  (D) Thumbnails pane  (E) Media
information pane

Concordance Desktop viewer toolbars

The following toolbars are available for adding annotations, navigating, and viewing
documents.

The Markup toolbar

The Markup toolbar provides a variety of tools for adding markups (annotations) to a
document during the review process.

Tool Name Description

Pan Moves the current page in any direction

Selection Selects a markup to edit, move, copy, resize,
reshape, or delete

Text Box Places a box that contains text on the page

Notes (Changemarks) Places a note icon on the page and opens a pop-
up for the content, status, classification reason
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Tool Name Description

Image Places an external raster image (JPG, BMP, or
PNG) on the page

Stamp Places a predefined stamp on the page

Straight Line Draws a straight line in any direction on the page

Polyline Draws a jointed line on the page

Crossout Draws an X on the page

Arrow Draws a line with an end arrowhead on the page

Rectangle Draws a rectangle around the selected area on
the page

Ellipse Draws an ellipse around a selected area on the
page

Redaction Blocks out areas on the page that are considered
confidential or sensitive from being viewed or
copied after production

Strikeout Draws a strikeout line over the selected text

Underline Draws an underline under the selected text

Highlight Highlights the selected text

Strikeout, Underline, and Highlight markup tools are only available if the document
contains selectable text.

The Markup properties toolbar

The Markup properties toolbar displays properties you can set for the selected markup
tool when adding or editing a markup.

Property Name Description

Fill Defines color for a markup tool

Text format Defines font name, style, size, and effect:

(T) - Transparent, match background, or custom
color

(U) - Underline
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Property Name Description

(I) - Italic

(B) - Bold

Line Style Defines style and width for lines and shapes

The Navigation toolbar

The Navigation toolbar allows you to move between documents and records. See,
Displaying documents and records in the viewer.

Tool Name Description

First Document Navigates to the first document in a single or
concatenated set of Concordance Desktop
databases

Previous Document Navigates to the previous document in a single
or concatenated set of Concordance Desktop
databases

Next Document Navigates to the next document in a single or
concatenated set of Concordance Desktop
databases

Last Document Navigates to the last document in a single or
concatenated set of Concordance Desktop
databases

GoTo Document Navigates to a specified document or page within
a single or concatenated set of Concordance
Desktop databases

Previous Page Navigates to the previous page in a multi-page
document shown in the viewer

Next Page Navigates to the next page in a multi-page
document shown in the viewer

The View toolbar

The View toolbar adjusts the magnification, size, and orientation of the current
document.  
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Tool Name Description

Zoom on Selection Enlarges a selected region

Magnifier Displays a magnifier window for viewing sections
of the current document

Fit to Height Adjusts the zoom height so that the entire height
of the document appears in the workspace

Fit to Width Adjusts the zoom width so that the entire width
of the document appears in the workspace

Zoom slider Controls the magnification of the document being
displayed

Rotate Clockwise Rotates the document in 90 degree clockwise
increments

Rotate Counter
Clockwise

Rotates the current document in 90 degree
counter clockwise increments

Toggle Thumbnails Opens the Thumbnails pane

The Thumbnails pane

The Thumbnails pane displays small images of the pages within the current document. 
The green rectangle indicated the currently displayed page.  The red exclamation point
(!) next to the thumbnail image indicates the page contains markups.  See, Displaying
documents and records in the viewer.
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Use the navigation tools in the Thumbnails pane to navigate the pages of the current
document.

Tool Name Description

First Page Navigates to the first page of the document or
image

Previous Page Navigates to the previous page of the document
or image

Next Page Navigates to the next page of the document or
image

Last Page Navigates to the last page of the document or
image

Previous Markup Page Navigates to the previous page that contains
markups

Next Markup Page Navigates to the next page that contains
markups

The Media Information pane
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The Media Information pane contains detailed information about each document within
a record. Each media button can be configured to display the information most
important to you.  See, Using the Document Information pane.  

Media Tab Description

Document Information Displays numeric, date, text and paragraph data, up to
60 characters, from the document's corresponding
Concordance Desktop field in the order you specify.

Image Information Displays metadata for the current image-type object
displayed in the viewer. TIFF image types display full
information. Other image types such as GIF and BMP
display only minimal information as these image types do
not allow for the storing of descriptive information within
the image.
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Media Tab Description

Markup History Displays a complete history, in descending chronological
order, of all markup additions, modifications, and
deletions that have taken place for the current document.

Displaying documents and records in the viewer

Using the media key (image key) field in Concordance Desktop, the viewer can synchronize
with the current database and display the associated documents.  Using the viewer you
can also view native documents, removing the need to purchase and open the document
in its native application.  The viewer opens a PDF copy of the supported document types,
allowing you to review and annotate them.

With the Concordance Desktop viewer open alongside the Concordance Desktop
application, you can view a record in the Browse and Table views while viewing the same
record in the viewer.

To open documents in the viewer:

1. In Concordance Desktop, open the database you want to view.

2. On the Dynamic toolbar, click the View Image (camera) button.

Documents may consists of multiple pages.  There are two way to determine if a
document contains multiple pages: 

· Appended is displayed next to the media key near the top of the view workspace.

· The Next Page button is activated.
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Concordance Desktop viewer

To navigate between documents and pages:

On the Navigation toolbar, do any of the following:

· To move to the next document, click the Next document button.

· To move to the previous document, click the Previous document button.

· To move to the next page in the document, click the Next page button.

· To move to the previous page in the document, click the Previous page button.

· To move to a specific document, click the Go To Document or Image page
button, in the Go To dialog box select the document number you want to view, and
then click GoTo.

· To move to a specific page in the document, click the GoTo Document or Image
page button, in the Go To dialog box, select the page number you want to view,
and then click GoTo. 

To display a page within the current document using the Thumbnails page:

1. To open the Thumbnails pane, do one of the following:
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· On the Navigation toolbar, click the Toggle Thumbnails button.

· On the right side of the workspace, click the arrow  button.

2. In the Thumbnails pane, click the page you want to view.

Concordance Desktop viewer Thumbnail pane navigation

Opening views

When synchronized with Concordance Desktop, each tab in Concordance Desktop has an
associated tab in the viewer, displaying the associated document view.  You can have up
to 16 views open at the same time. Each view is accessible using the named tabs at the
top of the workspace.
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If the Concordance Desktop Image Base (.cib) file does not exist for the
corresponding Concordance Desktop database, then you are prompted to convert the

existing imagebase or select the load file exported from CloudNine™ LAW (OPT) or

Concordance Desktop Image (LOG) file. 

To view media files in the viewer:

1. In Concordance Desktop, select the database tab you want to view.

2. On the Dynamic toolbar, click the View Image (camera) button.

The viewer opens the view for the document associated with the current record in
Concordance Desktop. 

 

To close the current view:

From the File menu, click Close.
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Magnifying records in the viewer

In the Concordance Desktop viewer, you can zoom, magnify, pan and rotate documents
depending on the record type and particular content. For instance, handwritten
documents are harder to read online and perhaps illegible in some instances too. Special
magnifying tools allow you to read with ease and inspect signature details.

Tool Name Description

Zoom on Selection Enlarges a selected region

Magnifier Displays a magnifier window for viewing sections of
the current document

Fit to Height Adjusts the zoom height so that the entire height
of the document appears in the workspace

Fit to Width Adjusts the zoom width so that the entire width of
the document appears in the workspace

Zoom slider Controls the magnification of the document being
displayed

Rotate Clockwise Rotates the document in 90 degree clockwise
increments

Rotate Counter
Clockwise

Rotates the current document in 90 degree
counter clockwise increments

Toggle Thumbnails Opens the Thumbnails pane

To adjust the magnification of the document view:

On the Navigation toolbar, do any of the following:

· To enlarge a selected area, click the Zoom on Selection tool and drag the tool
across the area you want to enlarge.

· To open a magnifier window, click the Magnifier tool and drag the tool over the
area you want to magnify.

· To fit the entire height of a document in the workspace, click the Fit to Height
button.

· To fit the entire width of a document in the workspace, click the Fit to Width
button.

· To zoom in or out on a document, using the Zoom slider drag the slider to the right
to increase the magnification or to the left to decrease the magnification.

· To rotate a document in 90 degree increments, click the Rotate Clockwise or
Rotate Counter Clockwise button.
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If your mouse has a scroll wheel, you can use the wheel to quickly zoom in or out
on a document.  Click in the workspace, and then turn the mouse wheel to zoom in
or out of the document.

To toggle the options of the Magnifier window:

1. On the Navigation toolbar, click the Magnifier tool.

2. Toggle the icon in the upper left corner for different viewing preferences.

· When the Eyeglass icon  displays, click on any area of the document and the
window will snap to that area and display the selected section.

· When the Bird's Eye icon  displays, a small rectangle displays with the cursor
when it is moved off the magnifier window.

As you move your cursor over the document, the area contained in small
rectangle displays in the magnifier window. 

· When the Dock  icon displays, you can click on an area of the document and
that area stays docked in the magnifier window.

You can scroll on the document and the view that is currently in the magnifier
remains the same until another area selection is made.

3. Click or drag the corner or edge of the magnifier window to expand its size.

4. Click on the Adjustment Handle  to decrease or increase the font size
within the magnifier window.

5. Click the Close button to exit the magnifier window.

Using sticky zoom and sticky rotate:

Many documents are often scanned with a portrait page view setting, making online
reading a challenge unless the page is rotated. The Sticky Zoom and Sticky Rotate
settings make reviewing easier by changing the page layout to a landscape view and
keeping it there even while navigating between records.

The Sticky Zoom and Sticky rotate functions are located on the View menu:

· Sticky Zoom - keeps your preferred magnification settings as you move from record
to record. If you uncheck the selection, and then navigate to the next record, the
record defaults to the full page view.

· Sticky Rotate - retains the rotated settings as you page through a record. These
settings are especially helpful if you are reviewing a spreadsheet.  If you uncheck
the selection, and then navigate to the next record, the record defaults its original
view.



Document Review 205

A check mark next to each option on the Tools menu indicates that this setting is
selected. The selections are maintained for the current database when Concordance
Desktop Viewer is closed and reopened.

Concordance Desktop viewer View menu

Using the media information pane

The Media Information pane provides quick access to additional information (metadata)
about the current document or image.  The information is directly linked to the information
in Concordance Desktop and is stored in the Concordance Desktop Image Base (CIB) file.  
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The Media Information pane organizes the information into three views.  

Media Button Description

Document Information Displays numeric, date, and text up to 60 characters and
paragraph data truncated to 60 characters from the
document's corresponding Concordance Desktop data in
the order you specify.

Image Information Displays metadata for the current image-type object
displayed in the viewer. TIFF image types display full
information. Other image types such as GIF and BMP
display only minimal information as these image types do
not allow for the storing of descriptive information within
the image.

Markup History Displays a complete history, in descending chronological
order, of all markup additions, modifications, and
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Media Button Description

deletions that have taken place for the current document.

The upper section of the Media Information pane displays detailed information about the
document for the selected view.  The lower section displays a set of buttons for one-click
access to the corresponding view.  When you click a view button, its contents are
displayed in the upper section.  The horizontal splitter bar located between the view and
the buttons allows you to collapse the buttons into a button tray.
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To show and hide the media information pane:

In the upper left corner of the media information pane, click the Expand/Collapse
(<<)  button.

The Document Information and Image Information views are customizable so that you can
display only the information you want.

To configure the Documentation Information view:

1. In the Media Information pane, click the Document Information view button.

2. To designate the Concordance Desktop database fields to display in the view, click the
View button.

The Grid View Options dialog box lists all the corresponding Concordance Desktop
imagebase fields available to display.

3. To select fields, in the Imagebase fields section, do any of the following:

· To select individual fields, select the field name check box.

· To select all the fields, click the Select All button.

· To cancel all the selections, click the Clear All button.

4. To reset the order the fields appear in the view, select the field you want to move, and
then click the Move Up or Move Down button.

5. When finished, click Save.

To configure the Image Information view:

1. In the Media Information pane, click the Image Information view button.

2. To designate the Concordance Desktop database fields to display in the view, click the
View button.

The Grid View Options dialog box lists all the metadata information available to display.

3. To select metadata, in the Imagebase fields section, do any of the following:

· To select individual metadata, select the metadata check box.

· To select all the metadata, click the Select All button.

· To cancel all the selections, click the Clear All button.

4. To reset the order the metadata information appears in the view, select the field you
want to move, and then click the Move Up or Move Down button.

5. When finished, click Save.
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You can also print or save any of the information in the Media Information views.

To print a media view:

1. In the Media Information pane, open the view you want to print.

2. Click the Print button.

3. In the Print preview dialog box, review the information, and then click the Print button.

Annotating documents

Applying markups

During the discovery process, marking up record detail is the phase when deeper content
investigation and case record preparation begins. 
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The Markup toolbar includes a variety of tools you can use to mark up (annotate) a
document or image during review. Applying markups includes redacting information and
adding notes. You can also apply color markings to highlight or underline text and add a
circle or box to emphasize a block or region of key content. All of these elements can
easily be edited, moved, or resized.

There is no limit to the number of markups you can add to a document.

Markups for the current document/record are displayed in the history tab of the Document
information pane. The markup history displays markup type, author, date, and time. 
Markup history is also saved in the .cib file.  See, Viewing document information.  

The current state for the markups on a document are stored in an XML formatted
(.xrl) file in the same directory as the corresponding media file.  DO NOT edit this file.
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 Doing so may corrupt all your markups and redactions, as well as, possibly cause
Concordance Desktop Viewer to crash.

Due to changes within Brava, our third party vendor, if you are currently working on a
review with Concordance Desktop Viewer version 1.08 or earlier, it is recommended
that you complete the review and produce the files before migrating to Concordance
Desktop.  For more information, contact Concordance Desktop Technical Support.

To add text:

1. On the Markup toolbar, click the Text tool .

2. Using the Text tool, select the area where you want to add the text. 

3. In the Text dialog box, type the text you want to add.

4. On the Markup properties toolbar, specify any of the following: 

· To change the color, click the Color button , and then select a color from the
color picker.

· To change the font, in the Font list, select a font.

· To change the font size, in the Font size list, select a font size.

5. To change the background color of the text box, click the Text Background button
(T), and then select one of the following:

· Transparent sets the background as transparent and all text is visible.

· Match Display Background sets the background color to match the color of the
current document background.

· Select Background Color opens the color picker dialog box, and sets the
background to the color selected.  The outline color of the text box is set to be
the same as the current font color.

6. Set the font style, do any of the following:

· To underline the text, click the Underline button.

· To italicize the text, click the Italics button.

· To make the text bold, click the Bold button.

7. Navigate to another document to save the markup.

To add a note:

1. On the Markup toolbar, click the Note tool.
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2. Using the Note tool, click in the area of the document where you want to place the
note.

3. In the Changemarks dialog box, do the following:

· In the top field, type a title for the note.

· In the bottom field, type the text you want to include in the note.

4. When finished, click OK.

5. To change the note color, on the Markup properties toolbar, click the Color

button , and select a new color from the color picker.

6. Navigate to another document to save the markup.

You cannot use Rich Text Formatting (RTF) in notes, including copying RTF
content from another application and then pasting into a note.  Doing so may
corrupt all the markups and redactions, as well as, possibly cause Concordance
Desktop Viewer to crash.  If this happens, you need to contact Customer Support.

After applying a note, you can move the pointer over the note to display the first
40 characters of the contents of the note.  To view the contents of the note
(maximum of 520 characters), double-click the note you want the view to open the
Markup History Details dialog box.

To add lines:

1. On the Markup toolbar, click one of the following:

· To draw a straight line, click the Line tool .

· To draw a jointed line, click the arrow next to the Line tool, and then click the

Polyline tool .

· To place an X over an area on the document, click the arrow next to the Line

tool, and then click the Crossout tool .

· To draw an arrow, click the arrow next to the Line tool, and then click the Arrow

Line tool .

2. Draw on the document:

· To draw a line, crossout, or arrow, drag the tool across the document where you
want the markup to appear.

· To draw a polyline, click to create the starting point, move the tool, and then
click to create each segment. 

· To draw a line, polyline, or arrow that is horizontal or vertical, press Shift while
you draw.
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3. To change the line properties, on the Markup properties toolbar, do any of the
following:

· To change the color, click the Color button , and then select a color from the
color picker.

· To change the line width, select the value from the drop-down list.

· To change the line style, select the style from the drop-down list.

4. Navigate to another document to save the markup.

To add shapes:

1. On the Markup toolbar, click one of the following:

· To draw a rectangle or square, click the Rectangle tool .

· To draw an ellipse or circle, click the arrow next to the Rectangle tool, and then

click the Ellipse tool .

2. Draw in the document:

· To draw a rectangle or ellipse, drag the tool across the document where you want
the markup to appear.

· To draw a square or circle, press Shift while you draw. 

3. To change the shape properties, on the Markup properties toolbar, do any of the
following:

· To change the color, click the Color button , and then select a color from the
color picker.

· To change the shape style, select the style from the shape style list.

4. Navigate to another document to save the markup.

To add text edit markups:

When a document contains selectable text, the Strikeout, Underline, and Highlight tools
become available.

1. On the Markup toolbar, click one of the following:

· To draw a strikeout, click the Strikeout tool .

· To draw an underline, click the arrow next to the Strikeout tool, and then click

the Underline tool .

· To draw a highlight, click the arrow next to the Strikeout tool, and then click the

Highlight tool .

2. Draw in the document:
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· To draw a strikeout, drag the tool across the text where you want the strikeout
to appear.

· To draw an underline, drag the tool across the text where you want the underline
to appear .

· To draw a highlight, drag the tool across the text where you want the highlight to
appear.

3. To change the text edit color, on the Markup properties toolbar, click the Color

button , and then select a color from the color picker.

A) Strikeout B) Highlight C) Underline

4. Navigate to another document to save the markup.

Applying images and stamps

The Images tool allows you to insert raster images (JPG, BMP, or PNG) into the current
document.  Images are created in an image editor for use with Concordance Desktop
Viewer.  Concordance Desktop Viewer is shipped with 16 images, such as Draft, Final,
Reviewed, and Witness.
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To insert an image:
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1. On the Markup toolbar, click the Image tool .

2. On the Markup properties toolbar, do one of the following:

· From the Image list, select an image.

· Click Browse, and then select the image you want to add.

3. Select the area where you want to add the image.

4. Navigate to another document to save the markup.

The image list in the Markup properties toolbar lists shows the 10 most recently
used images providing quick access to the images you apply most often.

Stamps contain predefined information, such as color, content, and other elements that
cannot be modified.  Concordance Desktop Viewer is shipped with four predefined
stamps:  

· Attorney's Eyes Only

· Attorney-Client Privilege

· Confidential

· Under Seal
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To add a stamp:

1. On the Markup toolbar, click the Stamp tool .

2. On the Markup properties toolbar, select a stamp from the Stamp list.

3. Click the area where you want to add the stamp.

4. Navigate to another document to save the markup.

The stamp list in the Markup properties toolbar lists the four default stamps that
are shipped with Concordance Desktop Viewer.

Applying redactions

A redaction is used when confidential information needs to be hidden in a document for
production.  Redactions associated with the produced document cannot be edited or
removed.  Once the document is produced, any text or images concealed by a redaction
cannot be viewed, copied, or searched.

If you need to export the body text for a production, you will need to re-OCR the
images after the redactions have been burned in.

The Redaction tool allows you to place one or more redactions (rectangular boxes) over
various areas of sensitive information within a document.  In Concordance Desktop Viewer,
the redaction appears transparent to allow you to make sure the redaction covers the
information you want to conceal.  When a production is executed, the redaction becomes
opaque concealing the information underneath.

When redacting a bullet or numbered list, it is recommended that you always apply
redactions using the Rectangle tool. This ensures that the list content is completely
redacted when the image is produced and/or printed. Begin drawing the rectangle in
the margin, outside the text area, to ensure all information is redacted successfully.

Since PDF files are not flattened or burned, when producing PDF files the redacted
information is removed from the file before the redaction is placed.  The production
process physically removes the hidden text from the produced file, the original document
is not altered.

When printing CNV documents, redacted documents print with transparent redactions
making the text underneath the redaction visible.  If you want redactions to print
opaque, you need to use the Production tool in Concordance Desktop to produce the
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documents and then print the output documents. For more information see
Productions.

There are two ways you can apply a redaction:

· Draw a redaction box over an area of the document or image

· Draw a single redaction line across a sentence or part of a sentence
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A) Redacted paragraph B) Redacted text within a paragraph C) Highlighted text

To add a redaction:

1. On the Markup toolbar, click the Redaction tool .

2. Using the Redaction tool, do any of the following: 

· To redact sentence-level text, click within the text and draw the tool along the
text.

· To redact a section of a document, click outside the text area and draw a
rectangular box around the text.

· To redact a list, click outside the margin of the list, and draw a rectangular box
around the text.

We recommend that you use different colors when applying redactions and
highlighting text. This ensures that the markup type can be easily differentiate
when viewing a document or image.

3. With the redaction selected, on the Markup Properties toolbar, locate the Reason
list.

4. In the Reason list, do one of the following and then press Enter:

· Type a new reason. 

· Click an existing reason from the list.

If you do not enter a reason for the redaction and press Enter or select a
reason from the list, the current redaction reason shown in the Reason list will
be applied to the redaction.

The redaction list displays only 40 redaction reasons based on alphabetical
order.

4. Navigate to another document to save the redaction.

To change the properties of a redaction:

1. On the Markup toolbar, click the Selection tool .
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2. Select the redaction you want to change.

3. On the Markup properties toolbar, do any of the following:

· To change the redaction color, click the Color button , and select a new color
from the color picker.

· To change the redaction reason, type a new reason or select it from the list, and
then press Enter.

4. Navigate to another document to save the redaction.

Editing markups

You can change the appearance, size, and location of markups after you add them.  All
changes are tracked in the Markup History view of the Media Information pane.

To edit a markup's properties:

1. From the markup toolbar, click the Selection tool .

2. Select the markup you want to edit.

3. From the Markup properties toolbar edit any of the properties.

To edit another user's markups:

1. From the markup toolbar, click the Selection tool .

2. Press Shift and then select the markup you want to edit.

To rotate or resize a markup:

1. On the Markup toolbar, click the Selection tool .

2. Select the markup.

The markup displays a rotate handle and resize handles around the perimeter.
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3.  Do one of the following:

· To rotate the markup, drag the green rotate handle in the direction you want to
rotate the markup.

· To resize the markup, drag one of the resize handles to transform the markup to the
desired size.

To delete a markup:

1. On the Markup toolbar, click the Selection tool .

2. Do any of the following:

· To select a single markup to delete, select the markup you want to delete.

· To select multiple markups, press CTRL and select the markups you want to delete.

· To select all the markups on the page, drag the Selection tool  across all the
markups on the page.

3. Press Delete.

Printing individual documents with Concordance Desktop Viewer

Using the print command in Concordance Desktop Viewer, you can print the current
document displayed in the viewer.  If you need to print a set or batch of documents, you
can run a query and use the CDV Printing command in Concordance Desktop.  See, Batch
Printing with Concordance Desktop Viewer.
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When printing documents, be aware of the following:

· When printing documents that have been reviewed and redacted using the viewer, be
aware that any redaction  placed on the document will print transparent revealing the
text underneath.  If you want to print redactions as opaque, you must run the
documents through the Production process in Concordance Desktop, then print the
document produced document.

· Printing documents that contain markups to Adobe PDF using the File > Print option,
does not permanently burn the markups in the document.  If you want markups burned
in, you must run the documents through the Production process in Concordance
Desktop, then print the produced document.

To print the current document in the viewer:

1. In the Concordance Desktop Viewer window, locate the document you want to
print.

2. From the File menu, click Print.

3. In the Printer section, select the printer to use.
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4. To modify the printer settings, click the Printer Setup button, specify the paper
size, orientation, and other general printing options, and then click OK.  Options will
vary with different printers and drivers. 

5. In the Print dialog box, click the General tab, if not already displayed.

6. In the Print Range section, click one of the following:

· Select All Pages, to print all the pages in the document.

· Select Current page to print the current document displayed.

· Select Designated Pages to define specific pages or a range of pages from the
current document.

· Select Current View to only print the area of the image that is displayed in the
viewer workspace.

7. In the Options section, specify the following:

· In the Number of copies field, type or select the number of copies you to print.

· In the Minimum line thickness field, type a value from 0 to 99 for the thinnest
line weight for markups, and then click points (1 point = 1/72 inch) or mm
(millimeters) for the unit value.

7. From the Print list, click one of the following:

· Click Lines as Black to print all lines black, markups print with color (if
applicable).

· Click As Grayscale to print in shades of gray. 

· Click Original Colors to print using the colors shown in the viewer.

8. Specify any of the following print settings:

· Select the Automatically rotate for best fit check box to allow more of the
image to fit within the margins of the printed page.

· Select the Print Changemarks notes check box to include the text in any notes
in the current document on a separate sheet.

· Select the Print redaction reasons check box to include the text in any
redactions in the current document on a separate sheet.

· Select the Optimize for PDF/Postscript printing check box if you are printing a
PDF document.

The Optimize for PDF/PostScript Printing option resolves the issue where some
older printers and the PDF Distiller and Writer may not properly invert printouts
resulting in reversed prints (black background and white foreground).  When
selected, this produces a bitmap of the current document/image that is sent to the
printer giving accurate printouts for the problematic printer or print driver. 
However, selecting this option results in slower print time and a larger print spool
file.

9. To add header, footer, or watermark text to the printed page, click the
Watermark/Banners button, edit the text strings, and then click OK.  
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To edit headers/footers and watermarks:

1. Click the folder next to the Header/Footer or the Watermark you want to edit.

2. For each header, footer, or watermark, click the <blank> field, and then do
one of the following:

· Type the text you want to be displayed.

· Type % to display the available macros list, and then select the macro you
want.

Available macros

Macro Description

%Date Inserts the current date

%
SysDatePlusDays
(X)

Inserts a date the specified number of days after the system
date. 

%Time Inserts the current time the print is executed based on a 12-
hour clock

%MilTime Inserts the current time the print is executed based on a 24-
hour clock

%Title Inserts the current title of the document

%Page Inserts the page number of the document

%TotalPages Inserts the total number of pages of the document

%BatesPgNo(X) Inserts a page number (x) to include for each printed
document.  The number entered is the beginning page
number for each document.  Multi-page documents are
numbered incrementally.  For example, %BatesPgNo(0001)
would print 0001 on each single-page document.  However, if
a document had more than one page, the first page would
appear as 0001, the second as 0002, and so on.

%Login, User Inserts the user name of the person who executed the print

%Hostname Inserts the hostname of the machine where the print was
executed from

%IPAddress Inserts the IP address of the machine where the print was
executed from

%% Inserts a single % character

© Inserts a copyright symbol

® Inserts a registered trademark

5. To edit the font for all headers, footers, and watermarks, click the Font
button, and then in the Font dialog box, specify the font name, style, and
size.
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6. To view a list of all the headers, footers, and watermark set for the
production, click List.

7. When finished, click OK.

Printing and Production headers/footers and watermark settings are separate
entities.  Parameters you set in the CDV Printing dialog box are only available
for printing.

10. In the Print dialog box, if desired, click on the Scale tab to select options such as
Fit document within banners.

11. When finished, click Print.

Concordance Viewer

Content review of documents is primarily done with the Concordance Viewer. The
Concordance Viewer allows you to magnify the original document image for clarity and
inspection, and provides a variety of markup tools specifically designed for privileged
content and trial preparation. Once you have reviewed and annotated the content,
especially redacting key information, the document markings are automatically saved and
the changes secured. 

Concordance Desktop stores references to all native documents and image information in a
single Concordance Desktop Image Base database (.cib) file. The .cib file is located in the
same folder as the associated Concordance Desktop database (.dcb).

Supported file types

The Concordance viewer works with the following file types:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic Experts Group

*.pdf Adobe Portable Document Format

· Imported eDocs and eMails are automatically converted to near-native PDF files
for viewing. 

· For load file imports, there is an option to convert to PDF for near-native viewing
during database creation.  If the .opt has unsupported file types, they can be
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converted at import or converted later using the Optimize feature on a
document, a query, or the database.  

Concordance Viewer basics

Displaying documents in the Concordance Viewer

Using the media key (image key) field in Concordance Desktop, the viewer can synchronize
with the current database and display the associated documents.

With the Concordance Desktop viewer open alongside the Concordance Desktop
application, you can view a record in the Browse and Table views while viewing the same
record in the viewer.

To open documents in the viewer:

1. In Concordance Desktop, open the database you want to view.

2. On the Dynamic toolbar, click the View Image (camera) button.

Documents may consists of multiple pages.  A multi-page document will reflect 1 of # of
pages, when on the first page of the document.
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Concordance Desktop viewer

Navigating the Concordance Viewer

The Concordance Viewer in Concordance Desktop opens a separate window and displays
the document associated to the record you currently have open in the Concordance
Desktop database.  Using the tools in the viewer, you can review documents, navigate
between documents, apply markups (annotations), and adjust the display of the
documents. 

The viewer work area displays the image of the current document with any markups that
have been applied.  The viewer allows you to continuously scroll through all the
documents without having to select the next document.  Selecting next page or pressing
the page down key when on the last page of the current document will scroll the view to
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the first page of the next document.  You can also use the mouse wheel to scroll through
pages while viewing a document.

The Thumbnails pane in the viewer displays small images of the pages of the current
document.  Thumbnail navigation can be achieved with the mouse wheel and the up and
down arrow keys.

The pane on the right can be toggled between document Properties and markup History. 
Currently, document Properties consists of the fields and values for the document from
the database, while markup History displays the markup history for the document.  

(A) Viewer work area  (B) Markup toolbar  (C) Markup properties toolbar (D) Navigation toolbar  (E)
View toolbar (F) Mouse Mode (G) Thumbnails pane  (H) Document information pane (I) Document
Options (J) Viewer Menu 

Viewer Menu
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The Viewer Menu can be accessed by selecting the hamburger  icon in the upper
left corner of the viewer. 

Menu Item Description

Closes the Viewer Menu and returns to the viewer.

Closes the Concordance Viewer.

Opens the Concordance Printing dialog.

Opens the Concordance Desktop Answer Center.

Mouse Mode

The Mouse Mode determines how the mouse will function while performing various
actions.  It is important to make sure the mouse mode is set appropriately based on
what you want to do in the Concordance Viewer.

Mouse
Mode

Mouse
Cursor

Description

Select Arrow Allows for selecting items or areas on the page to apply and edit
markups.  Most markup activities will use this mouse mode.

Pan/Zoom Magnifying
Glass

Mouse wheel in this mode zooms in/out on the displayed image

Area Zoom Precision
(Cross)

Use the mouse to select an area on the page.  Cursor changes to
magnifying glass, then click inside the selected area to zoom that
selection.

Magnifier Magnifying
Glass

Hold the left mouse button to display a zoom area.  You can move
this area around to magnify an area on the page.

Document Options
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Document
Option

Description

Sticky Markup When selected, it retains the last selected markup. This setting allows
multiple applications of the same markup without having to select the
markup again from the markup toolbar.

Sticky Rotate When selected, it retains the rotated settings as you page through a
record. This setting is especially helpful if you are reviewing a spreadsheet.
 Sticky rotate is also effective when viewing a homogenous population of
documents that all need rotation.  Sticky rotate is retained between
document navigation until the setting is unchecked.

Dual Page View Displays the pages of a document in two columns in the viewer. The first
page is top left. The second page is top right. If there are more than two
pages in the document then the third page is second from the top on the
left.  The number of rows of pages depends on the image size.

The Markup toolbar

The Markup toolbar provides a variety of tools for adding markups (annotations) to a
document during the review process.

Tool Name Description

Area Redaction Blocks out areas on the page that are considered
confidential or sensitive from being viewed or
copied after production.  If text is selected, then
it redacts the selected text.

Highlighter Highlights the selected text.

Rectangle Draws a rectangle around the selected area on
the page.

Ellipse Draws an ellipse around the selected area on the
page.

Connected Lines Draws a jointed line on the page.

Line Draws a straight line in any direction on the
page.

Text Places a box that contains text on the page.

Crossout Draws an X on the page.

Note Places a box on the page to hold short notes.

Stamp Places a predefined stamp on the page.

Arrow Draws a line with an arrow.

Image Places an external raster image (JPG, BMP, or
PNG) on the page.
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Tool Name Description

Strikethrough Draws a strikethrough line over the selected
text.*

Underline Draws an underline under the selected text.*

*Strikethrough and Underline markup tools are only available if the document
contains selectable text and text is selected.

The Markup properties toolbar

The Markup properties toolbar displays properties you can set for the selected markup
tool when adding or editing a markup.  The properties of the toolbar changes depending
on the type of markup selected.

Markup Type(s)  Markup property toolbars Name

Redaction Redaction

Text, Note, and Stamp* Text

Image Image

Rectangle and Ellipse Shapes

Line, Connected Lines,
Crossout, and Arrow

Lines

Highlighter Highlighter

Redaction

The types of lines markup toolbar contains several properties for defining the line
markups in the viewer such as color, width, and line style.  Sets the reason for
redaction.  The reason for redaction will be displayed in the center of the redacted
area when redactions are selected to be included in produced documents.

Property Description

Colors Sets the color to use for the redaction. See more details about the Color
Picker below. 

Redaction
Reason

Sets the reason for the redaction.  This may be blank.

CNDCN The document's CNDCN is listed.
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More information on applying redaction markups can be found in the Annotating
documents section of the Answer Center.

Text

The text markup toolbar contains several properties for designing text markups in the
viewer such as color, font style, size, and effects. 

Property Description

Colors Sets the color for the font and the surrounding text box.  See more
details about the Color Picker below. 

Font Name Select from the font style drop-down list.

Font Size Select from the font size options drop-down list*.

Background
Color

The default for the text background can be changed using the color
drop-down list and selecting an alternative color. 

Underline,
Italic, Bold

Clicking on U (Underline), I (Italic), and/or B (Bold) adds effects to the
font. When an effect is selected, the icon is highlighted 

CNDCN The document's CNDCN is listed.

*The stamp markup doesn't have the property for size as it automatically adjusts
to the size of the text box.

More information on applying text, note, or stamp markups can be found in the
Annotating documents section of the Answer Center.

Image

The image toolbar allows the loading of images so that an external raster image (JPG,
BMP, or PNG) can be placed on the page.

Property Description

Ellipsis Opens Image Markup window to browse to (JPG, BMP, or PNG) to apply
 to image.

CNDCN The document's CNDCN is listed.

Shapes

The shapes markup toolbar contains several properties for designing graphic markups
in the viewer such as color, width, line style, and fill.
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Property Description

Colors Sets the color for the shape and fill if enabled.  See more details about
the Color Picker below. 

Line Width  Sets the width of the lines in the shape.

Line Style  Sets the style of the line (solid, dashes, dash-dot, or dots).

Fill  Fills the shape to make a solid image

CNDCN The document's CNDCN is listed.

More information on applying rectangle or ellipse markups can be found in the
Annotating documents section of the Answer Center.

Lines

The types of lines markup toolbar contains several properties for defining the line
markups in the viewer such as color, width, and line style.

Property Description

Colors Sets the color for the line type.  See more details about the Color Picker
below. 

Line Width Sets the width of the lines.

Line Style Sets the style of the line (solid, dashes, dash-dot, or dots).

CNDCN The document's CNDCN is listed.

More information on applying line, connected lines, crossout, and arrow markups can
be found in the Annotating documents section of the Answer Center.

Highlighter

The highlighter toolbar contains the ability to change the color of the highlighter
tool.

Property Description

Colors Sets the color for the highlighter. The result is transparent with this tool.
 See more details about the Color Picker below. 

CNDCN The document's CNDCN is listed.

Color Picker
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The color picker is separated into three sections: Theme colors, Standard colors, and
Recent colors.

 

By selecting the color wheel, you can select a custom color.

A specific color can be selected by entering the designated values in the appropriate
fields or by moving the color bar on the right and selecting the corresponding tone in
the main square.  The bar immediately below the main square adjusts the
transparency level of the selected color.  
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Redactions may appear transparent in the Concordance Viewer but will be fully
redacted and overlaid with a solid color when produced. 

 The Navigation toolbar

The Navigation toolbar allows you to move between documents and records. See,
Displaying documents in the Concordance Viewer.

Tool Name Description

Previous
Document

Navigates to the previous document in a single or concatenated
set of Concordance Desktop databases.

Next Document Navigates to the next document in a single or concatenated set
of Concordance Desktop databases.

GoTo Document Navigates to a specified document within the current query.

Previous Page Navigates to the previous page in a multi-page document shown
in the viewer, or the next document if on the last page of the
current document.*

Next Page Navigates to the next page in a multi-page document shown in
the viewer.

GoTo Page Navigates to a specified page within a document.

*If you are on the first page of a document and press Previous Page then you will
go to the first page of the prior document not the last page of it. 

The View toolbar

The View toolbar adjusts the size and orientation of the current document.  

Tool Name Description

Rotate Clockwise Rotates the document in 90 degree clockwise
increments.

Rotate
Counterclockwise

Rotates the document in 90 degree
counterclockwise increments.

Fit to Width Adjusts the zoom width so that the entire width
of the document appears in the workspace.

Best Fit Adjusts the image size so that the entire image
of the document appears in the workspace.
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The Thumbnails pane

You can hide or show the Thumbnails pane by clicking the expand thumbnails button 
on the left side of the thumbnails pane.

The Thumbnails pane displays small images of the pages within the current document. 
The thumbnail image for the currently selected page is displayed with a dotted line
around it.  If a page contains markups, it will display with a red box surrounding the
thumbnail image.

Click on a specific page in the Thumbnails pane to display that page in the viewer work
area.

Use the navigation tools in the Thumbnails pane to navigate the pages of the current
document.

Tool Name Description

The Up Arrow
key/ the Left
Arrow key

Previous page Navigates to the previous page of the document
or image.

The Down Arrow
key/ the Right
Arrow key

Next page Navigates to the next page of the document or
image.

Previous markup
page

Navigates to the previous page that contains
markups.

Next markup page Navigates to the next page that contains
markups.

Enter key Select Page Displays the selected page in the main view.

The Page Up key Page Up Thumbnails
pane

Reverses the display of thumbnail in increments
of approximately 5 pages.

The Page Down
key

Page Down
Thumbnails pane

Advances the display of thumbnail in increments
of approximately 5 pages.

Document information pane

The Document Information pane contains detailed information about each record shown
in the viewer.
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Media Tab Description

Properties Displays numeric, date, text and paragraph data, up to
40 characters, from the document's corresponding
Concordance Desktop field.

History Displays the markup history, in descending page order, of
all markup additions, modifications, and deletions that
have taken place for the current document.

Opening views

When synchronized with Concordance Desktop, each tab in Concordance Desktop has an
associated tab in the Concordance Viewer, displaying the associated document view.  You
can have up to 16 views open at the same time. Each view is accessible using the named
tabs at the top of the workspace.  The database you are currently viewing will be
underlined.
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Changing between databases in the viewer

The database that is currently displayed is the database tab that is highlighted in blue. 

To change to another database view in the Concordance Viewer do one of the following:

· Select the database name by clicking on it.

· Toggle to the database name by holding the Ctrl key and selecting the Tab key until the
desired database is selected.

To close the a Database in the Viewer

1. Select the X to the upper right of the database that you would like to close.
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2. A Warning is displayed across the viewer.

3. Select OK to close the database.

4. Select Cancel to leave the database open.

Magnifying records in the viewer

In the Concordance Viewer, you can zoom, magnify, pan and rotate documents depending
on the record type and particular content. For instance, handwritten documents are
harder to read online and perhaps illegible in some instances. Special magnifying tools from
the mouse options and view toolbar allow you to read with ease and inspect signature
details.

  

To adjust the magnification of the document view:

Based on the Mouse Mode selection, and using the View toolbar, do any of the
following:

· To zoom in or out on a document, select the Pan/Zoom tool then use the mouse
wheel.  Rotate the wheel forward to increase the magnification or rotate the wheel
down to decrease the magnification.

· To enlarge a selected area, click the Area Zoom tool and drag the tool across the
area you want to enlarge then double click in the box to zoom.

· To open a magnifier window, click Magnifier and drag the tool over the area you
want to magnify.

The Zoom function in the Concordance Viewer is sticky by default across
documents in the database.  The documents remain in zoom mode until either Fit
to Width or Best Fit are selected.

· To rotate a document in 90 degree increments, click the Rotate Clockwise or the
Rotate Counterclockwise button.

· To fit the entire width of a document in the workspace, click the Fit to Width
button.

· To fit the entire image of a document in the workspace, click the Best Fit button.

Using sticky markup and sticky rotate:
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Many documents are often scanned with a portrait page view setting, making online
reading a challenge unless the page is rotated. The Sticky Rotate setting makes
reviewing easier by changing the page layout to a landscape view and keeping it there
even while navigating between records.

The Sticky Markup and Sticky Rotate functions are located on the Document Options
menu:

· Sticky Markup - keeps your markup settings as you move from record to record. If
you uncheck the selection, then you will need to select the markup each time to
use it.

· Sticky Rotate - retains the rotated settings as you page through a record. These
settings are especially helpful if you are reviewing a spreadsheet.  If you uncheck
the selection, and then navigate to the next record, the record defaults to its
original view.

A check mark next to each option on the Document Options menu indicates that this
setting is selected. The selections are maintained for the current database when
Concordance Desktop is closed and reopened.

Sticky rotate is also effective when viewing a homogenous population that all need
rotation.  Sticky rotate is retained between document navigation until the setting is
unchecked.

Using the document information pane

The Document information pane provides quick access to additional information
(metadata) about the current document or image.  The information is directly linked to the
information in Concordance Desktop and is stored in the Concordance Desktop Image Base
(CIB) file.  
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The Document information pane organizes the information into two views.  

Tab Description

Properties Displays numeric, date, text and paragraph data, up to
40 characters, from the document's corresponding
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Tab Description

Concordance Desktop fields.

History Displays a complete history, in descending page order, of
all markup additions, modifications, and deletions that
have taken place for the current document.

The Properties tab displays detailed information about the document.  

Select the History tab to view markup history.  The Refresh button updates the history
showing the latest changes to the markups for the current document. The Export button
exports all of the markup changes to a csv for further review or reporting. 

The main view of the markup history tab displays the following information if there are
markups saved. 

Item Example Description

Markup name Polygon Redaction Name of the
markup. In the
case of
redaction, the
specific type of
redaction is
listed (area
redaction, or
polygon
redaction).

Page Page 1 The page
containing the
markup or the
markup
removal.

Modification

(Not displayed
when creating
markups.)

Modified (Move) by Reviewer One on 4/19/2019 at 04:17 PM

Modified (Reason) by Reviewer One on 4/19/2019 at 04:17 PM

Deleted by Reviewer One on 4/19/2019 at 04:17 PM

Describes the
change that
was made to
the markup
since creation.
 This includes
the user who
made the
change, date
of change, and
the time of the
change (based
on the
reviewer's
local time).

Reason Highly Confidential The reason is
displayed for
redactions. 
The reason is
entered at the
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Item Example Description

time the
redaction is
placed or
edited.  The
reason may be
blank.

Created by Created by Reviewer One The user name
of the
reviewer that
made the
change.

Date 5/14/2019 The date of
the markup
change in
MM/DD/YYYY
format.

Time at 08:32 PM The time that
the markup
change
occurred
based on the
reviewer's
local time.

Markups that were converted from earlier Concordance versions will show add and
deletion entries only.

Annotating documents

Applying redactions

A redaction is used when confidential information needs to be hidden in a document for
production.  Redactions placed using the viewer are transparent and can be edited,
moved, or deleted as needed.  Once a document is produced, redactions cannot be edited
or removed in the produced file and any text or images concealed by a redaction cannot
be viewed, copied, or searched.

If you need to produce text files, you will need to OCR the produced images after the
redactions have been burned into the production output.

The Redaction tool allows you to place one or more redactions over various areas of
sensitive information within a document.  In Concordance Viewer, the redaction appears
transparent to allow you to make sure the redaction covers the information you want to
conceal.  When a production is executed, the redaction becomes opaque concealing the
information underneath.
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Since PDF files are not flattened or burned, when producing PDF files the redacted
information is removed from the file before the redaction is placed.  The production
process physically removes the hidden text from the produced file, the original document
is not altered.

There are two ways you can apply a redaction:

· Draw a redaction box over an area of the document or image.

· Redact a sentence or part of a sentence through text selection.

Area Redaction and Text Redaction within a paragraph 

To add an area redaction:
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1. On the Markup toolbar, click the Redaction tool .

2. Using the Redaction tool, do any of the following: 

· To redact a section of a document, draw a rectangular box around the section to
redact.

· To redact a list, click outside the margin of the list, and draw a rectangular box
around the text.

We recommend that you use different colors when applying redactions and
highlighting text. This ensures that the markup type can be easily differentiated
when viewing a document or image.

3. With the redaction selected, on the Markup Properties toolbar, locate the Reason
list.

4. In the Reason list, do one of the following and then press Enter:

· Type a new reason. 

· Click an existing reason from the list

· OR you may leave the reason blank

If you do not enter a reason for the redaction and press Enter or select a
reason from the list, the current redaction reason shown in the Reason list will
be applied to the redaction.

The redaction list displays only 40 redaction reasons based on alphabetical
order.

5. Save the redaction by removing focus from it.  To remove focus, you can click
outside the redaction, select another tool or navigation button, or even navigate to
another document.

To add a text redaction:

1. Use your mouse to select the text you want to redact.

2. Click the Redaction Tool on the Markup toolbar.

3. Select the text redaction to change any of the markup properties such as color or
Reason for redaction.

4. Save the redaction by removing focus from it.  To remove focus, you can click
outside the redaction, select another tool or navigation button, or even navigate to
another document.

You can select your text redaction font properties via the Markup Properties
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toolbar at the top of the window.

Text-based redactions are not enabled when a document is rotated.  Use the
area redaction tool or restore the document to the original orientation to use a
text-based redaction.

To change the properties of a redaction:

1. On the Mouse options toolbar, click the Select tool.

2. Select the redaction you want to change.

3. On the Markup properties toolbar, do any of the following:

· To change the redaction color, click the Color button and select a new color from
the color picker.

· To change the redaction reason, type a new reason or select it from the list, and
then press Enter.

4. Save the redaction by removing focus from it.  To remove focus, you can click
outside the redaction, select another tool or navigation button, or even navigate to
another document

When redacting a bullet or numbered list, it is recommended that you always apply
redactions using the Area Redaction tool. This ensures that the list content is
completely redacted when the image is produced and/or printed. Begin drawing the
rectangle in the margin, outside the text area, to ensure all information is redacted
successfully.

All redactions are produced as black when Black & White is selected in Image
Settings for the production output.  Color redactions will appear as set by the user
when Color is selected for the production output.

Applying markups

During the discovery process, marking up record detail is the phase when deeper content
investigation and case record preparation begins. 
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The Markup toolbar includes a variety of tools you can use to mark up (annotate) a
document or image during review. Applying markups includes redacting information and
adding notes. You can also apply color markings to highlight or underline text and add a
circle or box to emphasize a block or region of key content. All of these elements can
easily be edited, moved, or resized.

There is no limit to the number of markups you can add to a document.

Markups for the current document/record are displayed in the history tab of the Document
information pane. The markup history displays markup type, author, date, and time. 
Markup history is also saved in the .cib file.  See, Viewing document information.  
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To add text:

1. On the Markup toolbar, click the Text tool .

2. Using the Text tool, select the area where you want to add the text. 

3. Double click on the text box to open the text edit box.

4. Click on the text edit box once for the cursor to appear for adding text.

5. In the text edit box, type the text you want to add.

6. On the Markup properties toolbar, specify any of the following: 

· To change the color of the box and text, click the first color drop down, and then
select a color from the color picker.  The outline color of the text box is set to be
the same as the current font color.

· To change the font, in the font name list, select a font.

· To change the font size, in the list, select a font size.

· To change the background color of the text box, click the second color drop down
which opens the color picker dialog box, and sets the background to the color
selected.  The color choice displayed as a box with an X (Automatic) sets the
background as transparent with all text visible.

6. Set the font style, do any of the following:

· To underline the text, click the Underline button.

· To italicize the text, click the Italics button.

· To make the text bold, click the Bold button.

7. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

To add a note:

1. On the Markup toolbar, click the Note tool .

2. Using the Note tool, select the area where you want to add the note. 

3. Double click on the note box to open the note edit box.

4. Click on the note edit box once for the cursor to appear for adding text.

5. In the note edit box, type the text you want to add.

6. On the Markup properties toolbar, specify any of the following: 
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· To change the color of the box and text, click the first color drop down, and then
select a color from the color picker.  The outline color of the text box is set to be
the same as the current font color.

· To change the font, in the font name list, select a font.

· To change the font size, in the font size list, select a font size.

· To change the background color of the text box, click the second color drop down
which opens the color picker dialog box, and sets the background to the color
selected.  The color choice displayed as a box with an X (Automatic) sets the
background as transparent with all text visible.

7. Set the font style, do any of the following:

· To underline the text, click the Underline button.

· To italicize the text, click the Italics button.

· To make the text bold, click the Bold button.

7. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

A Note remembers the last text that was entered in the previous note when
creating a new Note markup.  Text will always have a blank text box when you
create a new markup.  
You can use Rich Text Formatting (RTF) in notes and text, including copying RTF
content from another application and then pasting into a note.  The text will be
converted to your current settings for the note.

To add lines:

1. On the Markup toolbar, click one of the following:

· To draw a straight line, click the Line tool .

· To draw a jointed line, click the Connected Line tool .

· To place an X over an area on the document, click the Crossout tool .

· To draw an arrow, click the Arrow tool .

2. Draw on the document:

· To draw a line, crossout, or arrow, drag the tool across the document where you
want the markup to appear.

· To draw connected lines, click to create the starting point, move the tool, and
then click to create each segment.  Double click when finished drawing the last
line segment of the connected lines.

3. To change the line properties, on the Markup properties toolbar, do any of the
following:
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· To change the color, click the color drop down, and then select a color from the
color picker.

· To change the line width, select the value from the drop-down list.

· To change the line style, select the style from the drop-down list.

4. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

To add shapes:

1. On the Markup toolbar, click one of the following:

· To draw a rectangle or square, click the Rectangle tool .

· To draw an ellipse or circle, click the arrow next to the Rectangle tool, and then

click the Ellipse tool .

2. Draw in the document:

· To draw a rectangle or ellipse, drag the tool across the document where you want
the markup to appear.

3. To change the shape properties, on the Markup properties toolbar, do any of the
following:

· To change the color, click the color drop down, and select a color from the color
picker.

· To change the shape style, select the style from the line style list.

· To make a solid shape, select Fill.

4. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

To add text edit markups:

When a document contains selectable text, the Strikethrough, and Underline tools
become available.

1. Select the desired text that you will markup.

2. On the Markup toolbar, click one of the following:

· To draw a strikethrough, click the strikethrough button .

· To draw an underline, click the underline button .

· To redact the selected text, click the Redact button .  Then select the
reason and color from the Redaction properties toolbar.

3. The selected text now has the desired markup. 
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4. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

If you have Sticky Markup enabled in Document Options, then the markup
selections will be applied to all text selections after adding your first text markup. 
This continues until you change the markup style or remove the sticky markup
selection. 

To edit text markups:

1. To edit text markups created in the Concordance Viewer the mouse options need
to be set to Select.

2. When the markup tooltip is visible, left click on the markup.

3. The selected markup can be edited.

· If you are using the underline or strikethrough markup, you can change the color
in the markup properties toolbar.

· If you are using the redaction markup, then the redaction edits can be made with
the redaction properties toolbar.

· If you would like to delete the markup, then select the Delete key.

The markup can be applied to multiple lines/paragraphs of continuous text in
one action.  Removing the markup from the same selected text may be multiple
actions.  Selecting the Delete key repeatedly will remove the markups one at a
time.  

· If a selection of text has multiple markups then each type of markup would need
to be selected and deleted in order to remove all markups from the selection.

Applying images and stamps

The Images tool allows you to insert images (JPG, BMP, or PNG) into the current
document.  Images are created in an image editor for use with Concordance Viewer.  
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To insert an image:

1. On the Markup toolbar, click the Image tool .

2. On the Markup properties toolbar click the ellipsis button, the Image Markup
window opens for browsing to the image you want to add.

3. Select the image and click Open.

4. Select the area where you want to add the image.

5. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

The image list in the Markup properties toolbar lists shows the 10 most recently
used images providing quick access to the images you apply most often.
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Stamps contain a default red "Confidential" stamp. The color, content, and font style can
be modified.  

To add a stamp:

1. On the Markup toolbar, click the Stamp tool .

2. On the Markup properties toolbar do any or all of the following to modify the stamp:

· To change the color of the box and text, click the Color drop down, and then
select a color from the color picker.  The outline color of the text box is set to be
the same as the current font color.

· To change the font, in the font name list, select a font.

· Set the font style, do any of the following:

· To underline the text, click the Underline button.

· To italicize the text, click the Italics button.

· To make the text bold, click the Bold button.

3. Click the area where you want to add the stamp.  Hold the mouse button while
dragging it to the desired size.  The text will automatically size to fit the image. 

4. Save the markup by removing focus from it.  To remove focus, you can click outside
the markup, select another tool or navigation button, or even navigate to another
document.

Editing markups

You can change the appearance, size, and location of markups after you add them.  All
changes are tracked in the Markup History tab of the Document Information Pane within
the Concordance Viewer.

To edit a markup:

1. From the Mouse Mode drop down choose Select.

2. Use your mouse to select the markup you want to edit.

3. Use any of the available markup tools to modify the markup as desired.

To rotate or resize a markup:

1. From the Mouse Mode drop down choose Select.
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2. Use your mouse to select the markup you want to rotate or resize.  The markup
displays a rotate handle and resize handles around the perimeter.

3.  Do one of the following:

· To rotate the markup, hover your mouse on the green rotate handle until your cursor
changes to a rounded arrow, then click and drag the green rotate handle in the
direction you want to rotate the markup.

· To resize the markup, hover your mouse on one of the resize handles until the cursor
changes to a resize arrow, then click and drag to the desired size.

To delete a markup:

1. From the Mouse Mode drop down choose Select.

2. Use your mouse to select the markup you want to delete.

3. Press the Delete key on your keyboard.

Printing individual documents with Concordance Viewer

Using the print command in Concordance Viewer, you can print the current document
displayed in the viewer.

When printing documents, be aware of the following:

· When printing documents that have been reviewed and redacted using the viewer, be
aware that any redaction  placed on the document will print transparent revealing the
text underneath.   If you want to print redactions as opaque, you should select the
Opaque option in the Print Redactions as drop down.

· Printing documents that contain markups to Adobe PDF using the File > Print option,
does not permanently burn the markups in the document.  If you want markups burned
in, you must run the documents through the Production process in Concordance
Desktop, then print the produced document.

To print a single document in the viewer:
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1. From the hamburger menu  in the upper left corner, click Print.

2. Set the printing parameters you want, including specifying which document you want
to print.  See the printing parameter details in Batch Printing with Concordance Viewer

3. Click Start printing.

Printing and Production headers/footers and watermark settings are separate entities.
 Parameters you set in the printing dialog box are only available for printing.

Print Preview

Prior to printing you can also see a preview by clicking on the Preview button at the
bottom of the Concordance Printing dialog.  The preview will display in a separate Print
Preview window, showing the first page of the current document.  You can Print directly
from the preview window, or Cancel the preview to return to the Concordance Printing
dialog.
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Keyboard shortcuts

Use the following keyboard shortcuts to perform Concordance Desktop functions from a
specific view or task pane. The behavior of the keyboard shortcuts depends on the view
or task pane selected. Ensure that the view or task pane you want to work with is
selected before using the keyboard shortcuts.

Concordance Desktop

Browse and Table View

Keyboard Shortcuts: Browse and Table Views

Shortcut Keys Use

F1 Open Concordance Desktop Help.

F2 Open Search task pane.

F3 Open or close the Review View.

F4 Open the Query by Example dialog box to run a form search.

F5 Open or close the Table View in the Browse View.

F6 Open or close the Browse View in the Table View.

F8 Open the Sort task pane.

- Navigate to the previous document. 

+ Navigate to the next document.

C Open the Copy dialog box to copy document data. (Browse View
only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.

L Navigate to the last document.
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Keyboard Shortcuts: Browse and Table Views

Shortcut Keys Use

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.

V Open the current document's corresponding image file in the
image viewer.

CTRL+N Open the New Database Creation Wizard for creating new
databases using load files, E-documents and E-mails.

CTRL+T Open the database templates for creating a new database using
a template.

CTRL+D Open the Dictionary dialog box when your cursor is in the
Advanced Search panel.

CTRL+F Open the Fields dialog box when your cursor is in the Advanced
Search panel.

CTRL+S Open the Fuzzy Search dialog box when your cursor is in the
Advanced Search panel.

Tags Task Pane

Keyboard Shortcuts: Tags Task Pane

Shortcut Keys Use

SPACEBAR Toggle selected tag.

C Open the Copy dialog box to copy document data. (Browse View
only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.
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Keyboard Shortcuts: Tags Task Pane

Shortcut Keys Use

L Navigate to the last document.

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.

other letter keys Navigate to the tag starting with the same letter.

Review View

Keyboard Shortcuts: Review View

Shortcut Keys Use

F2 Open Search task pane.

F3 Open the Review View if it is not already opened.

F4 Open the Query by Example dialog box to run a form search.

ENTER Execute the selected search query.

CTRL+D Open the Dictionary dialog box when your cursor is in the
Advanced Search panel.

CTRL+F Open the Fields dialog box when your cursor is in the Advanced
Search panel.

CTRL+S Open the Fuzzy Search dialog box when your cursor is in the
Advanced Search panel.

ESC Cancel the current search that is in progress.

Edit View
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Keyboard Shortcuts: Edit View

Shortcut Keys Use

CTRL+PAGE UP Navigate to the previous document.

CTRL+PAGE DOWN Navigate to the next document.

TAB Navigate to the next field in the document.

SHIFT+TAB Navigate to the previous field in the document.

CTRL+TAB Navigate to the last database or Workspace tab you
opened.

CTRL+C Copy the selected text.

CTRL+D Open the Duplicate dialog box to copy field data to another
record.

CTRL+F Open the Find dialog box to find text in the current field.

CTRL+F Open the Fields dialog box when your cursor is in the
Advanced Search panel.

CTRL+SHIFT+F Find the next instance of the text entered in the Find dialog
box.

CTRL+H Open the Replace dialog box to find and replace text in the
current field.

CTRL+L Open the authority list associated with the current field. 

For fields not associated with an authority list, navigate to
and open a saved authority list. 

CTRL+S Open the Fuzzy Search dialog box when your cursor is in the
Advanced Search panel.

CTRL+V Paste the copied or cut text.

CTRL+X Cut the selected text

CTRL+Z Undo the last action
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Concordance Desktop Viewer

Keyboard Shortcuts: Concordance Desktop Viewer

Shortcut Keys Use

CTRL + C Copy the current selection

CTRL + X Cut the current selection

CTRL + V Paste the copied selection

CTRL + SHIFT + A Pan tool

CTRL + SHIFT + X Zoom tool

CTRL + SHIFT + Z Magnifier tool

CTRL + E Fit to Height

CTRL + W Fit to Width

CTRL + SPACEBAR Rotate clockwise 90 degrees

CTRL + SHIFT +
SPACEBAR

Rotate counter-clockwise 90 degrees

PAGE UP Navigate to the previous page

PAGE DOWN Navigate to the next page

CTRL + P Open Print dialog box

Concordance Viewer

Keyboard Shortcuts: Concordance Viewer

Shortcut Keys Use

PAGE UP Navigate to the previous page

PAGE DOWN Navigate to the next page

ARROW UP Navigate to the previous page
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Keyboard Shortcuts: Concordance Viewer

Shortcut Keys Use

ARROW DOWN Navigate to the next page

ARROW LEFT Navigate to the previous document

ARROW RIGHT Navigate to the next document

TAB Go to the next markup (if there are markups on the page)

Additional Resources

Sample Files

Sample Concordance Desktop databases

Two sets of sample files are included with the installation of Concordance Desktop;
one is a set of documents for creating a sample e-document database and the other is
a set of PST files for creating a sample e-mail database. The directory where these
files reside also includes instructions for creating both types of databases in
Concordance Desktop, along with an empty "Database"folder that you can use as the
location for your sample e-document and e-mail databases. 

The sample files folder and the instructions for creating the sample databases
can be found under:

C:\ProgramData\CloudNine\Concordance Desktop\Sample Database

The e-document files can be found under:

C:\ProgramData\CloudNine\Concordance Desktop\Sample Database\Sample files\Edoc

The e-mail PST files can be found under:

 C:\ProgramData\CloudNine\Concordance Desktop\Sample Database\Sample files\Email

In addition to the sample files included with the Concordance Desktop installation,
there are also some sample databases and some sample data files you can download
by clicking on the links below. 
 

When downloading the Sample E-Documents Database, ensure that you unzip
the files to C:\ProgramData\CloudNine\Concordance Desktop\Sample
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Database\Database, in order to view the documents in the Concordance

Desktop viewer. Unzipping to any other folder will result in the inability to view
the documents in the Concordance Desktop viewer.

· Sample E-Documents Database

· Sample E-Documents Data

· Transcript Sample Database (with Exhibits)

To download and extract the Unicode sample databases, you will need WinRAR by
RARLAB. WinZip® by WinZip Computing does not handle the foreign language
characters in the Unicode sample databases correctly, causing broken native file links
in the databases.

· Unicode Sample Database (1000 records)

· Unicode Sample Database (100 records)

For more information about Concordance Desktop and the Unicode Standard, see
About the Unicode Standard.

Copyright Information

© 2020 CloudNine™. All rights reserved.

No part of this work may be reproduced or transmitted in any form or by any means,
electronic or mechanical, including photocopying, recording, or by any information storage
or retrieval system, without permission.

While the information contained herein is believed to be accurate, this work is provided "as
is," without warranty of any kind. The information contained in this work does not
constitute, and is not intended as, legal advice.

Concordance is a registered trademark and FYI is a trademark of Cloud9 Discovery LLC dba
Cloudnine. Other products or services may be trademarks or registered trademarks of their

respective companies.

* Concordance Desktop Viewer incorporates software created by OpenText and its use is
limited to the terms of the licensing agreement.  

CloudNine™ Concordance® Desktop
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